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Introduction to Autodesk Vault
Professiona

This chapter gives an overview of Autodesk® Vault Professional, its features, functions, and benefits, and
the Autodesk Vault Professional user interface.

Objectives

After completing this chapter, you will be able to:

= Describe Autodesk Vault Professional features.
= |dentify the user interface elements and navigate the user interface.




Lesson 1: Autodesk Vault Professional Overview

| Overview

In this lesson, you learn about the basic features and functionalities of Vault Professional, and its
i ' advantages as a design data management system.

o With Vault Professional, you can implement an automated release and change management process with
() complete tracking of bills of materials (BOMs) and related design information. Vault Professional also

- integrates with other business systems such as ERP (enterprise resource planning) systems. With these
integrations, your extended team can use design information for purchasing, inventory management, and
manufacturing, while allowing the engineering department to maintain control over their design data.
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Objectives

After completing this lesson, you will be able to:

= Describe Vault Professional.
* Explain the roles of Vault Professional in lifecycle management and change management.
= List some of the roles users can be assigned in Vault Professional.
* Describe Vault Professional integration with other design applications.
)
)
-
Y 2




About Autodesk Vault Professional

Autodesk Vault Professional is an integral part of the Autodesk data management solution. It uses vault
files as item data, making vault files available to an extended design team that can include personnel from
departments outside of engineering.

Autodesk Vault Professional helps you manage your vault data by creating and tracking change orders,
managing bills of materials, and working with item revisions and lifecycles to oversee files throughout the
design and manufacturing process.

Benefits of Autodesk Vault Professional

When designers and engineers place their data files in a vault, Autodesk Vault Professional connects
these files to item numbers that can integrate with ERP systems. Thus Autodesk Vault Professional is a
gateway connecting two different parts of a company: the design/engineering team and the extended
product team.

Example of How to Use Autodesk Vault Professional

With Autodesk Vault Professional, more users can connect directly to the files in the vault, assign items to
these files, enable other users in a larger team to work with the items, view items using visualization files,
and manage these items as they move through their lifecycle from design to manufacturing to
completion.
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Autodesk Vault Professional Functions

Autodesk Vault Professional automates the release management process by managing engineering
changes and bills of materials. You use Autodesk Vault Professional to manage items throughout their

lifecycle.

Manage Items

Create ltems
Delete Items
Organize ltems
Add User-Defined

Properties to ltems

Where Used

Track Item Revisions

With Autodesk Vault Professional, you can create items by assigning items to
data files or by creating new items.

When an item has reached the end of its lifecycle and is no longer used, you
can delete it from the [tem Master. - ‘

Using the ltem Master list, you can quickly search, sort, and filter items, and
customize how the item list is viewed.

In addition to the default properties for each item, you can add user-defined
properties (fields) to item records. :

You can analyze where items are used and check item dependencies before
editing an item or requesting an engineering change order.

A flexible revision numbering scheme keeps track of the history of items. You
can'use a predefined number of letter schemes, or use the ASMF Y14.35M
scheme. You can use secondary and tertiary schemes to track data with even
more detail. :

Bill of Materials (BOM)

Link Items

Edit BOMs

Units of Measure

Property Mapping

A BOM is built automatically when an assembly file in the vault is assigned an
item.

You can also link items together to create your own BOM that includes newly
created items.

You can edit materials and quantities for any design: You can override
quantities in a:BOM.

Autodesk Vault Professional and Autodesk® Inventor® support the same units
of measure, so any units of measure used in Inventor are automatically
transferred to Autodesk Vault Professional BOMs. You can also specify the
base measure of items, including mass, volume, quantity, and length.

You can map CAD properties in design files in Autodesk Vault to item
properties. These CAD properties are then carried over to corresponding
items in Autodesk Vault Professional and can be usediin the Item Master list
and in the BOM.




Compare BOMs You can view BOMs for different revisions of an item. Autodesk Vault
Professional also offers a graphical comparison view of BOMSs so you can
compare revisions.

Engineering Change Orders (ECOs)

Manage ECOs You can create ECOs and send them to members of the team. You can also
attach notes and red-lined drawings to ECOs.

ECOs are reviewed and tracked by members of the team, and can be
rejected, approved, or withdrawn. The status of these ECOs is shown
graphically and can be tracked to ensure that change orders are not
forgotten or misplaced.

SetUpRoutes ~ You can set up routing lists with email support. You can use these lists to
ensure that the right team members are notified of changes.

Item Lifecycle

Every item is tracked with indicators that show the state of the item (Work in Progress, Released, In
Review, and Obsolete). Revisions increment automatically in some cases when an item changes state. This
process ensures that correct revision control is used. Generally, items are in a Work in Progress state
when they are edited and in a Released state when they are released to manufacturing.

Manage Security

Users receive system access based on their departments, positions, and roles. Security features prevent
inadvertent changes and allow only authorized users to access or edit data. Certain functions, such as
creating new numbering schemes, mapping CAD properties to item properties, and editing users are
restricted to administrators.

Import and Export Item Data

You can import items from other systems; however, these items are not assigned to files in the vault. You
can export item data, including BOMs, to several formats to create reports.

Link Design Data into ERP Systems

Item data in Vault Professional can be synchronized with data in ERP systems. You can import item data in
XML format into most ERP systems. You can also import items from ERP systems into Vault Professional.




Example of Linking Design Data

The design work on an ICU valve is nearing completion and release by the design team. As part of
managing the valve data, you need to set up the packaged product. You add an item representing the
final packaged assembly, an item representing the packaging itself, and another representing the product
specification sheet. You link these items to the assembly design data to form a BOM for all the
components, and then release the items to manufacturing.

Based on an ECO, a new revision of the ICU valve packaged assembly has spare O-rings, and the ICU valve
buttons are no longer painted. After the revisions, you compare the assembly’s new BOM to the previous
version.

Security and Users in Vault Professional

You can control who has access to certain features in Vault Professional by assigning users different roles
and permissions.

‘Add Users

As a Vault Professional administrator, you can add, modify, and remove users from the system. You can
group users with similar roles and manage permissions and roles for both groups and individual users.

You can also add users from a domain.
Specify Roles

Autodesk Vault Professional has the following predefined roles: Administrator, Change Order Editor, ERP
Manager, Iltem Editor (Levels 1 and 2), and Item Reviewer. In addition, there are roles for Vault, Vault
Workgroup, and Vault Collaboration users as well as the Content Center. Users can be assigned roles
based on their required level of access within the company.

When you add a new user, you should include their email address so that they can receive
automatic notification of ECOs.




Role-Based Permissions

Users are assigned Vault Professional task permissions based on the role they are assigned by an
administrator. Administrators can also create Access Control lists for any folder in a vault. Folder
permissions such as Full Access and Read-Only can be assigned to groups or individual users.

Example

New employees join the company and require access to design data in the vault. The administrator adds

new users and sets their roles based on their required access to vault and Vault Professional data.

However, because the new employees are training during the first two weeks, the administrator sets their
access to certain sensitive folders as read-only until they have finished training.

Integration with Other Products

Vault Professional is a web services-based application. The application interfaces with files located in a
vault file store and database. The file store and database were created during installation or migrated
from another Autodesk Vault release.

Vault Professional integrates with the applications that produced the files in the vault. You can access the
vault from the design application or open files created by these applications from within Vault
Professional.

Autodesk Inventor

Vault Professional integrates with Autodesk Inventor. Vault Professional reads Inventor files and the
relationships amongst these files. The items’ type and BOM information is built on this data. )

= |nventor can control BOM data. By assigning BOM structure properties to components, such as
phantom or inseparable, Inventor influences how the Vault Professional application reads and builds
its BOMs for those items.
You can transfer custom properties between Inventor and Vault Professional.
Vault Professional fully supports all units of measure used by Inventor.

AutoCAD-Based Products

Autodesk Vault Professional integrates with other design applications and reads data in AutoCAD®
drawing (DWG™) files. The following list outlines how AutoCAD-based applications work with Autodesk
Vault Professional.

= External references (xrefs) are added as attachments to items in Vault Professional when the parent
drawings are assigned items. 4
Vault Professional can read drawing files and map their properties to item properties.
Vault Professional can read projects, drawings, and properties from AutoCAD® Civil 3D® drawing files,
and it can map their properties to item properties.

=  Vault Professional reads BOM data in AutoCAD® Mechanical and AutoCAD Mechanical Desktop
drawing files. It uses this data to create BOM data and determine object types.

= [fthe vault is set to enforce file locking, you cannot check out a drawing from the vault unless its
lifecycle state is set to Work in Progress.




Lesson 2: User Interface

- Overview

This lesson describes the features of the Vault Professional user interface.
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Objectives

After completing this lesson, you will be able to:

Identify the user interface elements in Vault Professional.
Describe the three main areas of the user interface.
Use the main pane in Vault Professional to show a list of objects that may be files in the vault, items,
or engineering change orders (ECOs).
= Navigate the user interface.




User Interface Elements

With the user interface elements in Vault Professional, you can work quickly and efficiently with data.

s AR B e

Navigation pane — Contains folders and subfolders for different environments,
shortcuts for searches, and filters. The work environment (All Folders, ltem Master,
Change Order Llst or Vault Explorer) is determined by the selection in the navigation
pane.

Main pane — Contains the primary list of data. This list changes based on the current
work environment. It may be a list of items, a list of files in the vault, or a list of ECOs.
Depending on the type of environment, the records for these lists can be selected
previewed in more detail, and edited :

Preview pane — Shows a preview of the selected record in the main pane. The
different tabs are logically organized views of details of the record and change
depending on the environment.

Main menu — Contains the commands used in Vault Professional.

Standard toolbar — The Standard toolbar provides quick access to common commands
depending on the environment

- Secondary toolbars — An Advanced and Behawor toolbar provndes qunck access to
other common commands dependmg on the enwronment

Status bar — Shows information such as the number of records in the main pane, the
number of records selected, the user name, and the name of the vault in which the
user is logged.
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Example of the Autodesk Vault Professional User Interface

In Autodesk Vault Professional, you normally begin in the navigation pane. This pane contains one or
more objects that essentially behave as folders, because they contain other objects.

When you select one of these folders, the data in the selected folder is displayed in the main pane. You
then work in the main pane.

When a record in the main pane is selected, it is previewed in the Preview pane.

About the Navigation Pane

The navigation pane is the starting point in the Vault Professional user interface. Use the navigation pane
to go directly to desired data.

Using the main workflows, you can work efficiently with Vault Professional and quickly locate the data
you need.

Navigation Pane Areas

All Folders The upper part of the navigation pane shows the folders you can click.
These folders can be filtered so that only the Item Master or only Vault
Explorer is visible.

In the following illustration the All Folders view is shown, where all
possible folders for navigation are visible.
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7 Table
7 TrailerHitch
= Ea My Search Folders
E’a Buttons

E& Plates

Three major work environments exist in Vault Professional:

ltems
Change orders
= Vault Explorer

By clicking the folders, you change the work environment displayed,
which affects the main pane and the Preview pane.
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- My Search Folders

My Worklist

My Shortcuts

Navigation Pane Buttons

In the previous illustration, saved searches are also visible.

These saved searches are environment specific. For example, if you
create a search in:the Iltem Master for the word Valve and then save
this search, it is displayed . under My Search Folders. Clicking this Valve
folder brings up the Item Master work environment and displays the
filtered items containing the word Valve.

ECOs requiring your attention or action are listed under My Worklist
together with the due date. Clicking the listed item brings up the
Change Order list work environment with the ECO highlighted.

You can create group folders in the My Shortcuts area. You can then fill
these folders with shortcuts to items, documents, files in the vault, and
ECO. Clicking these links takes youto the selected objects immediately.

L%

Helical Spring Lock
iCL Vahee

B8 End Cap
Housing

Add new group

Buttons in the navigation pane, located in the lower-left corner of the
main interface screen, filter the folders at the top of the navigation
pane. For example, clicking Vault Explorer removes ali folders except
those displayed in Vault Explorer.

TIP: Use these buttons to filter the folders saved under My Search
Folders. Under All Folders, you see the results of searches for all work
environments. However, when you click a button such as Vault
Explorer, only search results for the Vault Explorer environment are
displayed under All Folders.

11




Example of the Navigation Pane

In the following illustration, the All Folders button is selected in the lower-left corner of the user interface.
, The Item Master is selected in the navigation pane. The contents of this folder (ltem Master) are
displayed in the main pane.

ot

About the Main Pane

The main pane changes based on the work environment and how the view is customized. Use the main
pane to sort, filter, and view records in the list.

The main pane lists records of objects. These objects may be items, files in the vault, or ECOs, based on
the work environment.

You can customize the main pane to show different fields and to filter the list based on different criteria.
You can also use Find to quickly search a list.

12




Example of Iltem Master

When working with items, the main pane shows the ltem Master.

P

@ 7?:;) Number Revision State Title (em €O}
y togaie T Released Long Rail

100018 - Released Rail - Short
100017 - Released Side Assembly
100016 - Released Leg - Tapered
100015 - Released Dowel - Black Walnut
100014 - Peleased Small Table
100013 - Released Top
100021 - Work In Progress | ICU O Ring Lubricant
100022 - Work In Progress { ICU Button Paint
100023 - Work In Progress | ICU Valve Main Assemb
1ohnad - Work In Progress | ITULBUTM.Ipt

i

Example of the Change Order List

ECOs are listed in the Change Order list.

ECO-000002 Open Rework Trailer Hitch Saftay Plate 443042010 7:13 AM
THECO-000003 Approved Remove paint from ICU Valve buttons | 5/13/2010 12:00 AM

Example of Files in a Vault Folder

Files and their properties are listed when a vault folder is selected in the navigation pane.

sarch ICU Yaive v

& D File Mame i Yersion | Checked In
H®)] 8 1CU Vabee Main Asserably.iam 1 4/6/2007 4:25 AM
& ICUENDCP.ipt 1 4/6/2007 4:25 AM
vvvvvvvv ICUHOUSG.ipt 1 1/6/2007 4:25 AM
ICULBUTN.ipt 1 4/6/2007 4:25 &AM
ICUCRIMG.ipt 1 4/6/2007 425 AM
ICURBUTM.ipt 1 4/6/2007 4:25 AM
o0 () ICUSPRNG.ipt 1 4/6/2007 4:25 AM
BH ) IcuvALVEipt 1 4/6/2007 £25 AM
(B3| ICUVALVEASSY jam 1 4/6/2007 4:25 AM

13




&) About the Item Record Dialog Box

-,
. Along with the major interface panes, one of the most commonly used interface elements in Vault
Y Professional is the Item Record dialog box. Use the ltem Record dialog box to view (Open) or edit (Edit)
. items and their BOMs, and to attach and detach files. ltems must be in the Work In Progress state in order
) to open them for editing. Otherwise they can be opened read-only for viewing. This feature is helpful
~ when the item has a lot of details or when you want to view the associated files.
N Using the Item Record interface, you can edit an item’s properties, including the item’s BOM, attach and
/ detach files, and view change orders associated with that item.
)

Number
Category:

Title:

Déscription:
Units: |
8 §

Associtated files:

Top Level Assembly

Lifecycle State: - Work In Progress

Revision: 8

Last Updated By: - usera

Last Updated: " 4/21/2010.7:22 aM

Properties:

): File Mme

. Version
ICU Valve Render..

N;

1

Y2

ICU Valve Renderi.

Example of the Item Record Interface

You create a new item such as lubricant in the Item Master. In the Item Master, you double-click an item
representing an assembly to open it for editing. You add the lubricant item in the assembly item’s BOM.
When you have completed the task, you click Save and Close to save the changes and exit the Edit Item

Record dialog box.

Dates

| Bill of Materials |

Structure:

%Today

{Fas Muki-Level

Revision:

MNumber

Quantity  Units Title (Ttem, L0} Revision

State

5

100018

Each Cl kK

ICUVALVE.ipt

A
3 Each ICUGRING.ipt B
1 Each ICUSPRNG it A

Released

Released

Released

14




Chapter Summary

Autodesk Vault Professional extends provides product management to your manufacturing designs. A
common interface provides access to files, items, BOMs, and change orders.

Having completed this chapter, you can:

Describe Autodesk Vault Professional features.
Identify the user interface elements and navigate the user interface.

15
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| Autodesk

- Working with Items

All Autodesk® Vault Professional® users must be able to work with items, using the application’s
various features and functionalities. Your specific Autodesk Vault Professional item tasks are related to
your position in the design and manufacturing environment.

You can assign items to CAD files in the vault, or create new items for products not specifically
D) modeled in CAD.

' The list of items in Vault Professional can get very large and awkward to handle. By using customized
views and filters, you can sort or filter the item list based on item properties to manage the items
effectively.

Objectives

After completing this chapter, you will be able to:

. Create, modify, and delete items, use filters to view items, and add and remove file
attachments.

. Create, modify, and delete custom views, use filters to view items, and find items.

. Work with default item properties and user-defined properties, including item numbers, life
cycle states, and revisions. ‘

. Export item data for use in other applications.

— 16
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Lesson 1: Creating ltems

Overview

In this lesson you learn how to create, modify, and delete items, use filters to view items, and add and
remove file attachments.

Use items to help manage your vault data and make that data available to the extended design team.

B0 5 Number

Revision

State

Title (ltem, CO}

100019 -

Relezsed Long Rail
100018 - Released Rail - Short
100017 Released

Side Assembly

Assign items to files in a vault, and create new items from scratch.
Attach engineering documents such as specifications, design and product data sheets, and

Objectives

After complg

®

. Work with the Item Master.

[ ]

L]

regulatory documents to items.

®

Use automatic attachments to expedite assigning items to files in the vault.

NOT
CURRENTLY
USED

Create items by assigning items to selected design data from Autodesk® Vault.
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About Items

Working with items is a crucial part of automating the data management process and maintaining
control of your design data. When a new design is added to the vault, each part or assembly can be
assigned an item so it can be clearly identified.

You create items by assigning them to design data from the vault or by creating a new item directly in
the ltem Master.

Definition of Items

Items represent physical elements that a company uses to produce the products it manufactures.
Common items include parts and assemblies, documents, consumable goods such as grease, paint,
fluids and lubricants, and even artwork. Some items are purchased while others are manufactured by
the company.

An item is identified by a unique identifier (the item number). This number is used to identify the item
in change orders, product lists, bills of materials, and ERP systems.

! 2810 T Number Revision State Title (tem,CC) - ftem Description Category Name Uriits

| iE ’ ; ! '

| 1100019 - | Released iLong Raif i Long rail i Part {Each
i I ; g ; g

As part of a ne N O I part. The new item

d 100352) or a
complex set of
This item numb ' l I RRE N I I Y the item. The
application use

[tem Master

To manage andtrdce d to access a list of
items where they can preview, create, modify, and delete |tems as requwed The ltem Master is where
this list of items is found.

About the Item Master

The Item Master contains a complete list of all items in the system. These items usually represent
design data in the vault.

18
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Items in the ltem Master are identified by unique identifiers (item numbers). Each item has a number
of system and user-defined properties.

14 General

Go to a specific item.
Find an item or items, and optionally save the search.
Change column text alignment.

Create new items.
Edit items.
Preview items in the Preview pane.

: Number: g

Cafegory: Part

Tile: TCOLBUTNGt
: Désc}iptiﬁn: o

Ui EERIEE

Lifecycle State:

Revision:

Last Updated By:

Last Updyatygd: -

B % Number Revision State Title {ltem, CO) Teern Description Category Name Units
100019 - Released Long Rait Long rail Part Each
100013 Released Rail - Short Short Rail Part Each
100017 Released Side Assembly Assernbly of legs and sid... | Assembly Each
100016 Releazed Ley - Tapered Cak table leg Part Each
100015 H Dt $ gt *

General
100014 :
100013 Humber: 100020 Lifecycle State: - - chxrk InPr
Tooe5s - Categonys Part Revision: -
100023 ! Title: TCUYALVE jpt Last Updaked By usera .
100024 ; Deseription: Last Updated: 4}1 %
100025
100026 !

‘WorkIn. Progress :

usera

471572010 3:04 PM

h, and sort by any

19



brianr
NOT USED


Example of the Item Master

As new designs are added to the vault and assigned items, the Item Master list grows.

%‘} Number -+ Revision State Title (tem, COY° § . Irém Descriptior
100014 i Released Srmall Table Srnall Table
/ | 100013 - Released Top Top for small tal
N ] 100021 - Work In Progress {ICU O Ring Lubricant Grease for subas
100022 - Work In Progress | ICU Batton Paint
> 100023 - Work In Progress ICU Valve Main Assembly.iam
100024 - Werkln Progress ICULBUTN.ipt
100025 - Work In Progress {ICUHOUSG.ipt
100026 - Work In Progress | ICUSPRNG.ipt
s \\(
o

Creating Items

To work with Vault Professional, you must add items. Typically, you assign items to data files in the
vault. In some cases, you need to create an item that is not modeled in the design. Examples include

purchased it¢ t, artwork, or
packaging. Yq

- Procedure: Creatin

hange the category or

4. Click Save and Close. The new item is created.

Procedure: Assigning Items to Files in Vault

The following steps describe how to assign items to files in Vault Professional.

1. Make sure that all files to which you want to assign an item are checked into the vault.

2. Click the Vault Explorer Button.

3. In the main pane, right-click the part, drawing, or assembly file to which you want to assign an
item. Click Assign ltem.

4. Inthe Assign Item Wizard dialog box, review the new items. If necessary, right-click on an item and
select Change [tem Number to renumber the item.

5. Click in the Description field and enter a description of the item.

6. Click Next.

™ ; 20



brianr
NOT USED


7. If there are duplicates of the item, you can replace them with an existing item in the item master
by clicking in the Replace With field, or you can select the Auto-select first duplicate item check
box. You can also filter which items are displayed by selecting the Hide items without duplicates
check box.

8. Click Finish. The new items are created and the files in the vault are linked to the items. A report is
generated and displayed on the screen.

9. Click Save to save the report locally or click Send to Vault to save the report to the vault.
10. Click Close to exit the Assign ltem Wizard.
NOTE: When you assign an item to an assembly file, all parts and subassemblies in that

assembly must have items assigned as well. Items are assigned automatically to all the
necessary files if they do not have items assigned already.

Attaching and Detaching Files

When you crq tached to the item.

You can man 5. You can add
attachments assembly
instructions, s of the product, and

SO on.

You attach a ttached file is

SEICURRENTLY
In some cases by pinning the

attached file. ginally attached
remains whe Ider part might be

== USED

Procedure: Attachi

The following steps describe how to attach files to items.

In Item Master, double-click an item to edit it.

Select Actions -> Attachments.

In the Attachments dialog box, click Attach.

Navigate to the file you want to attach. Select the file. Click Open.

Review the attached file in the Attachments dialog box. Pin the file if necessary. Click OK.

I A T o

Click Save and Close.
Procedure: Detaching Files from Items

The following steps describe how to detach files from items.

1. In Item Master, CTRL+click the paper clip icon in the item’s record.
2. Select the attached file. Click Detach.

3. Click OK.
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Automatic Attachments

Some files are associated automatically with the parent file when the parent file is promoted to an
item.

Definition of Automatic Attachments

When you add CAD files to a vault, the relationships and links between files are maintained. For
example, the links between an assembly file and its part and subassembly files are maintained by the
vault. These linked files are automatically promoted to items when the assembly is promoted. In a
similar way, cross-reference links between drawings in AutoCAD®, AutoCAD® Mechanical, AutoCAD®
Electrical, or AutoCAD® Civil 3D® are also maintained in Vault.

Example of Automatic Attachments

An Inventor drawing is created from an Inventor part, and both are checked in to the vault. In Vault

NOT

Explorer the two files are visible.

o] CURRENTLY
USED

After assigning an item to the Grip.ipt part, the item also shows a link to both the files in the
Associated files list on the General tab.

General

MNumber
Catégmy:
- Title:
Description
Units:
Associated filesy ; Progeriest
[ File Name Yersion i  Mame
E > Itern Material o
! Tem Project
] %
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Exercise 1: Assign Items to Vault Files

In this exercise, you create a custom view for Vault Explorer, assign an item to a part and an assembly, and

attach files to an item.

M 5y Number

Revision

State

Title {lherm, CO)

Work In Progress

ICUVALYE.ipt

B 100020
B30 10002

Work In Progress

ICU O Ring Lubricant

B9 100022

Work In Progress

Work In Progress [ ICULBUTM.ipt

ICU Button Paint

Create a Custom View
1. Start Autodesk Vault Pr
the following information:

® User Name: usera
. Password: vault
. Database: AOTCVault

2. Inthe navigation pane, click All Folders.

3. Under All Folders, expand Vault Explorer.
4. Navigate to the Designs\ICU Valve folder.

TCVault - usera
Change Order List
Erzg Itern Master
o E’E‘, Vault Explerer {3
B Content Center Files
{7} Designs
7 Clamp

27 TraiterHitch
8 My Search Folders

B} AOTCVault - usera
Eé[ Change Order List

In the Manage Custom Views dialog box, do the

following:

Click New.
Under View Name, enter Thumbnails.
Click OK.

In the Manage Custom Views dialog box, select the
Thumbnails view. Click Modify.
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N
]
el

8. Click Fields.

9. In the Customize Fields dialog box, do the
following:

° In the Select Available Fields From drop-

L down menu, select All File Fields.

. In the Available Fields list, select Thumbnail.
Click Add.
e  Under Show These Fields in This Order, select

) Comment. Click Remove.

o . Under Show These Fields in This Order, select
Yy Thumbnail. Click Move Up until Thumbnail
’ appears above File Name.
. Click OK.
/ Show these flelds inthisorder
ST Yault Status
L ) Property Compl}

Attachments
Category Glyph
Lirtked to tem
File Type
Thumbnail
File Mame
Revision

State

Created By
Checked In

10. Click Close twice to cl
The main pane displa
from the visualization

BN Thumbnail File Name
> Gl 1CY Valve Main &ssemstly.
] ICUENBCPR.ipt
& , |ICUHOUSG.ipt

11. To adjust the size of the thumbnails, resize the
Thumbnail column.

ICU Valve Main Assermishy.

ICUENDCP.ipt

CURRENTLY
USED

Assign an ltem

1. From the Advanced toolbar, click All Files from the
toolbar drop-down menu.

humbriail k
t Define custom views...
e

Change Order List
@ ttem Macter

2. Inthe main pane, right-click ICUVALVE.ipt.
3. Click Assign Item.

ICUVALVEASSY ia

' Checkout

log box, do the following:

o replaie duplicateitems. .

5. In Vault Explorer, place the pointer on the item icon in
front of the part name. The Go to Item tooltip is
displayed.

D File Name
S Iy ICUYALVEASSY.iam

FAE 1 ICBDAE Gt
igned to an item ]
CTRL + click to go to ifem. |
T N i
() ICULBUTN.ipt
() ICUHOUSG.ipt

6. CTRL+click the item icon. In the Preview pane, click the
View tab (if it is not selected already). Under Attached
Files, click ICUVALVE.ipt.

24



brianr
NOT USED


toolbar drop-down menu, click
All ltems.

The list is updated with the new items.

7. Note the warning. In the View tab, click Update
to update the view.

8. Under All Folders, clic

Notice that when you
assembly file, it auto
subassemblies and p
Without these extra i
incomplete.

URRENTLY
USED

. 5] 100008

3

1 ICUHOUSGJpt
-5 160005 2
i 4
5

ICUENDCP.ipt
ICURBUTN.ipt
(ICUVALYEASSY.iem
ICUSPRNG.ipt
ICUGRING it

it

T = A

10. In the Assign ltem Wizard dialog box, do the
following:

. Click Next. An item number is
assigned to all parts, and duplicates

are found.
o Click Finish.
] Click Close.

An item icon is displayed next to all
files in the ICU Valve folder.

) Under All Folders, click Item Master.
If necessary, from the Advanced
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it Attach Files to an Item

.. 1. Inthe Item Master window, select ICU Valve
o Main Assembly.iam.

2. Inthe preview pane, select the General tab.

Only one file is associated with the item in the
" main assembly.

3. Inthe Item Master, double-click ICU Valve Main
Assembly.iam to edit the item.

4. Onthe toolbar, click Attachments.

in the Attachments dialog box, click Attach.

Navigate to the Designs\ICU Valve\Documents
folder. Do the following:

U Select ICU Valve Rendering.png.
] Click Open.

7. Inthe Attachments dialog box, click OK. The
attached files are listed under the associated
files.

8. Onthetoolbar, click Save

\ The assembly item updat
14 paperclip icon is displaye
,‘_ are attached files.

USED
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Exercise 2: Create New ltems

In this exercise, you create new items to represent physical objects not modeled in the vault.

Sy Bl Baon Panoptin
s | Wk e Progress |3 :
100021

ease for subassembly

Work In Progres:

The completed exercise

1. Start Autodesk Vault Profess
following information:

° User Name: user

e CLURRENTLY

2. Under All Folders, click item

Right-click ltem Master. l ' S E D

del
gj AUTCault - usera

B Change Order List

. Click New Item.

3. Inthe Edit Item dialog box, do the following:

. For Category, select Purchased.
° For item Title, enter O-Ring Lubricant.
. For Units, select Milliliter.

. Click Save and Close.
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4. The new item is displayed in the ltem Master,

f 5. In the Item Master, right-click the O-Ring lubricant
e and select Attachments.

In the Attachments dialog box, click Attach.
/7. Navigate to the Designs\ICU Valve\Documents folder.

i Select ICU Valve Specification Sheet - Grease.doc.
’ Click Open.
X 8. In the document row, in the Pinned icon column,
select the check box.

Attached Files

{[7).File Name © Version @ Créated By CheckedIn | Comment
ICU Valve Spec... | 1 1T Administrator 140672067 4:25 .., |

i1 Show all revisions

(.) 9. ClickOK.

CURRENTLY

USED



brianr
NOT USED


Lesson 2: Working with Items

Overview

In this lesson you learn how to create, modify, and delete customized views, use filters to view items, -
and work with item properties.

You can also export items for use with other applications or to create reports. ()

Use items to index and manage products in manufacturing. You also use items in the creation of Bills )
of Materials (BOMs) within Autodesk Vault Professional and in tracking change orders.

NOT

CURRENTLY
USED

Objectives

After completing this lesson, you will be able to:

o View specific items and files attached to the item.

° Use the Where Used tab to show item dependencies in the vault.
. Define custom filters to view and work with items.

° Use the Item Master to view, search, and filter items.

. Find items using Go To, shortcuts, and saved searches.
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Using the Item Preview Pane to View ltems

The extended design team requires access to design data. Because many team members outside the
engineering team do not use CAD, items cannot be viewed directly within the native CAD application.

o Visualization files are the main tools used for viewing items. Visualization files can be DWF™ or DWFx
. files. Visualization files can be published automatically when files are checked in to the vault, thereby
/ making viewing items in the vault easier and faster. With 3D visualization files, users can pan, zoom,
Y and orbit 3D Autodesk® inventor® models. Individual components in an assembly can be shown,

§ hidden, or isolated. With 2D visualization files, users can print and view drawings and mark them up to
provide feedback.

Use the View tab in the preview pane to view an item’s associated vault files.

i ) : Attached Files:

) \ [ File Name Version ®

Viewing Revision

You can vie

il images of the
different re

Number of Revisionst 3
" Current Revision: o 41
Y
- Thumbnail Number Revision State Title (Tteri, CO) Units
» 100028 Al WorkIn Progress |ICURBUTM Each
1000258 A Work In Progress | ICURBUTN Each
100028 - WorkIn Progress | ICURBUTM.ipt Each
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Procedure: Viewing an ltem

The following steps describe how to view an item’s associated files.

1. Inthe ltem Master window, select the item.

2. Inthe Preview pane, click the View tab.
Procedure: Viewing Other Data

The following steps describe how to view other data.
1. Inthe Item Master window, select the item.
2. Inthe Preview pane, click the View tab.

3. Click Open to open the file in the Viewer.

Using the Where Used Tab

With the Where Used tab in the Preview pane, you can analyze where items are included in the vault.

In the following
ICUVALVEASSY ;
used directly in
number of pare

Title Trem, CG)
Revisiom y 5E8

100030 ICUVALVEASSY. fam Assembly

----- 100023 ICY Valve Main Assembly.iam Assembly

‘Waork In Progress

Work In Progress

sed in the
bly file. The part is
y assemblies (total

31
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‘ How to Define Custom Filters to View Items

- The number of items in the system can grow quite rapidly, and finding items in the list can be difficult.
' Many methods are available to filter the item list. By default, a custom view is already applied to the
Item Master, which shows the items that have been updated in the last seven days.

The default custom view is displayed on the Advanced toolbar.

I Bems

It is strongly recommended that you create custom views to filter your data. Customizing helps speed
up the display of item lists because only filtered item data is retrieved from the server rather than the
entire item list.

\ Procedure: Defining a Custom Filter in the Item Master

- The following

) 1. Inthe lte to filter. Select
) Customize

desired.
Click Add.

If desired, o the criteria list.

o v ok wN

Click OK. T

Filter icon

(D NOTE: If the Item Master list is not displaying items you expect to see, check the filter
O settings and make sure it is displaying the desired content.

) Procedure: Saving Custom Views

-

) The following steps describe how to save custom views.

o) 1. Onthe Advanced toolbar, from the Views list, select Define

— Custom Views.

-

~ 2. In the Manage Custom Views dialog box, click New.

{%:«.% 3. Inthe Create Custom View dialog box; enter the desired view

Py name. Click OK.

i"m /

— NOTE: If a custom filter already exists (the filter icon is displayed on the Item Master title
“"f.;; bar), then you may not want to edit the filter again. Skip the next four steps.

;_ 4. Click Modify.

) . . . . .

— 5. In the Customize View dialog box, click Custom Filters.

/m 6. Inthe Customize View dialog box, add the filter criteria.
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7. Click OK to exit the Custom Filters dialog box. Click Close to exit the Customize View dialog box.

8. Click Close to exit the Manage Custom Views dialog box. !
Procedure: Managing Custom Views

The following steps describe how to manage custom views. L)
1. On the Advanced toolbar, from the Views list, select Define Custom Views.
2. Inthe Manage Custom Views dialog box, select the desired view name.

3. Click Modify, Copy, Rename, or Delete, as desired. ()
4. Close all dialog boxes. -
NOTE: You cannot rename or delete the default custom views (All Items, Last 7 Days). ﬁ

Although not recommended, it is possible to add additional custom filter criteria to these two
custom views

Procedure: Clearing Custom Filters

LT ==
CURRENTLY

petween custom views.

Procedure: Enabli

The following steps describe how to enable filtering

by column.
X . . .  State S
1. On the right side of the column heading, click " E;;J“:TJ
. (Blanks
the Column Filter button. Released | (Non blanks
2. Select one of the filter options. The column’s Released
. ' Released
values are listed, and you can filter based on S . .

h I Released . mm— i
these values. Released E.Small Table éAssembiy
lf you seIECt (CUStom)l you are prompted to set Releassrd Ennm:pl - Plark Wialnnt gDarl’
up a custom auto-filter for that column.
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How to Customize Column Display in the Item Master

Columns in the ltem Master list represent item properties. Many item properties exist, and you can
filter the number of columns (properties) displayed in the list.

In this procedure, you customize the ltem Master view by working with the list columns.

Procedure: Removing Columns in the Iltem Master

The following step describes how to remove a column in the list.
1. Inthe Item Master list, right-click the column header you wish to remove.

2. Select Remove This Column.
Procedure: Adding, Removing, and Rearranging Columns in the Item Master

The following steps describe how to add, remove, and reorder columns.
1. Inthe ltem Master list, right-click a column header in the Item Master. Select Customize View.

2. Inthe Cust¢

3. Inthe Cust( N O I

4. Customize

If you olumn headers to
=-ACURRENTLY

Procedure: Group lte

The following st
1. Onthe Adv

’_) = @ AQTCVault - administrator

(7 Change Order List

o . :
o 2. Inltem Master, drag a column header to the location indicated. The items in the list are
- automatically listed in groups based on the column header value.

I

g In the following illustration, the items are grouped by state.

-

.

)

L
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Ay
;
106022 A 1CU Button Baint Purchased Millititer TN
10002 i 1CU G Ring Lubricant Purchased iillfter LS
100013 a Top Part Each - N
100014 A Small Table ‘Assembly Each J
100015 S Dowel - Black Walnut Part Each ]
100016 A Leg - Tapered Part Each £ \)
100017 A Side Assembly Assembly Each g
100018 A Rail - Short Part Each
100018 Ly Long Rail Part £ach ;
100028 A1 ICURBUTN Bt Each
50024 & ICULBUTN Part Each
Work In Progress 7/
100030 ES TCUVALVE.ipt Part Each o
10030 i ICUVALVEASSY.iam Assembly Each )
100038 i ICUCRING it Pt Each .
160027 E TCUENDER ipt Part Each )
100026 A ICUSPRNG.ipt Part Each g
100025 A ICUHGUSG gt Part Each
: 100023 A Each ) -
th i : i k

Grouping by column header value can be useful when you work on a number of projects:

. Add a project name property to each item in the Item Master.
. Customize the view to show the item Project field, and then group the items by this field.

Procedure: Turn Off the Group By Box Display

The following steps
1. Onthe Advancg
2. Drag the colu

TTTICURRENTLY

USED
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How to Find Items

In this procedure, you find items by using the item number, using shortcuts, and searching for items.

Search Tips

. Use Go To to go directly to an item.
. Use My Shortcuts to go to items.
. Search for items using Find.

Procedure: Going to a Specific Item by Item Number

The following steps describe how to go to a specific

vt NOT
CURRENTLY
USED

2. Under My Shortcuts, you can also add new groups
(folders) to organize the shortcuts.

€ an item number

2. Entera

Procedure: Creati
in the Item Maste

The followin
shortcuts to

1. Inthe ltg
window

ain Sssy
ve Subassy

HAdd new group

3. Togo to an item, click the item shortcut.
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Procedure: Searching Items

The following steps describe how to search for an item or items, and optionally, how to save the

search.

1.

e o 0o o W N

In the Search box, enter the search text.

3

&

£,

Click Search. The items containing the search string are displayed.

To save the search, do the following:
On the Search bar, click Search Options.
Click Save Search.
Enter a search name.
Click OK.

In the navigation pane, under My Search Folders, the saved search is displayed.

CURRENTLY

USED
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Exercise 1: Work with Items

In this exercise, you will create shortcuts and a saved search for the project. You will also learn how to link the
ICU Button Paint item to the ICU buttons, how to delete items, and how to export the Item Master view.

Search em Master o

0 % Mumber: » . Revision " State. . Title {ftein, CO) Category Mame Units
100020 A WorkIn Progre§5 ié’UVALVEpr Part Each
180020 & Released ICU O Ring Lubricant Purchased Milliliter
100022 A Released ICU Button Paint Purchased Milliliter
100023 A Work In Progress [ICU Valve Main Assemblyiam [ Assembly Each
: Bill of Materials |

|

Date: Structure:

iToday v: Fas Wulti-Level
: Number : Quantity - Revision | State Title (iterm, CO)
Revision: )
1 A Work In Progress ICUHOUSG.ipt
| 1 A Work In Progress ICUENDCP.ipt
=8 100024 1 A Released ICULBUTN
"""" | L 100022 1 A Released ICU Button Paint
-E5) 100028 1 Al Released ICURBUTN
i[5 100022 1 A Released ICU Button Paint

Create Shortcuts

1. Start Autodesk Vault Professions
the following information:

. User Name: usera
° Password: vault
. Database: AOTCVault

2. Under My Shortcuts, click Add New Group.
3. Enter ICU Valve. Press ENTER.

7. Enter - Main Assembly after the item number.
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8. Press ENTER. 9. Click Save and Close. Repeat the previous steps to

E-f7) KU Valve link the ICU Button Paint item to the Left button
. JBH) 160010 - Main Assernbly (ICULBUTN.ipt) item.

10. In the ICU Valve shortcut group, click the shortcut
to the Main Assembly.

9. On the standard toolbar, click Find.
. 11. In the preview pane, click the Bill of Materials tab.
* ’
10. On the Basic tab, for Search Text, enter *BUTN. Verify that the ICU Button Paint item is listed

Press ENTER. twice, under the ICU buttons.
11. Click File menu > Save Search.

» Number Quantity : Title {ftem, CC}
12. In the Save Search dialog box, for Search Name, ’
enter Buttons. Click OK. locoss 1 ICUHOUSGipt
130040 1 ICUENDCP.ipt
er earc E% 100037 1 ICULBUTN .
The saved search is displayed under My S h =@ ‘
Folders.  Cmwes ICUBution Paint . ¥
. . . epg 04 1 ICURBUTN
13. Close the Find dialog box.  CEwes T ™
é?l[g‘a] 100043 2 ICUVALVEASSY.iam
Link Items 100633 1 ICALYE.ipt
‘ 100042 3 ICUQRING.ipt
106035 1 ICUSPRNG.ipt
1. Under All Folders, right-click item Master. T €8 R et

2. Click New ltem.
3. Inthe Edit Item dialog box, do the following:

Delete Items

For Category, select Purg @gRing Lubricant
For Item Title, enter ICU
For Item Description, en

Set Units to Milliliter.

. Click Save and Close.
4, Under My Search Folders, cli ' l I RRE N I LY Ring Lubricant

5. Double-click the ICURBUTN i
6. Click the Bill of Materials tab

7. Right-click the row. Click Edit | ' S E D . The O-Ring
Add New Row. bm the Iltem

Number Quantity

k Obsolete.

NOTE: You can delete an item only if its
lifecycle state is set to Obsolete.

Edit Bill of Material > Add New Rowe I

8. Inthe Find dialog box, click the Basic tab if it is
not selected already. Do the following:

Enter Paint as the search text.

Click Find Now.

Select the row displayed.

Click OK.

The ICU Button Paint item is linked to the
ICURBUTN.ipt item.
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Lesson 3: Item Properties

Overview

“ In this lesson, you will learn how to use item properties to search for and sort items, organize items, and
filter the ltem Master list. You use item properties to manage items.

2

ch Ttern Master -

Mumber 7 Revision State Title (Hem, CO) Category Name
100020 & |Workin Progress |ICUVALVE.pt Part
100021 ICUv1 A Released ICU O Ring Lubricant Purchased
10022 A Released ICU Button Paint Purchased

(=]

Icuvt
100025 ICUvL
100026 1CUvL
100027 ICUVL
100028 '

= NOT
CURRENTLY

Released ICUEBUTN Part
Work In Progress | ICUHOUSG.ipt Part
Work In Progress | ICUSPRNG.ipt Part

Work In Progress | ICUENDCR.ipt Part

=]

il
{afw

03 | (B0
105 | 030

Default ltem Properties

By default, each item has several properties that store and manage its number, revision lifecycle, and
- other associated data.

Definition of Default ltem Properties

Items have properties that apply to all items by default. These are the system properties and are similar
to those for Vault, Vault Workgroup and Vault Collaboration. In some cases the properties are marked
(Item, CO) to denote they are unique to items and change orders.
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The following list describes the main properties that are displayed on the General tab.

Property Nam

Number Unique item identifier Normally a numerical sequence

Category Categorization of the:item. “Part,” “assembly;” or
“purchased”
Title Brief description of item or Up to 128 characters

change order

Description | Secondary descriptibh of item Up to 128 characters
or change order

Units Quantity Select from a list

Lifecycle State , ltem Iifecycle state. | “Work in Progress” or ”Release‘d”
Revision Item revision String or character

Last Updated by system

Last Updated N O I by system

Example of Spec.ifyin. C U RRE N T I_Y

sequence (Part

inge the item
distinguish the item
for consumables it

100010) or as ¢
number after it
later on. The U
can specify ho
The final set of properties is controlled by the system. The Lifecycle State designates the position in the
product development process. You can change the lifecycle state to Released, signifying it is ready for
production, or Work In Progress, denoting that it is being edited. As designs evolve they are given
Revisions to denote major milestones in a product development lifecycle. For example, a part may be
released to manufacturing at Revision A but later be modified based on warranty reports to Revision B
to correct a defect noted by customers. The updates are tagged with the user that last updated the
item (Last Updated By) and the time the update was done (Last Updated).

41
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User Defined Item Properties

In addition to the system properties, there are a number of pre-defined user defined properties that are
assigned to Items as they are created. These are based on common file properties associated with the
different authoring applications. For example, the property Material — designating what property the
item is made of- can be set from a file property in Autodesk Inventor.

Additionally, you may want to specify some properties that are unique to your company. For example,
you may have different Business Units that produce designs that you may want to identify or search on.

Best Practices for Working with User-Defined Properties

The administrator can define additional item properties to add company-specific properties to items.
You can use these properties to help arrange or find items in the vault.

It is recommended that:

You attach user-defined properties to items or remove them from items in the vault. Properties
are created and managed by the administrator using the Property Definitions dialog ( found

und

The the vault if possible. For
exa N OT 5 made of- can be set from
afil

), as shown in the

HCURRENTLY [~

% Enabled
‘% Enabled
B Language ¥ Enabled
B Last Suthor % Enabled
B Last Printed % Enabled
B Last Saved Time T Enabled

: B Eanbled

SN soesavmsamor-1
Settings | Mapping

Property values: Category values:
M : g Mame

Basic Search

Initial ¥alue
List Values

oy
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Example of Using a User-Defined item Property

You create an Iltem Project property value for a predefined ltem user-defined property so that you can
sort by that property or use it to search for items.

Nﬁmbev:

Lifecycle Stater . Work In Progress
Categony - Revision: A
H :
Title: ICU Wabve Main fsserr ‘ Last Updated By Administrator
Descriptions= 1 - § | Last Updated: - 4/15/2010 500 PM
Units: Fach
Sssociated files: Properties: \
ff} File Name Name : 7 ¥alue
U Yakve R, » : e Project ficuvt
»

You can also ask the administrator to map the user-defined item property to properties in the vault
files.

Iltem Numbering Schemes

All items have unique item nu
operations. These item numbe
administrator.

Guidelines for Item Numbers

There are two predefined nu C U I {I {E N I LY

you use customized numberin

The two predefined schemes i

° Sequential numbering U S E D
This scheme creates item
scheme that starts with 100001 and goes to 999999.

. Mapped numbering

This scheme is selected automatically when a file property is mapped to the item number. You can
choose the numbering scheme when you add new items to the vault. It can be any value up to 50
characters long.

Custom Numbering Schemes

If you choose to use a custom numbering scheme, the scheme can follow company standards or use any
identifier. It is recommended that you make this identifier as simple as possible. A six-digit numbering
scheme starting with 100000 is ideal.
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The following illustration shows the use of a custom sequential scheme. Notice that parts, assemblies,
and purchased items are numbered from 100033 to 100043,

Example of Using Item Numbers

earch fern Master

0 T Number ¢ - Revision State Title (tem, COY- “ Category Name Units
100033 A Work In Progress ICUVALVE.ipt Part Each

140034 B Released ICY O Ring Lubricant Purchased Milliliter

100033 B Releazed ICU Button Paint Purchased Pfililiter
: i @ 100036 A Work In Progress ICU Valve Main Assemiblyiam | Assembly Each
B 100037 B Released ICULBUTN Part Each
| 100038 A Released ICUHCUSG.ipt Part Each
I 10003¢ A Released ICUSPRMG.ipt Part Each
100040 A Refeased ICUENDCP.ipt Part Each
100041 C Work In Progress ICURBUTN Part Each
100042 A Work In Progress ICUQRING.ipt Part Each
100043 A Work In Progress ICUVALVEASSY ilam Assembly Each

Numbering schemes can include such things as company initials, a type sequence, a numeric sequence,
and a manufacturing process code, as in BRD-PRT-10051-P. However, a scheme like this might be
needlessly complex and require too much work to set up and use.

It is recommended that you start the item numbering with a digit other than zero since some
spreadsheets eliminate the leading zeros when data is imported.

NOT

For example, the following
assemblies, and purchase

By Mumber . 7

Revisic

(400012

000013

000014

000015

000016

000017

000018

000019

000020

CURRENTLY |-

000021

FiOIm@MI@ BN

Work In Progress

ICUORING.ipt

Part

Each

000022

T

Work In Progress

ICUVALVEASSY.iam

Assembly

Each

This is poor practice.

a report.

Many software programs such as spreadsheets import the item numbers without
the leading zeros, so item number “000020” appears as “20”, which may be undesirable when creating
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Item Lifecycle States

By setting lifecycle states for items in the Item Master, you can manage design data as it changes. For
example, Items in the Released state cannot be edited. This restriction prevents any changes while the
current revision is being manufactured.

earch Rern Master &

@ % Mumber Revision State Title (ltem, CO) Category Name Units

| 106033 I Work In Progress TCUVALVE ipt Part Each
100034 B Released ICY O Ring Lubricant Purchased Millifiter
1008035 B Released ICU Button Paint Purchased Miltifiter

100036 A ‘Work In Progress ICU ¥alve Main Assembly.iam | Assembly Each

100037 B Released ICULBUTH Part Each

100038 A Refeazed ICUHOUSG.ipt Part Each

100039 A Refeazed ICUSPRNG.ipt Part Each

100040 A Released ICUENDCP.ipt Part Each

1004t C Work In Progress [CURBUTH Part Each

100042 A Work In Progress ICUCRING.ipt Part Each

100043 A WorkIn Progress ICUYALVEASSY Jam Azzembly Each

Lifecycle States Definitions

The following four default lifecycle states indicate where a part is in its design and manufacturing cycle:

. Work in Progres ‘

. In Review — lte N OT tured.

. Released — Item indicates
when the item is

- EE CURRENTLY [

This built-in scheme pr| ddition,

designs that are obsole

- NOTE: that th I ' S E D business

~ _# processes. In Manufactured
and the state

earch frem Master c§

‘%‘@ Mumber 7 Rewdsion State - Title (Hem, CO} Categony Mame Linits
000012 B For Review ICUVALVE. ipt Part Each
000013 C Manufactured ICU O Ring Lubricant Purchased illititer
000014 C ranufactured ICY Button, Paint Purchased hilliliter
000015 B Work In Progress ICU Valve Main Assemblyiam | Assembly Each
000015 [} For Review ICULBUTN Part Each
000017 B Manufactured ICUHOUSG.ipt Part Each
000018 8 Manufactured ICUSPRNG.ipt Part Each
0o001s B Manufactured ICUENDCP.ipt Part Each
000020 D For Review ICURBUTN Part Each
000021 A Manufactured ICUORING.ipt Part Each
000022 A Manufactured HCUVALVEASSY dam HAssembly Each
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Item Revisions

Revisions reflect changes you make to design data. Typically, Vault Professional manages revisions
based on the lifecycle state of an item and the lifecycle rules. For example, if you change a released
item’s lifecycle state to Work in Progress, the revision automatically bumps to the next revision. You can
also manually change an item’s revision; however, this is not recommended in most situations.

Revision Schemes

The current revision of an item is indicated using one of three default types:
. Alphabetical Format

Primary revisions are marked with consecutive letters, such as A, B, C, and D.
. Default ASME Y14.35M Format

Similar to the alphabetical format, but letters that might be confused with others have been
removed (suchas |, 0, Q, S, and Z).

) Default Numeric Format

A simple consecutive numbering system.

e administrator
ault Settings ->
Behaviors (tab) anc

Example of Revisions

When working on §
Item several times

CURRENTLY
USED

The following illust] material

(Revision A), and t

Numb
Lurrent Revision: B
Thumbnail Number Revision T State Title {Item, CO} Units
100028 Al Manufactured | ICURBUTN Each
100028 A Work In Progress |ICURBUTM Each
100028 - Work In Pregress [ ICURBUTNM.ipt Each
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Exercise 1: Work with Item Properties

In this exercise, you add a new item with user-defined properties, link the item to the ICU valve assembly, display
the user-defined property in the item master view, add a customized view for the current project, change the
item project property, group the item master list by project, customize the view by box, and renumber items.

Feryde e ¢

sk nbrogress. | IOLIORING.ISE

ek I Brogress. | WOLNALVEASEY i Hssunibhy Exch WA
el Bragress 0 Valve M Asseebiy.) Bxh WL
Wierk F Progress | BOU O-bing Lubrisart Groage fu Prrchased | Wie ICLNL
ok InProgens  CLARUTHAR Part Bach  EEWVL
otk nfragress | BCUVALYE Rt part Each UM
Yok inPrigras HIRSEGER Pk Bach Wi
Wk i Pregess I BN BT Pt iPurchused Pl 30U
Work In Frogress | FCUSERINA.pt pat Bal ICNL
otk inFrogess  IENEEE Pt fah AL
ik in Progress  ICURELTN Pt Esh  mmt

Add a New Item

tem Project user- defined
ep 7.
1. Start Autodesk Vault |
following information
. User Name: usera
. Password: vault
. Database: AOTCV

2. Under All Folders, clic
for the ICU valve.

lick under name. Click
ies.

Properties dialog box:

he value next o Item

e Right-click item Master. " Project. Enter ICUV1.
® Click New Item.
3. In the Edit item dialog box: Properties:
I bame 7 Value

. For Category, select Purchased.
] For Item Title, enter ICU O-Ring Lubricant.
. For Item Description, enter Grease for

8. On the standard toolbar, click Attachments.
subassembly

9. Inthe Attachments dialog box, click Attach.
10. Navigate to the Designs\ICU Valve\Documents

Numgen 000013 folder.
Cat t s -
steaen . Select ICU Valve Specification Sheet -
Title: - 1CU O Ring Lubricant Grease.doc
Description: Grease for subassembly ° Click Open
Units: . Click OK.

. i 11. On the standard toolbar, click Save and Close.
. For Units, select Milliliter.

The new item is displayed in the ltem Master list.
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12. The ltem Master list now shows the ltem Project
column.

Link Item to the Assembly Note: The new customized view you just
created lists all items in the [tem Master.

Because this list can be very long, you create

(L Double-click the ICUVALVEASSY.iam item to edit it. another custom view that is based on it, but
Click the Bill of Materials tab. that adds a custom filter to search for
“ICUV1” in the Item Project property.
Right-click the top row. Click Edit Bill of Material > in the ftem Froject property
Add New Row. . .
o ) . o Add a Customized View
. 4. In the Find dialog box, click the Basic tab if it is not
) selected already.

- On the Advanced toolbar, select Define
vy 5. Enter Grease as the search text. Click Find Now.

Select the row displayed. Click OK. . . .

) _ . Inthe Manage Custom Views dialog box, with
The ICU O-Ring Lubricant item is linked to the Listing by Project selected, click Copy.
ICUVALVEASSY.iam item.

Custom Views from the Custom Views list.

4. Inthe Create Custom View dialog box, for View
Name, enter ICU Valve 1 Project. Click OK.

\ Number Quantity Title (Item,CO}

- EL 5. With ICU Valve 1 Project selected, click Modify.

} . rign ALVE.ipt . .

L rEg oo 3 ICUTRING.ipt 6. Click Custom Filters.
£ [ 000018 1 ICUSPRNG.ipt .
j,jj__j’f T g ooonts 1 ik gbox, do the following:
7. Click Save and Close. Project.
K tains.

" () Display the User-Definec

1. Onthe Advanced toolbar
Custom Views list.

DOXES.
2. Onthe Advanced toolbar
Views from the Custom tlect ICU Valve 1 Project

. 3. Inthe Manage Custom Vi | ' S E D (?nly- one item, the ICU
L) is displayed because

~ 4. Inthe Create Custom Vie items have ICUV1 in the

stom Filters dialog box.

Name, enter Listing by Prdject. K UR. .
ltem Project property.
Select Listing by Project. Click Modify.
() 6. Inthe Customize View dialog box, click Fields. Change Item Project Property
- . Inthe Customize Fields dialog box, for Select
oy Available Fields From, select Items from the list. 1. Onthe Advanced toolbar, select Listing by Project
O f he C Views i
1 ~— 8. ForAvailable Fields, select ltem Project. rom the Custom Views list.
) —cli i
~ 9. Click Add to add Item Project to the list on the right. 2 :?etmhe Item Master, double-click the ICUVALVE.ipt
M ' v 3. Under Properties, click the value next to Item
,»m} Show these fields in this orden ProJECt' Do the followmg:
(- ftem Icon
| 7 : Nint:"tk;::rnnf Attachments i Enter ICUV1.
St Property Compliance . Click Save and Close.
™ N_umber :
e Title (tem, CO) 4. Repeat the previous three steps for all of the items
) Revision belonging to the ICU valve.

: Descripti ,CO .
PO peseription Lem C0) , 5. Under All Folders, expand Vault Explorer, Designs,
| 10. Click OK. Table.

f«m;,,, 11. Close the remaining dialog boxes. 6. In the Table list, right-click Small Table.iam. Select
L Assign item.
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7. Inthe Assign ltem Wizard dialog box, do the
following:

) Click Next.
) Click Finish.
] Click Close.

Under All Folders, click Item Master.

Edit each of the seven items belonging to the Table
project, and enter Tablel in the Item Project
property.

10. On the Advanced toolbar, for Custom Views, select
ICU Valve 1 Project from the list. Only the ICUV1
project items are displayed.

11. For practice, add a new custom view, called Table 1
Project, which is based on the ICU Valvel project,
by searching for the Tablel ltem project using the
custom filters.

Group the Listing by Project

1. On the Advanced toolbar, select Listing by Project
from the Custom Views list.

2. Inthe ltem Master, right-click the Item Project
header. Select Group by This Field.

Click View menu > Refresh.

4. Inthe Advanced toolbar, click G
it off. The listed items are groupg
project. You can expand or colla
you work.

Ttern Miasts

Ho B e oroas

NOTE: The Group by Box
appear as expected for items that are used
in more than one project. For example, an
item that is used in the Tablel and ICUV1
projects might have an ltem Project
property of “ICUV1, Tablel.” This shared
item lists correctly using the ICU Valve 1
Project custom view and the Table 1 custom
view, but does not list correctly under the
Group by Box Listing by Project View.

Renumber Items

1. Onthe Advanced toolbar, from the Custom Views
list, select ICU Valve 1 Project.

Make a note of which items are assemblies and
which are purchased. In this case, items 100003 and
100010 are assemblies, and items 100011 and

100012 are purchased. (Your item numbers may be
different.)

2. In ltem Master, do the following:

Select the first item in the list.

Press SHIFT and select the last item in the list.
Right-click anywhere over the selected items.
Click Change ltem Number.

3. Inthe Change Item Number dialog box, from the
Select a Numbering Scheme list, select AOTC-

Complex. N

4. Inthe Change Item Number dialog box, do the
following:

. For Type, select 200 to change the o
assembly item numbers. )

° For Type, select 300 to change the

purchased item numbers.

5. Click OK. The new item numbering scheme is
displayed in the Item Master.

| £ Thom Mumber ¢ New Tten Bumber © Type

| 10000 JRi S 2 106

| 1006003 ZO-ERYES 200

{reln SNOFREEE 200

{100 G-y eEE 00

L0009 1DO-SERSE 198

1100002 100 #FEF we

ustom Views list.

Custom Views

e [astitem in the list.
° Right-click anywhere over the selected items.
. Click Change Item Number.

9. Inthe Change Iltem Number dialog box, from the

Select a Numbering Scheme list, select AOTC-
Numeric. Click OK. '

Notice that the item numbers differ from the ones
at the start of the exercise. To avoid confusion, old
item numbers are not reused.
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Lesson 4: Exporting ltems

Overview

Other data management and analysis applications are often used along with Autodesk Vault
Professional. You can export Vault Professional item properties in a range of file formats to provide
engineering and product data to other applications.

Objectives

After completing this lesson, you will be able to:

® Describe how Vault Professional integrates with ERP systems.
. Export item data for use in other applications.

Iltems and ERP Systems

Vault Professional i N O I . You can use
item data from Va ring operations

that are often man

wseems |CURRENTLY

An enterprise reso
inventory, suppliers
modules integrated
contain design and

asing,

ber of software
rofessional
agement of your
b [imited to
Microsoft Excel sprédat 1atar Dr Y p i from any item
(or export selected properties directly from an |tem) in formats accepted by a range of applications.
These file formats mclude text, comma- and tab-delimited, XML, and Microsoft Excel spreadsheet files.
O :

Mumber Title
1100002 Hitch Assembly

1.1 100012150 8678 M12 x 25
1.2, 100008 Hex Thick Nut - Inch 3/4 -
1.3 100007 [Mounting Weldment.iam
1.3.1 100017 end plate | H.ipt

1.3.2 100015 E}rawBarh”lountTinlatejp

BT AT IRAATR RS AIBR funy 171 40f 1

Exported item data in Microsoft Excel
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ERP Systems and Vault Professional

You can export to, and import from ERP systems through a neutral file format, such as CSV.

To import or export items, you must be logged in to Vault Professional as an ERP Manager, as shown in
the following illustration. L

Select Role:

ERP Manager !

R~

ERP Import
File Change File Number

Fite CheckIn
File Check Out =
File Create | L }
Fife Delete Conditionst
File Move
Fite Promote
:Fife Read
File Rename
Fite Undo Check Qut (Current User}
Fife Update

Exporting ltem N OT
“TICURRENTLY
USED

The following steps describe how to export items to a comma-delimited file. You can use the same
Export Items wizard to export items to other file formats.

ats.

Procedure: Exporting ltems

4. Loginto Autodesk Vault Professional as a user assigned the ERP Manager role.

5. Make sure the items to be exported have a Released or Obsolete lifecycle state.
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N O I bne of the items. Click Export Items.

ts are automatically selected for

CURRENTLY

10.

11.

‘DrawBartountTopPlate.ipt 100015

Click Next.
Under Specify Target, select Other. Click Next.

.On the Specify File pane, under File Types, click CSV (Comma Separated Values .CSV).

File types:

I CSY [(Comma Separated Yalues .C5Y)

Under BOM Indicator, click Level Numbers.

The exported file includes a numeric indicator of the hlerarchlcal position of the file in the item
structure. For example, if the first subassembly was assigned Level 1, the first child part in the
subassembly is assigned Level 1.1, the second part 1.2, and so on.

NOTE: If you select Parent Item for the BOM indicator, each exported item, other than the
top- level items, includes the item number of its parent item.

Mumber Title

100002 Hitch Assembly
100012150 8678 M12 x 25
100008 Hex Thick Nut - Inch 3/4 -
100007 Mounting Weldment.iam
100017 .end_plate LH.ipt

100015 DrawBarMountTopFlate i

32 AN AR AIRE S 4 L A4S 40

Click Browse. Browse to your export folder. Enter the file name. Click Save.

. Click Next. On the Specify Attributes pane, drag field names from the Attributes list to the Export

File list. To remove a field from the Export File list, drag it outside the Export list. Click Clear
Mapping to remove all fields except Level.

NoTe: If you select Level Numbers as the BOM indicator, you must include the Number
attribute in the Export File list.

Attributes -
- Humber
Title Mumber
Quantity Title
Ttem Type Quantity
+ Ttem Description Units
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13. Click Export. An export summary is displayed. On the Summary pane, you can print the report or
distribute it by email.

14. Click Finish. The exported file is available for import into an ERP system or other software. An
example CSV export file is shown in the following illustration.

tevel, Number, TitTe,Quantity, Units, 7
1,100002,Hitch assembly,1,Each, - !
.1, 100012,I50 8678 MIZ X 25,4,Eac
. 2, 100008, Hex Thick Nut - Inch 3
.3, 100007, mounting weldment. am, 1
L 3.1,100017, end_plate tH.ipt,l,Eac
. 3.2,100015, brawBarMountTopP | ate.
. 3.3,100013,AN5T ATSC 2x2x 174 - 1
3.4,100016, end_plate RH.1pt.1,Eac

ek

Exercise 1: Export Items from Vault Professional

In this exercise, you change an assembly and its components to a Released lifecycle state, and then
export properties of the items to a tab-delimited text file.

Level Number Quantity units Title Item Type

1 100014 1 Each small Table Genera

1.1 100017 2 Each side Assembly  General

1.1.1 100016 2 Each Leg - Tapered General

1.1.2 100018 1 Each rail - short General

1.1.3 100015 4 each powel - Black walnut General
1.2 100019 2 each Long Rail General

1.3 100015 8 gach powel - Black walnut Genera’l
1.4 100013 1 Each Top General

The completed exercise

1. Start Autodesk Vault Professional. Log in us N O I

following information:

. User Name: administrator eased.

) Password: leave this blank ' l I R R E N I I Y
. Database: AOTCVault
Note: To export items, you must be |

as a user with at least ERP Manager
permissions.

2. Under All Folders, click ltem-Master to disp
list of items in the vault.

3. Onthe Advanced toolbar, select Assembly ltems
from the Custom Views list.

4. In the main pane, right-click the Small Table The lifecycle state of the table assembly and each of
assembly item. its components is set to Released.

6. Inthe main pane, click the Small Table assembly
item.
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7. Click File menu > Export Items. All items associated
with the table assembly are listed in the Export
Wizard dialog box.

Welcorne to the ERP Export Wizard,

Select the items to be exported fo the target system. Salec
deselecting itéms may change the settings on parent o i
- iterns, See help for complete details.

Ley - Tapered:100016
{9 Rail - Short:100018
{F: Dowel - Black Walnut:100015
[ Long Rait100019

4] Dowel - Black Walnut:100015

L Topd0not3

8. Inthe Export Wizard dialog box, click Next.

9. Click Next to go to the Specify File page. Do the
following:

. Under File Types, click TDL (Tab Separated
Values .TXT).

File types:

CS¥ (Comma Separated Values .CSV)

XML

- BOM Indicator
@ Level numbers

% Parent item

° Under BOM Indicator, click Level N
10. To browse for the file location, do the f

. Click Browse.
Browse to the Desktop folder.

13. Click Export. Click Finish to complete the item
export.

Open the file in Notepad and review the data. All
the items in the table assembly are listed.

NOT

For File Name, enter Small Table Ite C U RRE N T I_Y

Click Save.

100013

11. In the Export Wizard dialog box, click Next.

12. On the Specify Attributes page, drag the following
fields from the Attributes list to the Export file list:

. Number
. Quantity
. Units

. Title (Iltem, CO)

USED
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Chapter Summary

All Autodesk Vault Professional users must be able to work with items, using the application’s various
features and functionalities.

You can assign items to CAD files in the vault, or create new items for products not specifically modeled in
CAD.

The list of items in Vault Professional can get very large and awkward to handle. By using customized )

views and filters, you can sort or filter the item list based on item properties to manage the items
effectively.

Having completed this chapter, you can:

) Create, modify, and delete items, use filters to view items, and add and remove file attachments.
. Create, modify, and delete custom views, use filters to view items, and find items.

. Work with default item properties and user-defined properties, including item numbers, life cycle
states, and revisions.

. Export item data for use in other applications.

NOT
CURRENTLY

USED
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Managing Change

Vault Professional provides control over how new designs or design changes are released, eliminating
the issues commonly involved with manual processes. Creating a change order allows you to describe
the changes to a design and manage the progression of that change order as it is reviewed, approved,
orrejected.

Objectives
After completing this chapter, you will be able to:

® Create and revise lifecycles manually.
= Create and approve change orders.
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Lesson 1: Revision Control

Overview

In this lesson, you learn how to use revision control to manually control lifecycle states and how
different workflows affect revision control.

In design and manufacturing, a part may go through many design iterations. Lifecycle states control
the revisions of a part or assembly within this process.

S e s % o

Rewvision Title Jtem, COY

Select Lifecycle State

 Lifecycle State . ) Description

o
=]

o}

=
[

[ 10 :
= Toh - Released Ttemn is ready for production
i
Tod Obsolete Ttem is no longer used in active production
10

] Apply to Children

Objectives

After completing this lesson, you will be able to:

= Define item lifecycle states.
= Control lifecycle states.
*  Manually change lifecycle states.
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Item Lifecycle States

To manage design data you must control the various stages from design to manufacturing. To do this,

you mark an item using one of four lifecycle states.

Select Lifecycle State

Lifecycle State e Deseription t

:Released Ttem is ready for production

Chsolete Item is no longer used in artive production

i 1o Children

Definition of Lifecycle States

The lifecycle state of an item indicates where it is in the design and manufacturing process. The
following table describes the default states:

Work in Progress The item is available for editing. Files associated with the item can be
: checked out and edited. The item can be updated to the latest file
versions.

New items are automatically assigned Work in Progress status.

In Review The item is being reviewed prior to release to productio_n-.
The item and its associated files cannot be edited or updated.

Released The item is available for production based on its effectivity start date.
The item cannot be edited or updated.

Obsolete ~The item is no longer used in production and cannot be updated
Items in the Obsolete state can be deleted.

The actual names of the lifecycle states can be changed to reflect those used in your
organization. This will be covered in a later lesson.
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How to Manually Change a State

To change a state, right-click the item in the Item Master and select Change State. The Select Lifecycle
dialog box displays the states and options available based on the current state of the item.

In the following illustration, the item is set to Work in Progress. You can select In Review, Released, or
Obsolete. The availability of Apply to Children and Set Effectivity depends on the selected lifecycle
state.

Select Lifecycle State

Lifecycle State Description

Released Item is ready for production

 Obsolete Lrern is no longer used in active production

Example of a Manual State Change

The design team has determined that a part is ready for manufacturing. During the design phase, the
part has a Work in Progress lifecycle state. You set the lifecycle state to Released to indicate that the
part is ready for manufacturing and distribution.

Controlling Lifecycle States

You can change lifecycle states manually or they can change as a function of change order workflow.
The settings created by the administrator determine the way in which lifecycle states affect revision
control.

Example of a Bump Rule

Although a part has been in service for a period of time, its failure under certain conditions requires
that it be modified. Currently, the lifecycle state of the part is set to Released. When you change this
state back to Work in Progress, you create a revision.
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Procedure: Setting the Bump Rules

The following steps describe how to set the bump rules.

NOTE: You must be an administrator to complete the following procedure.

1. Select Tools -> Administration -> Vault Settings. Select the Items tab and under Lifecycles click the

Rules buttons to display the Administer Lifecycles dialog.

2. The four columns display the possible transitions of lifecycle states.

3. Select a state and then click Edit.

4. The Lifecycle Rules dialog box is displayed.

State Transition from WIP to In Review

From State To State Descrjpﬁon Lifecya;.le Type
Work In Progress Chsolete ?rzr; ?:qs; ;an:)i:;:tde Tem Lifecycle
Work In Progress Released ?recmm P\‘;;;pt;‘:né:;::5:3 Itemn Lifecycle
» ;%Warkln Progress - - , = : .
e o
’ Released Woerk In Progress ;treor:q P‘;::::;i?:z;; Jrem Lifecycle
: Obsolete In-Review 2:; yg;:;?:t?gg?:ieviaw Item Lifecycle
Obsolete Work In Progress gecr’: }(1;;::;2:::;% Trem Lifecycle
InRevew Obsolete geo';’l’:;’efi‘;;“‘t‘;"gimle& Trem Lifecycle
In Review Released g:::«‘[’:;:gi&n;;ease g Item Lifecycle
ey Gos

Rule

Action

# iBump Revision

[Mone

Bumyp Primary Revision
Bump Secondary Revision
Bump Tertiary Revision

5. By default, all transition rules, except Released to WIP, are set to None. To modify a rule, select a

new bump revision rule from the Action list. The four available revision sequences are None, Bump

Primary Revision, Bump Secondary Revision, and Bump Tertiary Revision,
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Revisions and Lifecycle State

By default, when you change an item’s state from Released to WIP, the revision automatically bumps
using the primary revision bump action.

The following state changes do not bump the revision status of an item:

WIP to Obsolete
WIP to Released
WIP to In Review

In Review to WIP

Obsolete to WIP

Revision Formats

The administrator or creator sets the revision sequence and can either specify one of the formats
shown in the following illustration or create a custom revision scheme.

ilter <&li Rewision Schemes>  ~

Released to Obsolete
In Review to Obsolete )
In Review to Released

Obsolete to In Review

New.: [DCopy, / IS Delete | & Import.

Schemie Name

Default ASME Y14.35M Format

Bescripti

Default Mumeric Format

Standard Alphabetic Fermat

Culy characters are permitted within the primary format

Standard Numeric Format

Sequential numbering starting from 1

Scheme Details

Scheme Values:

t

Preview | Seherme Format | Comments

Revision primary sequence values:

T T M ) o e

- Example Revision Formats
Delimiter Characten
Primary:

) Setohﬂary:

v Tertiang

Examples of the revision format are displayed in the Preview tab of the Revision Scheme Definitions

dialog.
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Changing States Manually

Administrators and creators can change an item’s lifecycle state manually in the ltem Master.

Rewision . State

Change Item Mumber..,

Change Revision...

Change State...

, Py
ange Effectivit®.

1 attachmentz..,

Definition of Manually Changing Lifecycle States

You can use lifecycle states to control the release status of items by manually changing an item to
Work in Progress, In Review, Released, or Obsolete.

Changing a State

To change a state, right-click the item in the ltem Mastef and select Change State. The Select Lifecycle
dialog box displays the states and options available based on the current state of the item.

In the following illustration, the item is currently set to Work in Progress. When the Select Lifecycle
dialog appears you can select In Review, Released, or Obsolete. Notice that the options Apply to
Children and Set Effectivity are not available.

Select Lifecycle State

Lifecycle State Description

Itern is ready for production

§ eleased

Chbsolete Fem is no lenger used in active production

Hapolyto Children
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Lifecycle State Options

When you select a state, the options available vary.

Work In Progress

In Review

Released

Obsolete

Apply to Children is available but not set. If the item has children,
selecting this option will also set their lifecycle state set to Work In
Progress.

Apply to Children and Set Effectivity are unavailable as options.

Set Effectivity is available as an option. This allows you to specify a
point in the future when the new revision will supersede the current
one.

Apply to Children is selected and cannot be changed. If the item has
any un-released children, their lifecycle state is also set to Released.

Apply to Children is available as an option but is not selected. If the
item has children, selecting this option will also set their lifecycle state
set to Obsolete.
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Exercise 1: Change Lifecycle States Manually

In this exercise, you create an item, attach itto a
change order, and manually change the lifecycle
state.

100030 Work In Progress  |ICUYALVE.ipt

@ 100029 - Work In Progress | TCUYALYEASSY ies

The completed exercise

1. Start Autodesk® Vault Professional®. Log in using
the following information:

User Name: usera
Password: vault
Database: AOTCVault

Click Go menu > Item Master.

On the Advanced toolbar, select All Items from
the Custom Views list.

f Document Items
‘ Electrical Items ,
Electrical Project ltems = ¢

4. Click Go menu > Vault Explorer.

Under All Folders, expand Vault Explorer.

Click Tools menu > Options. Ensure that Show
Hidden Files is selected. The DWF™ files are
displayed

dptiohs

FF) Use large status icons
[ Show working folder location

[ Show hidden files

7.
8.

9.

10.

11.
12

13.

Click OK.

Expand the Designs folder. Click the Clamp
folder.

@ § Content Center Files

= [ De

1 7 ICU Valve
7 Table
£ TrailerHitch
E& Wy Search Folders

Right-click Handle.ipt. Select Assign Item.

D File Name Revision

Open

Yiew in Window,,.

5] Assign Rtem..,
Go Toltem

In the Assign ltem wizard:

» In Preview Items, click Next.
= |n Find Duplicates, click Finish.
= |n View Results, click Close.

An item icon is displayed next to the file name.

! O 0 (ED FileName

Click Go menu > ltem Master.

In the Item Master, click the Number column to
sort the item numbers in ascending order.

In Item Master, right-click the new item.
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14. Select Change State.

Revision State

Chznge ltem Number...

Change Revision...

NOTE: Your item number may differ
from the illustrations shown in this
exercise. Your item should be the
highest number. In this example, it is
100002.

15. In the Select Lifecycle dialog box, select
Released.

16. Click OK. Notice that the revision is a dash (-)
and the lifecycle state is changed to Released.

o 2 % SR

@ % Number Title (Ttem, CO)

E) |"|100002 ‘- | Released Handle.ipt

17. Click Go menu > Vault Explorer.

18. Review the part. A lock symbol is placed beside
the part. You see this symbol because of the
Enforce File Locking per Lifecycle State setting.

[ Fite Mame

B3 Handlept
0 Handie.ipt.dwf

19. Click Go menu > ltem Master.

20. Right-click the item. Select Change State.
21. Select Work In Progress.

22. Click OK.

23. Review the status of the part. The Revision is
now set to A.

) 5 Number. #  Revision State Title (tem, 00}
1100002 A

| Work in Progress | Handle.ipt

The bump rules determine which actions take
place for a change of lifecycle state. In this
example, the administrator has selected the
default behavior of a primary revision using the
Default Alphanumeric Format.

24. Return to Vault Explorer. Notice that the lock
icon is removed from the part.

The part is now set to Work in Progress and the
company wants to create a series of revisions
before releasing the part. To do this, you use
secondary revisions.

25. Return to the ltem Master.
26. Right-click the item. Select Change Revision.

Number Revision State

Restore...

Change Item Mumber...

Change State... be

27. Select Next Secondary. Click OK. In this example,
the revision is A.1.

Select a Revision
#% Next Primary B

@ Next Secondary AL

& Next Tertiany CorARd

#5 User Specified

The modification to the part is now complete.
You select a new secondary revision.

28. Right-click the item. Select Change Revision.

29. Select Next Secondary. Click OK. In this example,
the revision is A.2.

The secondary revision is now complete. The
desigh team wants the part to be reviewed.

65

N




30. Right-click the item. Select Change State.

=Select & Revision

 Next Pamary B
@ Next Secondary Al
& Next Tertiary ALl

- User Specified

31. Select In Review. Click OK.

@ U} % Number /. Revision State Title (tem, CO}

32. Return to Vault Explorer. Notice that the part is
locked.

33. Return to Item Master.
34. Right-click the item. Select Change State.
35. Select Released. Click OK.

Select Lifecycle State

Lifecycle State Description

m is avaitable for editing

36. The lifecycle state is changed to Released and
the revision stays at A.2.

0 'S Number ¢ . Revision State Title (tem,CO)

37. Return to Vault Explorer. Notice that the part is
still locked. After the part is released, you decide
that further work needs to done.

Return to the ltem Master. Right-click the item. Select
Change State.

38. Select Work in Progress. Click OK.

Select Lifecycle State

Lifecycle State Description

ltem is no longer used in active production

39. The lifecycle state is changed to Work in
Progress and the Revision changes to B.

Resision State

0 @ Number

Title (fem, CO}

40. Return to Vault Explorer. Notice that the part is
unlocked. You can now make modifications to
the part.
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Lesson 2: Change Orders

Overview

This lesson describes how to create change orders to control the release of new designs or changes to
those designs.

You must have Vault Professional Creator or Vauit Professional Reviewer permissions to create or
participate in a change order. In addition, the administrator defines appropriate change order
permissions for each participant in the change order process.

Subsnit and Force Approval

withdraw Fast TrackApproval

Subruit

Submit

i T

H

{ Re-Open

CREATE

Set Effactivity

;
|
4

Cancel

S

Double dicken astate forsummary information

Objectives

After completing this lesson, you will be able to:

Review the Change Order dialog box.
Create a change order.

Attach an item to a change order.
Review lifecycle states.

Review change order routing.
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When you create a revision, design changes are made and the changes are then approved by one or

Introduction to Change Orders

more people. Using the Change Order process, when you (the change requestor) modify files or items,

the change is routed to the correct members in the design team before being released to production.

Unlike the manual process covered in the last lesson, files and items associated with change orders will
automatically change state depending on the results of the approval process.

8 5 Number State Title (tem,CO)
| |ECO-000007 | Approved eview saftey brack stress analysic

carch Change Orderiist o ﬁ

Due Date
4720/2010 1:32

Submit and Farce Approval

Withdrav

Fast TrackApproval

Submit

Subrmit

DPEN

Definition of Change Orders

Cencel

{Cancel

Set Effectivity

¥

Doubte clickon astate forsummary information

You can use change orders to both describe the changes made to a design and to manage the progress

of those changes through review, approval, rejection, and release to production. The Change Order
dialog box provides a historical record of why, how, and when changes were made.

-

Change Order Number:

Change Order Title:

o -

Release Inital Version for Protetyping

Detailed Deseription:

Approve and release the clamp parts, assemblies and documents

Due Date: Submitted by:

Date Submitted:

472372010

Propertiss;
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Description of Change Order Workflow

The Status tab in the Change Order dialog box displays a workflow chart of all possible combinations of
state progressions.

g Qrcer List a -'k

M

Submit and Force Approval

| Withdrave Fast Track&pproval

¥

mwpprc\‘e APPROVED

Submiz Sebmit

Set Effectivity

g-Open

Double clickon astate for summary snformation
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Change Order Workflow Chart

You can also visually identify the current status of the change order by clicking the Status tab on the
respective Change Order dialog box. Double-clicking a state gives you summary information about that

state.

QPEN

WORK

REVIEW

L

APPROVED

REJECTED

CAMCELLED

CLOSED

After a user has created and submitted the change order, the change order enters the Open
state. In the Open state, the Change Administrator can edit the title, edit the value of a user-
defined property, and change the attachments.

As soon as the change order enters the Work state, the Responsible Engineer is notified that
there is a change order requiring attention, and the following occurs:

*  The change order number is added to each participant’s work list.
* An email message is sent to each person on the routing list if they have
subscribed to.email notification for change orderevents.
As soon as the change order enters the Review state, routing participants are notified that
there is a change order requiring attention, and the following occurs:
= The change order number is added to each participant’s work list.
= An email message is sent to each person on the routing list if they have
subscribed to email notification for change order events.
When a participant with Approver status approves a change order, the change order enters
the Approved state. ,
In the Approved state, the Change Administrator must set the effectivity date to release the

items for production on the change order.

When a participant with Approver status rejects a change order, the change order enters into
the Rejected state.

As a Change Administrator, you can do the following:
®  Cancel the change order.

= Reopen the change order.

Inthe Cancelled state no action can be taken by anyone.

In the Closed state no action can be taken by anyone.
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Create a Change Order

Use the Change Order dialog box to create change orders. A change requestor initiates the process and
adds comments, attaches files, and selects the routing participants.

|
|

Change Order Number

' ECO-000006

Change Order Title:

Release Inital Version for Prototyping

Detailed Deséription:

Approve and refease the clamp parts, aszemblies and documents

Change Order Options

The tab functions in the Change Order dialog box are described in the following table.

Specifies the change order attributes, including the list of items

General associated with the change order.
Lists files and/or items (collectively called Records) associated with the
Records ~
change order.
Comments Contains the decisions for the change order in the form of comments,
replies to comments, attachments, and markups.
Files Lists all files including all those associated with items andany added
: markups. ~ ,
Routing Lists the participants involved with the current change.
Status Shows the-current status of the change order in a workflow diagram.
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Change Order Number

As an administrator, you can create numbering schemes that meet the needs of multiple projects. For
example, you might want to distinguish between change orders created by Manufacturing and those
submitted by Engineering. The change order numbering schemes are accessed on the Tools menu >
Vault Settings > Change Order tab by clicking the Define button in the Change Order Numbering group.

Modify Change Grder numbering fist :

L. Mame

) FastTrac
THCE

Procedure: Creating a Change Order
The following steps describe how to create a change order. You must have Administrator or Change
Order Editor Permissions to create or participate in a change order.

1. You can right-click on items in the Item Master or file in the Vault Explorer view to display the
context menu. Select New Change Order..

PinBipt
Pivot_Lower.

Work in Progress

Unable to view the fite selected. Cli an g
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2. The Change Order dialog box is displayed.

| General

Change Qrder Nuimber: ; State:

ECO-00000% Create

Change Order Title!

Detaited Description:

Due Date: Submitted by: Date Submitted:

{4717/2010 R

Properiies:

Mame

3. Click the button next to the change order number [...] to display the Change Order Numbering
Scheme dialog. Select a numbering scheme from the list.

Modify Change Order numbering fist:

L. Name

;%ECG SR CRNE .

{FastTrac
TMCO

NOTE: The numbering scheme cannot be changed after the change order has been
created and has entered the Open state.
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4. Enter a title under Change Order Title and enter a detailed description. Under Due Date, select a
date when the change order is to be completed

General %Ré;ogds e

ECO-000009

Change Order Title:

EMDdify Pin A for tighter fit

Detaifed Description:

Customer service reports that the ping are coming loose due to too muth play in the assembly. Need to determine what 4
- the optimal diameter is and adjust the design.

Due Date; Submitted by Date Submitted:

Janramo P

5. Click the Records tab. The file selected in step 1 is displayed.

Lock For: [ A

) Description  Revision State {Hist... | - Units
» @; H n_Adl ! | :1& §Workin Pre...

You can use the Add button to attach other files or items to the change order.

6. Select the Comments tab. Select Add Comment to add information about the required design
change, etc.

) Created 8y Created

Pin diameter needs to be increased to account for excessive play. See the attached photc for detalls from 2 returmed *
part.
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7. Click the Routing tab. Select a routing list.

ecords | Commer

Specify the routing to be used:
8 Unanimous. Approval is Not Required for Selected Routing in
s gj " Review State

Default i

Users Routing Role

T userh
usera Change Administrator, Responsitle Engineer
Administrator Netification User

8. Click Save and Close to create the change order and exit the dialog box.

Change Orders and Revisions

A change order can automatically generate a primary revision to the items or files included in the
change order. You can also manually change the revision for any work-in-progress item or file.

Definition of Change Orders and Item Revisions

You can manually change an item or files revision regardless of its participation in a change order.

Title (ftem, C0)

' 8 ' uber

PinB

Work In Progress

164016 . Work In Progress | Lower Pivot i
100017 - WaorkIn Progress : Threaded Phvot
100018 - Work In Prograss | Screw

Work In Pregress | SHCS_10-324

Revise from: .~ .- Latest {Non-Released Biased)

Select next revisioni §Pfimary

i i Mame Revision Revision Definiticn g

h
P
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For example, if a part is currently a work in progress, a department can create a secondary revision to
indicate a design change.

~Select 3 Revision

5 Next Primary ¥
@ Mext Secondary el
& Next Tertiary B

@ User Specified

By default, items are locked and only the Change Administrator and Responsible Engineer can make
them editable. If an item in the Released state is added to a change order and editing is enabled, the
item’s state changes to Work in Progress. A new revision is automatically created unless the bump
revision action is set to None in the Lifecycle Rules dialog box.

Example of a Revision Change

In the following example, the part file Grip.ipt is released and has a revision A. When you use the
Change State option to change the item state to Work in Progress, the revision changes from A to B
and the part is now editable.

Change Item Number...
Change Reyvision...

Changs 5§

Change Order and Item Revision Rules

When items are controlled with a change order, the rules about changing state are different than non-
controlled items.

= Only users with Vault Professional Creator, ERP Manager, or Administrator roles can change
the state of an item.

=  When you add an item to a change order, the item’s lifecycle is controlled by the change
order.
If a change order is rejected, the item version remains unchanged.
Approval of a change order changes the state to Released.
To set the effectivity of an item under a change order, you must set the lifecycle state to
Released.

=  The BOM shows the most current revision of the released children.
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Change Orders and Lifecycle States

You can change the lifecycle state of an attached item and make it editable in any change order state
such as Open, Submitted, or Approved. You cannot change the lifecycle state in the change order if the
change order is in Closed or Canceled state.

o g o

Associated Records: LockFer

i
|
I

Units

State (Historical}

Description. | Revision,

Select Lifecycle State

Lifecycle State

Rell Back Lifecycle State Change...

Example of a Change Order

Engineering has been notified that a part has had a higher-than-expected failure rate under certain
conditions and must be redesigned. When you create the change order for the existing item, the part
can be modified and the change routed through the design team for approval.

When the item is not included in an active change order, you can manually change the state of the
item.

Opgen..

Update...

Restore...

Change ltern Mumber...
Change Revision,.
Change State:. h

- Change Effectivity...

Sttachmarde..
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When the item is attached to a change order, this functionality is not enabled.

hange Item Number...

hange Revision..,

Rules for Using Change Orders and Lifecycle States

When you attach items to change orders:

Manual lifecycle state changes are not permitted.

The items can be in the Released state.

Files are locked and not editable on Released items.

You can change the item’s state from Released to WIP.

Obsolete items cannot be added to change orders.

Items put into the WIP state on change orders can be released only upon approval of the

change order.

* If'the change order of an item whose state has been changed to WIP is rejected, the item
cannot be rolled back.

= If the change administrator changes Allow Edit on a change order so that the item cannot be

edited (check box on Allow Edit is off } on an item in the Work in Progress state, the item

changes to In Review so that it is not editable.

Identifying Change Order Participants

When you create a change order, you specify a routing list of participants with predefined roles and
specific permissions and responsibilities. Participants are notified that a change order requires their

attention. The change requestor and approver roles control the progression of the change order. The

reviewer role can only view, add, and reply to comments.

erts | B

Specify the routing to be used:

Unanimous Approval is Net Required for Selected Routing in
" Review State o

Users: Routing Role

Approver

usera Change Administrator, Responsible Engineer
Administrator Notification User
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Example of Change Order Routing

The administrator creates routing participant lists in the Global settings dialog (Tools menu >
Administration > Global Settings > Change Order tab) dialog box, as shown in the following illustration.

Routing Definition

) Define Chaniye Order Routing Li
X ge Order Routing Lists
EA

Select workflow definition to use

q
on new Change Orders: Standaed

Lists can contain any number of users, but you must specify at least one Approver, one Responsible
Engineer, and one Change Administrator in order to create a routing list.

Routing participants:

Users Routing Role

Approver, Responsible Engineer

USETC Approver

To set the routing, the administrator can select Unanimous Approval for Review State Required in the
Routing Settings dialog box.

Routing Nare: Grcsg:B

. Change Order participants: Routing participants;

: Users Users Routing Role

usera Change Admi..,
userb Approver, Res..
HSErc Approver
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Routing Editing Rules

The following rules apply to editing the routing after the change order has been created:

= Depending on the state of the change order, anyone on the routing list can add another
Reviewer, except for Notification User.

®  The administrator, Change Administrator, and Responsible Engineer can add and remove
Approvers and Change Administrators.

= Only the administrator, Change Administrator, and Responsible Engineer can remove a

Reviewer.

Assigning a role to the administrator on a routing list can their ability to edit routing lists.

The author (the creator of the change order) can never be removed.

Change order activities can only be performed by the routing participants.

Anyone can create a change order even if they are not on a routing list. This user becomes the

Change Requestor

Notification

A user on the routing list is notified when the change order enters a state that requires their attention.
There are three notification methods:

* My Worklist: In the navigation pane when All folders or Change Order List is displayed. The
change order number and due date appear on this list. Clicking on a change order in this list
will change the main pane to Change Orders with that change order selected.

*  Pop-up alert: Similar to Outlook e-mail messages, these appear briefly in the lower right hand
corner when a change order is added to the user’s work list. This pop-up message can be
turned off or on. By default, the pop-up notification is on. To change the setting, click View
menu > Notification Display.

* E-mail notification. The administrator must configure Autodesk Data Management Server for
email notification and Vault Professional users must have valid e-mail addresses in their user
profiles.

Routing participants are notified

= The change order number appears on each Routing participant’s ‘My Worklist’ list depending
on the state of the change order. For example, the Responsible Engineer is notified when the
change order enters the Work state, but the Approver does not get notified until it enters the
Review state.

* Following the same logic, an email message is sent to each person on the routing list
depending on the state of the change order. For example, the Reviewer is notified by an e-mail
when the change order enters the Review state.

»  Vault Professional includes a role called Notification Users in the ECO Routmg tab. This user is
notified when a change order is closed, usually indicating that a new revision of items or
documents is now available.

*  If Vault Professional is running but inactive, a pop-up alert appears momentarily on the user’s
screen in the lower right corner when the change order is added to his or her work list.
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Participants and Change Order Roles

The following steps describe the typical workflow for creating a change order as well as the roles of
participants at each step in the process.

1. A user creates a change order. This user can be any member of the design team as long as they )
have a Change Order Editor role. The following actions occur: £

They are added to the routing list as a Change Requestor.
The change order enters the Create state.

The Change Administrator is notified.
The Change Requestor or the Change Administrator submits to the Open state. e

2. Inthe Open State the Change Administrator reviews the order and determines whether to add
comments, markups, or additional properties. .. T

* The Change Administrator selects the items in the Records tab of the change order and
changes state to put them in Work In Progress.
The Change Administrator submits the change order to the work state.

=  The Responsible Engineer is notified.

3. If the Change Administrator did not put the items into the Work In Progress state the Responsible
Engineer can at this point. The Responsible Engineer checks out the files from the vault and
modifies them with regards to the change order. The files are then checked back in to the vault,
the items are updated and the State changed to In Review.

4. The Responsible Engineer submits the change order and it enters the Review state.

5. The Reviewers and Approvers are notified. They can review the design changes, add comments
and markups. The Approvers can, at any time, accept the change order. If the administrator has
selected the Unanimous Approval for Review State Required in the Routing Settings dialog box, all Y
Approvers must review and submit their acceptance of the change order. The change order is now g
set to Approved.

6. The Change Administrator is once again notified. He or she now sets the change order effectivity.
The date for the item to become released is specified in the Set Effectivity dialog box. Any Work In
Progress or In Review items on the change order at set to Released.

7. The change order is now closed. All Notification Users are notified by e-mail (if configured),
indicating new items are ready for production.
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Exercise 1: Create and Approve Change Orders

) In this exercise, you create two change orders. You submit and approve the first. For the second, three routing
participants must approve the change order because unanimous approval is required.

Db s = B B ey MRt

The completed exercise

Create and Approve Change Orders An icon is displayed next to the part name and
the associated drawing.

1. Start Autodesk Vault Professional. Log in using
the following information:

» User Name: usera O 0 B FileNome
» Password: vault B Gripiipt
= Database: AOTCVault i _@ﬁiunp idwe.dif
B Gripad
In Vault Explorer, expand the Designs folder. ;&iécx;:ptm cwf
3. Click the Clamp folder. [y Clamp.iam
6. Switch to the Item Master. Right-click the new
& () AOTCau - usera item. Select New Change Order.

Change Crder List
Ttem Master
5 R Vault Explorer 15)
i} 8 Content Center Files
=R ealel

£ U Ve 0% Number Revision' -~ © State

£ Table

7 TrailerHitch
o B
@ B3 My Search Folders

Right-click Grip.ipt. Select Assign Item.

Change Item Number...

5. Inthe Assign Item wizard, Preview ltems page, P
click Next. Do the following: Genera! | Hisory | 311 ot

. Change Reyvision...
Change State,.,

On the Find Duplicates page, click Finish.
= On the View the Results page, click Close.

| Attachments..,

New Change Order...
Add Te Change Chrder...

Export fréms .
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7. Inthe Change Order dialog box, General tab, for
Change Order Title, enter Modified hole
diameter.

8. For Detailed Description, enter Increased hole
diameter to 7.92 mm.

9. Click Save. Close the Change Order dialog box.

You can now customize the view to indicate that
the item is controlled by a change order. To do
this, add a field to the table.

10. In the ltem Master, right-click one of the column
headers. Click Customize View.

Mumber 7 . Revision  .State

Sert Ascending

_ Sort Descending

. Group By This Field
- Group By Box

Remove This Column

. Alignment
-

11. In the Customize View dialog box, select Fields.

12. Under Select Available Fields From, select items
from the list.

Seldct available fields from:

i iltemlcon

1. {Number of Attachments
Property Compliance
i Number

Revision

iiState

Title {item, CC)

Category Neme

- i Units

Description (ltem,C0}

lyp
Category Glyph (Histerical)
| Category Neme (Historical)
Comment

Controlled By Change Urder

Current Qwner
Date Modified
jEff.End

Ef. Start
Effectivity
Equivalence
Itern Customar
Ttern Material :
Item Project o
Lest Updated By i
Leased Until M

13. From Available Fields, select Controlled by
Change Order.

14. Click Add.

15. Under Show These Fields in This Order, select
Controlled by Change Order. Click Move Up until
it is below Number of Attachments.

Show these fields in this orden

Item Icon o
Mumber of Attachments

Property Compliance
Number

Revision : X
State [
Title (Ttem, CC) i
Category Mame

16. Click OK.

17. Click Close. An icon is displayed next to items
controlled by a change order.

‘T Number Revision State

Contrelled by Change Order _
CTRL + click to go to change order.

NOTE: Your item and change order
numbers may differ from the illustrations
in this exercise.

18. Switch to the Change Order list.

19. In the Change Order list, right-click the new
change order. Do the following:

= Select Respond > Submit.
= (Click OK to dismiss the Submit — Add
Comment dialog.

The status of the change order is set to Open.

20. In the Change Order list, right-click the new
change order. Do the following:

=  Select Respond > Submit and Force

Approval. .
= Click OK. )
NOTE: Usera is a Change Administratorandcan ()
force the approval of a change order. Yy

21. Select the change order.
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22. Click the Status tab to display the workflow
chart. Do the following:

= Double-click the Approved state icon to

L) display summary information about the

N state.

— S

R

= Close the Summary dialog box.

i

. TrackApproval .,L
Rpprove
APPROVED
s '\‘\, Set Effectivity
\ ;
o : |
}

23. Right-click the new change order. Select
Respond > Set Effectivity.

NOTE: Only a Change Administrator.can perform the
Set Effectivity activity on an item attached to a change
order. The Change Administrator must set the
effectivity in the Approved state to release the items to
production and close the change order.

Click OK twice.

24, Review the status. Because the effectivity was
set to immediate, the status is now closed.

isat Effectivity

CLOSED

25. Switch to the Item Master.
26. Select the item.

27. In the preview pane, notice that the lifecycle
state is set to Released.

Lifecycle State: Reldased -

Revision: -

Last Updated By: = usera

Last Updated: - 4/17/2010.7:09 BM

Create a New Change Order

Switch to Vault Explorer.
-Switch to the ltem Master.

In the Item Master, right-click the item created
in the previous section of the exercise. Do the
following:

e Select Change State > Work in Progress.
e Click OK.

Acrevision is created. In this example, the new revision is

Revision ; State

Title {ftem,COY

Right-click the item. Select New Change Order. Do

the following:
= For Change Order Title, enter Increased
notch depth.
=  For Detailed Description, enter Notch depth
increased to 3.18 mm.
4. Under Properties, Value column, click Design.
Select Manufacturing from the list.

Properties:
Name 7 Value

Customer Support

Manufacturing
Warketing
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5. Go to the File Name tab the Attached Files list,
select Grip.idw. Do the following:

= On the top view, zoom in to the notch
feature.
Click the arrow next to Create Markup.
Click Rectangle callout, revision cloud.

J37 Rectangle catfout

Circle callout

A Triangle callout

|7 Rectangle callout, revisicn cloud: oo

Circle callogt, revision cloud %

ZF Triangle callout, revision cloud

Circle czllout, revision pelycloud

C})j
,‘2‘)
ez
¢ Rectengle catlout, revision polycloud .,
&
5

b Triangle caflout, revision polycloud {

.

6. Click and drag to create a markup around the
notch.

7. Inthe text box, enter Notch depth increased to
3.18 mm.

8. Click Fit to Window. @'

9. Click the down arrow next to Stamps. , T l
Do the following:

= Select the For Review stamp.
= Click in the sheet to place the stamp.

7]

10. On the toolbar above the DWF window, click
Save. Do the following:

= |n the Save As dialog box, navigate to the
Clamp folder.
= Accept the default file name

Click Save to add the markup file to the vault.
11. In the Add Comment dialog box, do the
following:

= For Title, enter Notch depth increased to
3.18 mm.

= For Comments, enter Due to a number of
failures in the field; the notch depth has
been increased.

»  (Click OK.

Comment

Title: Motch depth increazed to 318 mm

Comment:

{ Due to a number of failures in the field the notch depth has been increased)

Inzhudde origingt message

12. Click the Routing tab. From the list, select
GroupB.

13. Review the Routing participants. usera, userb,
and userc are part of this group.

= ysera is the Change Administrator. Since
usera is creating the change order he will
also be the Change Requestor for this
change order.

= userb is an Approver and the Responsible
Engineer.

= ysercis an Approver.

The administrator created this list with
unanimous approval required for a change
order.

k § Unanimous &pproval is Required for Selected Routing
" in Review State




.

o

14. Click the Status tab. The workflow chart shows
that the change order is set to Create.

! P 2

353
Pt Teadiazmens H

Onstie iy srtabirpasmanary indyrnsn

15. Click Save. Close the Change Order dialog box.

16. In the Change Order list, right-click the new
change order. Do the following:

= Select Respond > Submit.

= Click OK to dismiss the Submit — Add
Comment dialog. Note that by default a title
is entered indicating the ECO is submitted to
the Open state.

8 5 Number State ¢ Title (ftem,C0)
| Modified hole diameter

17. In the Change Order list, select the new change
order. Click the Status tab to display the
workflow chart.

Gestedtrnassan i aiommson

18. In the Status diagram, double-click the Open
state to display the summary information about
the state. Close the Summary dialog box.

usera submits the change order again to change
the status to Work.

19. In the Change Order list, right-click the new
change order. Do the following:

Select Respond > Submit.

= Click OK in the Submit — Add Comment
dialog box, again accepting the default
comment.

Note in the Status tab the new state of the
change order.

Submit andFarce s

; Withdrae

Submiit Sybmi

Re-Open

You now log in as userb, the Responsible
Engineer.

20. Click File menu > Log Out.
21. Click Log In.
22. Log in using the following information:

User Name: userb
Password: vault
= Database: AOTCVault

23. Review My Worklist. The ECO is listed.

ECQ-000003 (417720101

Clicking on the ECO in your worklist will take you
directly to the Change Order list with the change
order selected.

24. Click the Comments tab. Review the comments.
Note the details in the comment titled Notch
depth increased to 3.18mm. Right click on this
comment and view the attachment.

| Genera Records| Comments | Files;

; Title

ECO-000003 Submit to Open
%l p
L.G# ECO-000003 Submit to Work

Bus to 2 nurmnber of faifurss i the field the notch depth has been increased
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25. Select the Files tab and click the attached
markup file clamp_markup.dwf in the Attached
files list. Note the markups on the drawing.

26. In the Change Order list, right-click the new
change order. Do the following:

=  Select Respond > Submit. This will move the
change order to the next state Review.
®  The Submit — Add Comment dialog appears.
In the Comments field enter “Reviewed by
the responsible engineer. The new design is
EOOQFE 3’\ ?nﬁ correct.”

rome.
= (lick OK.

Title: ECO-G09003 Submit to Review

Comment:

Reviewed by the respeasible engineer, The new design is correct|

27. Note that the change order still appears in My
Worklist. The change order requires unanimous
approval from all reviewers. In addition to being
the Resposible Engineer, userb is also a
Reviewer. userb must also approve the change
order.

28. In the Change Order list, right-click the new
change order. Do the following:

= Select Respond > Approve.

= |nthe Approve — Add Comment dialog enter
“The design has been reviewed and is
correct. Ready for re-release.”

= (Click OK.

Comment

Title: ECO-000G003 &pprove to Approved

LComment:

i The design. haz been reviewed and is comect. Ready for re-release.

Inchudz original message

29. Select the Status tab. Note that the change
order state is still Review. Double click on the
State to review the status. The change order
requires unanimous approval from all reviewers.
userc must also approve the change order.

“ast Track&pproval £

Approve
REVIEW PR

Mo Activity
sera:
Mo Activity
serby:
Approve
SeC;

Mo Activity

30. Click File menu > Log Out.
31. Click Log In.
32. Log in using the following information:

User Name: userc
Password: vault
= Database: AOTCVault
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33. Note that the change order is in My Worklist.
Select on the change order to switch to the
Change Order list with the change order
selected.

34. Double click on the change order to open it for
review.

35. Select the Comments tab and review the
comments.

N d sty Greved
£ Hoteh depth Bycarancdto 18 me § we AT

D000 Sl 4 Dot ey SABLA VAT .
uanry SORING T8
ECL 003 Subeit 4 Resdeve e RN LI o

j{ The disian his besn mdavad ki I comect, Reilifor igrekende:

36. In the Respond toolbar note that there are two
possible icons enabled — Reject and Approve.
Select Approve.

Appﬂrcfa% ..

o Title # Crented By

37. In the Approve — Add Comments dialog enter in
the Comment section “Agreed — ready for
immediate re-release.”

38. Select OK to dismiss the dialog.
39. Close the Change Order dialog box.

40. Click the Status tab. Because all three
participants have approved the change, the
state is set to Approved.

SHrde g st S

The Change Administrator is responsible for Closing the
change order by setting the effectivity of the items on
the change order. In this scenario usera is the Change
Administrator.

41, Log in as usera using the data provided earlier in
this lesson.

42. Note once again the change order appears in My
Worklist. Select on it to go to the change order.

43, In the Change Order list, right-click the new
change order. Do the following:

Select Respond > Set Effectivity.
In the Set Effectivity — Add Comment dialog
enter “Release set effective immediately.”
» Click OK.
= In the Set ltem Effectivity dialog review the
default settings. Note that it is possible to
set the effectivity in a future date by
selecting the date drop down. In our case
we will set the item new revision to be
immediately available for manufacturing.

Sungdup Apend 18, 2038
Rpil, 260 [

Nan Mtor jur Wed Tee R R

= Click OK to dismiss the dialog and create the
new revision.

44. In the Change Order list, review the status of the
change order. Note it is now closed.

Fags

Son v

Dreissickonrameior TS

45, Select the Records tab and note the Revision
and State (Historical) of the item. It has been
now released at Revision A.

8! Records (¢

Associated Records:

Description - . Revision | - State (Historicaly
PA i Released
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Chapter Summary

In this chapter, you learned how to use Autodesk Vault Professional to attach items to a part
and then create a new change order using the item. You also used the preferred work flow to
release and set the effectivity of a part.

Having completed this chapter, you can:

Create and revise lifecycles manually.
»  Create and approve change orders.

4

M

r“.m\;

™
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Autodesk

Working with Bills of Materials

This chapter describes how to use bills of materials in Autodesk® Vault Professional®. You learn how
these BOMs are integrated with other applications, including Autodesk® Inventor® and Autodesk®
Vault.

Objectives
After completing this chapter, you will be able to:
Manage bills of materials (BOMs).

* Describe the integration of Inventor, Vault, and Vault Professional and the relationship between an
Inventor bill of materials (BOM) and the associated Vault Professional item BOM.
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Lesson 1: Bills of Materials

Overview

This lesson describes how to manage and use bills of materials (BOMs).

As an essential element in the design or manufacture of products, a BOM, in its simplest form, can be a
list of components and the quantity of each required. It may, however, describe much more. BOMs
may indicate which parts are manufactured and which are purchased, the materials, part numbers,
and stock numbers of each part, and how the parts are structured and assembled.

Use the Bill of Materials tab in the Edit item Record dialog box or in the Preview pane to work with the
items’ BOM.

Structare:

[Tos Multi-Level

Number Categery Name (Historical} ! Title {tem,CO) Revision : State

[al

Each Assembly ICU Valve Main Assembly Released
100002 Each Assembly Yalve Assembly
[ 100002 Each  Part O Ring
100008 tach Part Yalve Spring
- 100016 Each Part Valve
-[B8) 100012 Milliliter Purchased ICU G-Ring lubricant
100004 Each  Part Right Button
100005 Each Part End Cap
Each Part Housing
Each Part Left Button
100015 Each Bocument ICU Valve Rendering - Internals
: 100016 Each Bocument ICU Valve Rendering
100613 Each General Valve Packaging Assembly
100014 Each Bocument ICY Valve Instructions

Work In Progress

[a]

Released
Released
Released

Released

Released
Released
Released
Released

Released

LRI NS

Releazed

Released

5]

In Review

Objectives

After completing this lesson, you will be able to:

View part BOMs.

Edit BOMs to add, delete, and reorder items, and change item quantities.
Compare BOM revisions or BOMs between different items.

Format, print, and export BOMs.
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About BOMs

You can manage and track components of an assembly by using a BOM that lists all its parts and
subassemblies. When you link purchased items to an assembly, the items become part of the BOM list
as well. Although you typically associate a BOM with an assembly, all items have a bill of materials. You
can view the BOM for any item by clicking the Bill of Materials tab.

Part and Assembly BOMs

A part BOM contains information related to a single item. The item can represent an Autodesk
Inventor part, a purchased part, or another item added to the Item Master. If the item is linked to
other items as part of a larger group, you may not be able to edit some of its properties, such as the
quantity. You can add rows of other items to a part BOM. For example, you can include an existing
document item that provides process or materials information on the part.

Unlike a part BOM, an assembly BOM contains multiple rows of item data that are linked directly or
indirectly to the assembly item. Because these linked items are required for an assembly, some
industries refer to this list as a recipe or formula. An assembly BOM does not require an actual
modeled assembly. You can create a new item for non-modeled assemblies and add rows of other
items to this new item’s BOM.

Examples of Part BOMs

The following illustration shows a BOM for an ICUSPRING part. Standard modeled parts are usually
measured in units of one (each). Notice that the quantity field for this item is edited in its parent BOM.

Structure:

Quantity  Units Category Name (Historical} : Title (ftem,CO) Revision - State

The following illustration shows a BOM listing for a non-modeled part (lubricant). Its unit of
measurement is set to milliliter.

Structure:

Quantity -~ : Units Revision ' State

Category Name (Histerical) | Title (ftem,CQ)

92




Examples of Assembly BOMs

The following illustration shows the BOM for an ICU valve main assembly, including parts,
subassemblies, and non-modeled items such as paint and lubricant.

Notice that the row numbers start at 1 (one) for each level of the structured BOM and increment until

all items in that level are listed.

Numb 7.Q
»
0
B8 100005 2 1 Each Part End Cap A Refeased
100008 3 1 Each Part Left Button B WorkIn P
{ -8 100017 1 15 © Willifiter Purchased ICU Button Paint - Work In
&8 100004 4 1 Esch Part Right Button B WorkIn |
V 1000617 1 15 Milfiﬁtef Purchased ICU Butten Paint - Work In Pr
Sil 108002 5 2 Each Assembly Valve Assembly C Work In Pro
©LEgcow t 1 Each Part Yalve 8 Relessed
100003 2 3 _Each Part -0 Ring A Released
106006 3 1 Each Part Valve Spring A Reteased
100012 4 30 Idilliliter Purchased ICU O-Ring lubricant & Refeased
& 1 Fach Document ICU Valve Rendering B Released
3 100015 7 I Each Becument ICU Valve Rendering - Intenals B Beleazed

The following illustration shows the BOM for an ICU valve left button. Notice that another item (button
paint) is linked to the button part, making it an assembly.

Structures

Mumber Row

Quentity . Units Category Mame {Hist.., : Titfe (frem CO) Revision | State

Millititer Purchased ICU Button Paint Werkin

100017

Viewing a Bill of Materials
You can change your view of an item’s Bill of Materials based on item revision, date, or BOM structure.
By Revision

Select the desired revision. Depending on the item and its state, you may also
select one of the following from the list:

Fesision:

= Latest — The current BOM, which may be in any state and the items in the
BOM may be in any state. -

= Effective — The current effective BOM, which is the latest released BOM [Effective
with all items in a released state. Lo T—

=  Past effective — Past effective BOMs that have been superseded. Obsolete o
items display past effective revisions.
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By Date

Select the desired date and the BOM in effect at that date will be displayed.

Select a date from the calendar to display the item’s BOM in effect on that
date.

By BOM Structure

You can also select from three types of BOM structures:

»  Multilevel — A tree structure of all child items in the current BOM. This is
the most useful of the three BOM structures.

=  First Level — This displays only the first-level child items of the current
item.

* Parts Only — The BOM is flattened to a single level. No subassembly
items are displayed.

Editing a BOM

Date: < Structure:

Today (] P Multi-Level
Monday, April 19, 2010
‘. April, 2010

Sun Mon Tue Wed Ths Fri

% % o 1

305 5 7 8
o121 i
wid e o2 2
5 2% 27 2% 2

Wy e
wHEH O eN
-
=

Structure:

E'f-'u— Multi-Level

Ta First-Level

You can view an item’s BOM on the BOM tab in the Item Master. You must open the item Editor to

make changes to the BOM. The item must be in a Work in Progress state.

To edit an item, double-click it in the [tem Master. The Edit Item dialog box is displayed.

e

Number f L Lifecycle Stater Work In Progress

Category: 2 : Revision: . 1B

Title: {CU Yalve Main Assembly Last Updated By: ' usera

Description:

Last Updated: 471872010 10:12 aM
Units: ’

HAssociated files:

Properties:

:E’] File Name i Version Name
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Click the Bill of Materials tab to access the BOM data.

Structisre;

[Ths Multi-Level

¢ L 1000..
& [ 100002

;L 000,

.5 1000...

¢ 0.,

R S A
i th

Quantity : Units

Each
fach
Each
ilfitiger
Each
Milfiliter
Each
Each
Each
Each
Milliliter

Categc»ry Mame (Historicaly »Title (Item,CQ}_,

Purchased
Bart
Purchased
Assembly
Part

Part

Part

Puschased

Housing

End Cap

Left Button

1CU Butten Paint
Right Button
1CU Buiten Paint
Valve Assembly
Valve

O Ring

Valve Spring

ICU O-Ring lubricant

Released
Released
WorkIn Progress
Work In Progress
Work Tn Progress
Work [n Progress
Work In Progress
Released
Released
Released
Released

Notice that the BOM Item toolbar is active. Using this toolbar, you can add, delete, and renumber item

rows and compare BOM revisions.

Latest

Procedure: Adding Item Rows to an ltem BOM

The following steps describe how to add item rows to an item BOM. Note that you can only add

existing items to the BOM.

1. Inthe ltem Master window, click the Bill of Materials tab. Right-click the top row of the BOM.

2. Click Edit Bill of Material > Add New Row.

Structure:

T Multi-Level

Mumber

(35 100003
1000

ssemiby
art

P ik, Add Mew Row

Change Iem Number,.,
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Enter the item number or search for the item in the list.

Click

Look For: Look I
v Itern Master

Search fon
Search Text:

Packaging i

MNumber.

Title Jtem,CO} Revision

1 Objects {1 selected)

OK. The new item row appears in the BOM list.

| Mumber Row 7 Quantity. : Units: . Category Wame (Historical] | Title (tem,CO} Revision - | State

1 - Each Preduct Valve Assembly Packaged... C Work In Progress
1 1 Each Assembly ICU Valve Main Assembly D WorkIn Progress

1 1 Each Part Housing A Released

2 1 Each Part End Cap A Released
3 1 Each Part Left Button B Work In Progress
1 15 Milliliter . Purchased ICU Button Paint - Work In Progress
1000044 1 Each Part Right Button B Work In Progress
1.1 i5 Wiilliliter - Purchased ICU Butten Paint - WorkIn Progress
5 2 Each Assembly Valve Assembly C Work In Progress

i 1 Each Part Valve B Released

2 3 Each  Part GRing iy Refeased

3 1 Each Part Yalse Spring a Released

4 30 Milliliter  Purchased ICY G-Ring lubricant A Released

3 1 Each Document ICU ¥alve Rendering B Released

1000157 1 Each Decument ICU Yalve Rendering - Int.. B Released

100014 2 i Each Document ICY Valve Instructions B In Review

oy

You can edit a BOM only if it is displayed in the Multi-level view (BOM tree view) that.
shows the relationships between the items. You cannot edit a BOM if it is displayed in the
First Level or Parts Only list views (the flat BOM view). Any row that you add to the BOM
becomes a first- level child item of the top-level item. To add items to a subassembly, you
edit that item and add the item rows there.
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Procedure: Deleting Item Rows from an ltem BOM

The following steps describe how to delete item rows from an item BOM. When you delete an item
from a BOM it is not removed from the Item Master, but rather it is removed from the BOM for the
top-level item.
1. Inthe Item Master, click the Bill of Materials tab. Right-click the item row to be
removed.

2. Click Edit Bill of Material > Remove Row. The item row is removed.

CAUTION: You receive no warning that the row will be removed. Make sure you are
removing the correct row. You can remove only item rows that are first level children of the
top-level item. To remove items in subassemblies, you must edit the subassembly item.

Procedure: Reordering Item Rows in an item BOM

The following steps describe how to reorder item rows in an item BOM:
1. Inthe ltem Master, click the Bill of Materials tab.

2. Click the any column header to sort first-level child items by the values in the column. Click the
same header to invert the sort order.

3. You can also reorder individual rows if there are multiple items with the same value in the column
controlling the sort order. To reorder one or more rows, you select and then drag the rows to their

new position.
MNurnber Row 7 MNumber Fow Mumber : Row
{5 100002 1 =g 00002 00 1 {55 100002 1
LB 100010 1 = [ 1pgot0 1 o
B8 100003 2 1%03 2 B 100010 1
[BF] 100006 3 - [Eg 100006 3 [ 100003 2
IO S ; g 100006 3

4. Onthe BOM ltem toolbar, click Save Row Order.

100002

Save Row Order
| Restore Saved Ordj;‘r"'

4 3
ertals 3

icture
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5. To restore the previous saved BOM order, select Restore Saved Order from the Edit toolbar.

Save Row Order
E}E Restore Saved Order

You can reorder only item rows that are first-level child items of the top-level item. You can
also reorder the BOM based on the values in a specific column. Click a BOM column header
to sort the rows based on the values in that column. Click the same header to reverse the
sort order

Procedure: Changing BOM Item Quantities

The proper quantities of modeled items are calculated by default. Vault Professional works with the
Inventor BOM structure, uses the same units of measure, and automatically adjusts for phantom,
reference, or inseparable assemblies.

You can change any quantity in the BOM, including calculated numbers. The following steps describe
how to change BOM item quantities.

1. Inthe ltem Master, click the Bill of Materials tab. Click the quantity of any item
row directly related to the top row.

2. Enter a new quantity. This entry is referred to as a static quantity.
3. Toreturn to a calculated quantity, select the item row. Right-click the quantity.
4. Click Calculated Quantity.

Number TRew Quantity
i) 100002 1 -
i

Nomber Row Quantity : Units L C@};gory}

| 100002 Y : Each Assernbly
] 1 Each Part

I
- 38 100012

5. Click Actions menu > Update. In the Update Item wizard, accept the defaults on each page of the
wizard.

Tl Al kems

Change em Murmisas

6. Close the Update ltem wizard.

You can only change quantities for first-level child items
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Comparing BOMs

Each revision of an item has a unique bill of materials. All items revised through a change order have
an associated BOM, which may differ from the BOM for a previous item revision. You can compare
BOM revisions by clicking the Compare BOM button on the toolbar.

You can compare BOM revisions to gain a good perspective on the overall assembly change and status,
and to help avoid costly, unnecessary mistakes.

s 22

. 100005 i i Revision C

| Bill of Materials

Date: Structure:

[Today = {EotMulti-Level

v Quantity. " Units : Categc‘ry Mama {Historical) - Title (ftem,CO} Revisien ‘ Statg
Revisien: - Each Assembly ICU Yalve Main Assembly  E Released

Bocnand
Each Part Housing Released
Each Part End Cap ' 3 Released
Each Part Left Butten Released
Millditer  Purchased U Butien Paint . Released
Each Part Right Butten Released
Willifiter  Purchesed ICH Bugton Paint ~
Each Assembly Mair Vabve Assembly <
Each  Part ORing S
Each Part alve B Released
A
A

Released
Released

Released

Released

-8 1000..,
- B8 1000...

Each -Part ) Valve Spring
Milliliter  Purchased ICU O-Ring lubricant

W N e W B W R B

Reteased

Procedure: Comparing BOM revisions

The following steps describe how to compare BOM revisions.

1. Inthe ltem Master, open an item for viewing. In the Item dialog box, click the
Bill of Materials tab.

2. Use the revision slider to select a base BOM from different revisions, or use the
Date list to select a revision that is active on a specific date.

3. Onthe BOM ltem toolbar, select Revision to compare it to the one currently
displayed. You can also enter an item number and compare the BOMs of two
different items.

4, On the BOM Item toolbar, click Compare.

Revision C
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B SRS ” ah M
J DB s 6 £as IGhValve Randasi g sigase
. : BF 100007 1 3 Each Part Heusing A Released
/ 100005 2 I Each Part End Cap A Released
\ 3 1 Eoeh s LBk & Beleasad
> 1 i5 Miliditer : Purchased ICY Button Paint - Released
: ¥ T Eavh PNt Right-Butten €
""" 1 15 Killifiter . Purchased ICU Button Paint Relessed
5 2 Each Assembly Pain Valve Assembly C Released
FE .1 3 Each Part G Ring & Released
B3 w2 1 Each Part Yalve B Released
e, 1000... 3 3 Each Part Valve Spring A Relesed
{ ) LED1000..4 30 Millfiter * Parchased ICU O-Ring lubricant & Released
D

5. Use the navigation controls at the bottom of the Bill of Materials tab to display

the changes one at a time. The differences between the two BOMs are
highlighted in the preview pane.

Structure:

Key Points

Items in red do not exist in the displayed BOM.

Items in blue exist in the displayed BOM, but not in the comparison BOM.
ltems in blue and bold exist in both BOMs, but show differences.

BOM Output

You can view item BOMs in either tree or list view. Both views can be printed or exported to a
Microsoft Excel spreadsheet, a tab-delimited text file, or an HTML page.

You can customize the setup for printing BOMs from the File menu or the toolbar in the Edit Item

1 Each Asserbly Releaged
1 Each Part Housing Released
2 Each Part End Cap Relessed
3 Each Part Left Button Relzased
1 Willdizer . Purchased KU Butten Paint Released
4 Each Part Right Buteon Released
P {8 100017 1 Millitizer  Purchased ICU Bution Paint Released
2! B3 100002 5 Each Assersbly Main Valve Assembly Released
@ 100003 1 Each  Pert O fing Relessed
1000 2 £ach Part Valve Released
L, 3 Each  Part Valve Spring Released
o 100012 4 RMalliiter - Purchased [CL O-Ring lubricant Released
o
S o :
2/ i Zoom Factor 100%
FARNY
Lo/
]
R

Record dialog box.

The following illustration shows the use of Print Preview

=

—

1CU Valve Main Assembly

to display the form to be printed.




Procedure: Formatting and Printing BOMs

The following steps outline how to prepare and print a bill of materials.
1. Inthe Open or Edit Item dialog box or in the Preview pane, click the Bill of

Date: Structure:

Today iﬂ FeiMulti-Level L

Numb

i
i
i
i
i

Revisiom:

Materials tab.
2. Select the BOM revision for the selected item.
3. Select the BOM format from the Structure list.

Bill of Materials |

Date; Structures

[P Mttt 7]

[Today

Number Row Quardi
Revision:

Structure:

iE Parts Only

[ Fo Multi-Level
First-Lewel




5 oy

4. Click File menu > Print Preview

6. In the Printable Component Editor, select format and behavior settings to customize the print out.

Click OK.

&P Footer

% GroupFooter
B HorzLines
[ Vertlines
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7. Inthe Print Preview dialog box, on the toolbar, click Header and Footer or Page Setup to further

customize the report.

Header And Foo!

8. Click Print or Print Direct.

5 Headen

Wicrosoft Sans Serif, 8.25pt

{Page = [ste Brinted] {User Name]
@ Focter,
{Page # of Pzges ¥ {Time Printed]
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Procedure: Exporting BOMs

The following steps outline how to export a BOM in a variety of file formats.

1. Inthe [tem Master window, right-click an item. Click Open.

| 100010

I 100011 Open...

| 100012 Update... b

! 100013 Restore...

] 100014 =
; Change Fem Mumber.,, 3

2. Inthe Edit Item Record dialog box; click the Bill of Materials tab.

3. Select the BOM format from the Structure list. In this example print the Parts Omlu list of the
BOM.

Structures

Tas Multi-Level
oz Multi-Level
Fo First-Level

' i
l B8 100005 2

4. Click File menu > Export, or click the Export tool on the Standard toolbar.
5. Select the file type for the export. Enter a file name. Click Save to export the BOM.

Libraries > Documents 'y

Qrganize . Newfalder

¥ Favorites = Documents library
B Deskiop Includes 2 locations

2 Downloads Name - Date modified Type : Size

&rrange by ‘Foider hd

%1 Recent Places o
i Acade 2011 {2200 1828 PR - File felder

Fite foler
Documents - Fite folder
. ¥

off Music g Ty File folder
& Pictures o 4 : File folder

B videos ¢ 187 File folder
: D File: foldee

- Hor‘nke’groupp

 File name: . BOM Listing
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Exercise 1: Work with an Assembly BOM

In this exercise, you manage and edit a product’s BOM. You
learn to:

Change BOM quantities.

Add new items and link items in the BOM.
Reorder BOM rows.

View BOMs.

Redesign the Valve Assembly Packaged Product.
Compare and export BOMs.

-} Quantity  Units -/ Title | Revisio:

Each Yalve Assembly Pac... B
1 Each ICU Valve Main Ass... -

1 Each  ICULBUTN.ipt &

‘Each  ICUENDCP.ipt

100025 1 Each  ICURBUTM.ipt A
e B Mty RokhBuban-Paink -

100029 2 Each . ICUYALYEASSY.iam A

The completed exercise
Change BOM Quantities

1. Start Autodesk Vault Professional. Log in using the
following information:

User Name — usera
Password — vault
»  Database — AOTCVault

2. Inthe ltem Master, double-click the ICUVALVEASSY.iam
item to edit it. Click the Bill of Materials tab.

3. On the Bill of Materials tab, right-click one of the
column headers. Select Customize View.

Click Reset to reset the fields to their default state.
5. Inthe Customize View dialog box, click Fields.

6. Do the following:

= For Select Available Fields From, select item
Fields.
Under Available Fields, select Units.
Click Add.
If Item Icon is not shown in the Show These
Fields in This Order list, add it to the list.
s Under Show These Fields in This Order, select
Units.
Click Move Up until it appears below Quantity.
=  Move ltem lcon below Number.
= (Click OK.

Show these fields in this orden

Quantity

Units

Title Jtem,CC)
Rexvision

State

In the Customize View dialog box, click Close.

On the Bill of Materials tab, select the ICU O-Ring
Lubricant item. Do the following:

For Quantity, enter 30.
= Press ENTER.
= (Click Save and Close.

Mutnber [E DetailID - Quantity Units T
{88 100002 - " Each 19
- [E5 100010 ‘[EH) 1 Each i
i 100003 3 Each I
i-[E5 100006 (53 1o ke it

9. Inthe Item Master, double-click the
10. ICULBUTN.ipt item to edit it.

11. On the Bill of Materials tab, for the quantity of the
ICU button paint, enter 20. Click Save and Close.

12. Repeat the previous two steps for the
ICURBUTN.ipt item.
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Add New Items and Link ltems in the BOM

Under All Folders, right-click Item Master.
Click New ltem.

Enter the following information for the new item:

*  For Category, select Product.

= For Item Title, enter Valve Assembly Packaged
Product.

»  Press ENTER.

To complete the information for the new item, do the
following:

For Units, verify that Each is selected.

For value, enter ICUV1.
Click Save and Close.

Under All Folders, right-click Item Master.
Click New item.
Enter the following information for the new item:

For Category, select Purchased.

For Item Title, enter Valve Packaging.
Press ENTER.

For Item Description, enter Product Box.
Press ENTER.

. To complete the information for the new item, do the

following: ‘

= For Units, verify that Each is selected.

= Under Properties, select the Item Project row.
= For value, enter ICUV1.

= (Click Save and Close.

Lifecycle State:

Category: & ; Revision: :

Title: KRN Last Upated B

- Des;(iption: Last;Up@aiedz
Unitsy 5
Associated files Properties:
i [FileNeme . Version |1 Mame ) Vo
There are o rers 10 shos i thisview, || 1| Project g
i

9. Under All Folders, right-click Item Master.
10. Click New Item.

Under Item Properties, select the ltem Project row.

11.

12.

13.

14,

15,

16.

Lok For: LookI:

Enter the following information for the new item:

For Category, select Document.

For Item Title, enter Valve Product
Specifications and Instructions Sheet.
Press ENTER.

For Item Description, enter Product Spec.
Press ENTER.

To complete the information for the new item, do
the following:

For Units, verify that Each is selected.
Under Properties, select the Item Project row.
For value, enter ICUV1.

" Click Save and Close.

In the Iltem Master, double-click the Valve
Assembly Packaged Product item to edit it. Click
the Bill of Materials tab.

Right-click the Valve Assembly Package Product.
Click Edit Bill of Material > Add New Row.

In the Find dialog box, click the Basic tab if it is not
selected already. Do the following:

For Search Text, enter valve.
= Click Find Now.

Select the following items in the Found list:

ICU Valve Main Assembly.iam.

Valve Product Specification and Instructions
Sheet.

Valve Packaging.

Click OK.

- ( Irem Master

Serch far:

Search Text:

‘valve -

5 Objects @selscted)
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17. In the Bill of Materials, select the ICU Valve Main
Assembly row. Press * on the numeric keypad to
expand the view to its children. Your BOM should look
like the following illustration.

L Number Detail (D Quantity Units Title (ften,CO)
|
-8 100014 1 Each Valve Preduct Speci
[ 100013 1 Each Valve Packaging
i[5 100009 1 Each ICU Valve Main Assemififyciszs
1 Each TCUHOUSG.ipt
~{BE) 100005 1 Each ICUENDCP.ipt
{8 100008 i Each ICULBUTN.pt
. LEg 00015 4 Milifiter  |ICU Button Paint
£5) 100003 1 Each ICURBUTM.ipt
5] 100015 2 Mililiter  ICU Button Paint
& 8 100002 2 Each ICUVALVEASSY.iam
-G 100010 1 Each ICUVALVE.ipt
-5 100003 3 Each ICUCRING.t
; ‘B 1 Each ICUSPRNG.ipt
m 20 Millfter 10U O-Ring Lubricant

Reorder BOM Rows

1. Review the rows in the BOM. They are not in the
desired order. Company policy requires the packaging
to be the last item in the BOM.

2. Click the (-) sign to close the ICU Valve Main
Assembly.iam tree view.

3. Drag the Valve Packaging row to the bottom of the list.

4. Drag the Valve Product Specification Sheet down to the
last row.

B8 Detail ID

Quantity Units Title (ltem,CG)
- Each Yalve Assembly Pac

2lve Main Rasern;

Valve Packaging

E t:.‘} | 10[%1;

t

5. On the BOM Item toolbar, click Save Row Order.

The BOM is now ordered as desired.

6. Click Save and Close. The Valve Assembly Package is
complete. :

In the Item Master, right-click Valve Assembly
Packaged Product. Select Change State.

In the Select Lifecycle dialog box, select Released.
Click OK.

Notice that all the children (the components) of
the Valve Assembly Package were also released. o

View BOMs (N

1. Inthe Item Master, select the Valve Assembly

Packaged Product if it is not selected already.

In the item detail pane, click the Bill of Materials
tab. Review the BOM rows. Notice that the
guantity of the O-ring lubricant is 30 milliliters in
the ICUVALVEASSY item. (There are two

ICUVALVEASSY items.)
Number [B8 Quentity - Units Title (ftem,CQ) o
© g 100004 1 Each ICURBUTN.ipt {
; [EEE 100015 [B8} 20 Milliliter ICU Button Paint
: -‘@ 100002 2 Each TCUVALVEASSY iam
-[B5 100010 [F1 Each ICUVALVE.ipt
100003 [E53 Each ICUCRING.ipt
3”@ 100006 1 Each ICUSPRIMG.ipt
© g F Milliter  1CU O-Ring Lubricant
100013 i Each Yalve Packaging
1000%4 1 Each Valve Product Specifications

For Structure, select Parts Only. Notice the
quantity of the ICU O-ring lubricant (60 milliliters).
This value is the correct total because there are
two ICUVALVEASSY items with 30 milliliters of
lubricant each.

Structure:

ICUSPRNG.ipt
ICUHOUSG.ipt
ICUVALVE.pt

ICU O-Ring Lubricant
Valve Packaging

Valve Product Specifications and Inst
ICU Button Paint

é\lmb—uﬁ\l\—l'—‘l\))—l
3 < E

For Structure, select First Level. The three items
you linked to the Valve Assembly Packaged
Product are displayed.

Structure;

Quantity Titte (ltem, (O}

| ging e

é\}a!ve Product Specifications and Instruction: N

L

For Structure, select Multi-Level to return to the a0

structured BOM list.
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- Redesign the Valve Assembly Package

1. Inthe Item Master, right-click the ICULBUTN.ipt item.
Click Change State.

) 2. Inthe Select Lifecycle dialog box, select Work in
Progress. Click OK.

3. Repeat steps 1 and 2 to change the lifecycle state to
. Work in Progress for the ICURBUTN.ipt,

ICUVALVEASSY.iam, and Valve Assembly Packaged
Product items.

“ 4. Double-click ICURBUTN.ipt item to edit it. On the Bill of
Materials tab, do the following:

() =  Select the ICU Button Paint row.
. = Right-click the selected row.
: =  Click Edit Bill of Material > Remove Row.
= (Click Save and Close.
Mumber Guantity. Units Title (ftem, COY Revision
Vo g 10 B - Each ICURBUTNipt A
/'ﬂ”/ ‘)‘

Edit Bilt of Material v |5 Add NewRow

. (Remove Row
“ Change Quantity

Change tem Number...

arge Revidion.,

{_J 5. Repeat the previous step to remove the ICU Button
Paint row from the ICULBUTN.ipt item.

6. Inthe Item Master, double-click the Valve Assembly
Packaged Product item to edit it. Click the Bill of
Materials tab.

~ 7. Select and right-click the top row. Click Edit Bill of
’ Material > Add New Row.

8. In the Find dialog box, do the following:

Click the Basic tab if it is not selected already.

= Under Search Text, enter ICU*,
Click Find Now. A number of items are returned in
the search results.
= ®  Select the ICUORING.ipt row.
*  Click OK.

Besic

Seasch for:
Search Text:
tcur ]

Titke ftem, CO} Reiision
{ICUSPRNG.ipt -
{ICUENDCP

9.

The ICUORING.ipt item is added to the BOM. Do
the following:

Change its quantity to 3.
=  (Click Save and Close.

KMumber Quantity i Units T}it!e (ltem,COY
=g 100012 - Each Valve Assenbly Packaged Prod...

100009 H Fach ICU Valve Main Assembly.iam
100013 H Each Valve Packaging
: ., 100014 i Each Valve Product Specifications z

10. In the ltem Master, change the lifecycle state of

the Valve Assembly Packaged Product item to
Released. If prompted to confirm the state change
for children, click Yes.

Compare BOMs between Revisions

11.

12.

13.

14.

In the Item Master, right-click the Valve Assembly
Packaged Product item and select Open. Click the
Bill of Materials tab.

In the BOM Item toolbar, do the following:

= Select Revision -.
=  Click Compare.

; Latest
| Effective
Revisicn A

Review the changes. All items removed are red and
items added are blue. items in blue and bold differ
between the two revisions.

ICU Valve Main Assembl., - Refeased

Each ICUHQUSG.ipt - Refeased

ICUENDCE.ipt - Released

[CULBUTN.ipt A Refeased

w | Hetios R - Hatansiad

Each FCURBUTN, ipf A Released

b G Hatbon Raing R Hebaasad

Each [CUVALVEASSY lam A Refeased

Each ICUVALVEpt - Refeased

Ezch [CUQRING.ipt - Released

Each ICUSPRNG.ipt - Released

[ 100011 B Milfiliter  [CU O-Ring Lubricant - ReJeased

3 wont3 i Each Valee Packaging - Refeased
- B 100014 1 Each ‘falve Product Specificati., - Released
0 100002 B fach  ICUORING.pt - Reteased

On the BOM Iitem toolbar, click Compare to turn
off the BOM comparison.
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15. In the dialog box, click File menu > Export.

Save.

W Favorites
8% Desktop.
4 Downloads

ecent Places

a % Hcmvegroup )

Libraries

Fite name: | ICU Product BOM - Rev §] -
Save astype: | ‘

4% Hide Folders

17. Open Microsoft Excel. Open ICU Product BOM - Rev
B.XLS.

18. If the Import Text Wizard dialog box is displayed, do the
following:

Click Next.
Click Next.
Click Finish.

Sy Boide SRl . LB T e
L Number (Hemlcon Quantity Units  Title {item,CO} . . ‘Revision State
100012 NORMAL - Valve Assermbly Packaged Product § A Released
100009 NORMAL ICU Valve Main Assembly.iam - Released
100007 NORMAL HCUHOUSG.ipt - Released
100005 NORMAL ICUENDCR.ipt - Released
100008 NORMAL ICULBUTN. int A Released
100004{NORMAL ICURBUTN, ipt A Reteased
100002 NORMAL ICUVALVEASSY fan A Rejeased
108010 NORMAL ICUVALVE.ipt N - Reteased
100003 NORMAL ICUDRING.ipt it Released
100606 NORMAL 1:£ach ICUSPRNG.Ipt - Released
100011 NORMAL 30 MMAllier 1CY O-Ring Lubricant e Released
100013 NORMAL iEach Valve Packaging -
100014 NORMAL 1 Each Valve Product Specifications and instructions Sheet - iReleased !
100003 NORMAL 3:Each JCUORING.Iot i o § . - Re!eagedj

19. Close Vault Professional and Excel.
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Lesson 2: Integration with Autodesk Inventor

Overview

This lesson describes how to use Autodesk Vault Professional with other applications. The primary
focus is the relationship between Autodesk Inventor and Vault Professional BOMs. The lesson also
covers working with Vault Professional and Autodesk Vault, AutoCAD®, AutoCAD® Mechanical, and
AutoCAD® Electrical.

Objectives

After completing this lesson, you will be able to:

Describe the integration of inventor, Vault, and Vault Professional.

Describe the relationship between an Inventor bill of materials (BOM) and the associated Vault
Professional item BOM.

Work with Autodesk Inventor virtual components.

Customize content center library components to use with Vault Professional.

Describe how Vault and Vault Professional work with drawing files.
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About Inventor, Vault, and Vault Professional Integration

Autodesk Vault Professional works with documents and data stored in a vault that is created and
managed by Autodesk Vault. Both products are built on a web services foundation, Users (particularly
creators and administrators) must be familiar with the relationship between files and properties stored
in the vault and items in Vault Professional. Vault Professional users who create Inventor CAD models
use Vault to manage works in progress. Users can then use Vault Professional to assign item numbers
to vaulted parts and assemblies. You can edit assembly BOMs in both Autodesk Inventor and Vault
Professional, and coordinate property information between Autodesk Inventor, Autodesk Vault, and
Autodesk Vault Professional.

e .

g? E‘,?- v ! "g Assembly View v @&
% HitchAssembly.iam

& @ Representations

- P origin

jEaad @ Mounting Weldment; 1

e ﬁ Drawbar:1

g @ ANSIFASME B18.8. 1 PIN. CLEVIS. 3/4x
B () Axe Clip: 1

@ ()Bali1

#- & fegular Helica! Spring Lock Washer {Inch
1 & Hex Thick Nut - Inch 3/4 - 10:1

b~ £9 FrameRail: 1

i3 % Frame_Fastener:1

b %Framefasbener:z

ol % Frame_Fastener:3

&5~ (B Frame_Fastener:4

B3 0 B Mumber ¢  Revision

Application Overviews

5 State Title (ftem,CO} Description (ftem,CO} Category Na..

5 100018 - WorkIn Progress ANSTAISC 2:2x 174 - 1200mm Cross Bar Cipa
100018 - Work In Pregress Hitch: Ball Hitch Bail Part
100020 - ‘Work In Progress end_plate_RH.ipt End Plate - RH Part
100021 - Work In Progress Draws Bar Draw bar Part
100022 Weork In Progress DrawBartMountBottomPlateipt Draw Bar Bottom Plate Part
100023 VWork In Progress ANSASME BIBS.L PIN, CLEVIS. 374 x19% | Clevis Pin Purchased
100024 - Work In Progress Axte Clipipt Axle Clip Purchased
100025 - WorkIn Progress 150 8678 M12x25 Cup Head Square Meck B... ; Purchased
100026 - Work In Pregress Hex Thick Nut - Inch 34 - 10 Hex Thick Nut Purchased
100027 - WorkIn Progress WMounting Weldment.iam Hitch Weldment Assembly
100028 - Work In Progress Regular Helical Spring Lock Washer (Inchj ... | Helical Spring Lock Washer | Purchased
100029 - Work In Progress Hitch Assembly Hitch: assembly Assembly
100030 Work In Progress 15306312 Spring Washer Purchased

Autodesk Inventor is a 3D, parametric CAD application. You can combine individual part models in a
hierarchy of assemblies to create a complete digital design. You supply values for intrinsic document
properties and can add custom properties to any part or assembly.

Use Autodesk Vault to provide work-in-progress version control for Inventor models and other
documents. A vault stores versions of documents, file relationships between documents, and property
data associated with each version. You check files out of the vault to modify them in Inventor and
check in the new versions to share with your design team.

When you use Autodesk Vault Professional to assign items to these files, users outside the engineering
department can access property and bill of materials data from the files stored in a vault.
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Working with Autodesk Vault Professional and Autodesk Vault

Autodesk Vault Professional is an external application that adds manufacturing and release data to
documents in the vault. You create an Autodesk Vault Professional item when you assign an item
number to a file stored in the vault. Initial property values for the item are extracted from the property
information stored in the vault. After it is created, the item is connected to the file in the vault, but
property values are largely independent. You can add Autodesk Vault Professional items without
associating them to a vault file.

You need to understand how actions in Autodesk Vault Professional affect the associated files in
Autodesk Vault because a number of tasks can be completed only when files are checked in to the
vault, and lifecycle state changes can affect the state of the associated files in Autodesk Vault.

Autodesk Vault Professional and A\utodesk Vault

' 1} [%%} Number ¢ Revision

03 : v
100004 . Released ICURBUTN,ipt
100005 - Released ICUENDCP.ipt
100006 - Released ICUSPRNG.ipt

10

A

® 0 B[ File Name F. . Revision State

i
(B

)

ICU Valve Main Assembly.iam

oy ]
B3 E5 e

i =biEh| R EBIEBIER R O

All of the associated files of a released item in Vault Professional are locked in the vault.
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Working with Autodesk Vault Professional and Autodesk Inventor

When you create an item from a part or assembly stored in a vault, Autodesk Vault Professional
extracts property information from Autodesk Vault. The property values are typically assigned in
Autodesk Inventor, but you can edit values for existing properties in Autodesk Vault. ltem properties
can be mapped back to the properties in the associated Autodesk Inventor part or assembly
document. If you understand the relationship between properties in all three applications, you can
effectively integrate Autodesk Vault Professional into an Autodesk Inventor design environment.

An Autodesk Inventor assembly BOM maps information to the BOM in the associated item in Autodesk
Vault Professional. Your understanding of this process helps to ensure its accuracy.

S T~

tructured [BE partsonly O

TUnit QTY LGQTY - Stock Number

223

WO s O b W R e

©
=3

1

ANSTASME B8,

Cupr b
Spring W

Bill of Materials

Date: Structures
{Today | ;} 1Pag Multi-Level
Revision:
-8 100023 1 Each ANSI/ASME B188.1 PIN. CLEVIS. 3/4 x 191 Work In Progress
| ) 100021 1 Each  DrawBar Work In Pragress
1 Each Mounting Weldmeatiam Work In Progress
47.244094488189  Inch ANS]AISC 2x2x174 - 1200mm Work In Pregress
1 Each end_plate RH.ipt Werk In Progress
1 Each end_plate 1H.ipt Work In Progress
B 1 Esch  DrawBarMountTopPlate.pt Work In Progress
i 100022 1 Each DrawBarhiountBattomPlate.ipt Work In Progress
] 100025 4 Each  ISOE78 MI2x25 Work In Progress
@ 100030 4 Each 15306312 WerkIn Progress
1B 100031 4 Each  I1S7790 M12 WotkIn Progress
- (B8 100018 1 Each  Hitch Ball WorkIn Progress
. ;- 100028 1 Each Regutar Helical Spring Lock Washer {inch} .. - Work In Progress
‘ -E 100026 1 Each Hex Thick Nut - Inch 374 - 16 Work In Progress
(g5 10002¢ 1 Bach  fude Clipipt Wark In Progress

Autodesk Vault Professional BOM
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Example of Application Integration

o _ The following example shows the integration of the three applications. This workflow represents a
o change order on a Released item. The associated file in the vault is locked when the item is in a

\ Released state.

, 1. A \Vault Professional user creates a new change order for a released part or

v/ assembly item. On submittal of the change order, the Change Administrator or
) Responsible Engineer changes the item status changes to Work in Progress
creating a new item revision. This action unlocks the part or assembly the vault.

State Title (Ttem, CO)
Work In Pr d_plate RH.ipt

DrawBarht

Cgen... : ANSI/ASME B18.8.1 PIN. L
Update.., ‘

B_estcre...

Change Ttem Nutnber...
Change Revision... :

Change State

Attachments...

New Change Order..,
. 4dd To Change Orders

2. When the Responsible Engineer works on the change order, they can open the change order and
7 examine the items associated with it. The items are on the Records tab. From here, the user can
directly go to the item.

Description

Open.

Add Related...
Go To ltem N
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3. Looking at the item, the user can see which file is associated with that needs work and go directly
to the vault folder containing the file.

Number Revision - | State Title ftem, COY

100022 DrawBarMountBettomPlat
100023 - Work In Progress ANSI/ASME B18.8.1 PIN, CLEYT
100024 Axle Clipipt

Work In Progress

Work In Progress

Attached Files

[ File Name Version @

Qpen

View in Window...
Go To Folder

Revision State

Open

I
DrawBarhdount]) View in WSndowe..

| end_plate LH.ipy Assign Ttem,
end_plate RH.ip| ;q Tolt

115




J
oY 5. The Autodesk Inventor user edits the file and checks them back in to the vault.

=

)
Y Refresh From ¥Wault
Get Revision,,.

- " CheckIn.., Mhs'

{ ) Chgck Out

Undo Check Out...
. Change State..,

Revision - State

100022
100623
100024

I

Restore..,

Change em Number...

Show Change Pevision..

(Y 7. Finally the change order is completed, returning the item to a Released state. The files are again
o locked in the vault.

Title Description Revision State {Historical} Units

i

| Draw Bar Draw bar A § Refeased o Each

When you check out, edit, and check in a component, you must update the associated item
in Autodesk Vault Professional before you can change the lifecycle state of the item. Each
item revision is associated with a specific version of the component in the vault. The change
order cannot be completed unless the items have been updated.
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Inventor BOMs

Information in Inventor assembly BOMs is translated into the BOMs of the associated Vault ’ J
Professional items. )

Y

/

/ et
Uit QTY 1QTY | Stock Number + Destription ; i,

1 ANSTASME RISA.1PIN. iy

B surdhsad

[N T RN

)

Definition of Inventor BOM

Inventor assembly BOMs contain information about their hierarchy of parts, subassemblies, and virtual
components and are usually displayed as structured lists of components, as shown in the following

illustration:
b= Struchured rw Ww;i )
i A
{ Part Number | BOM Structure - | Unit QTY | OTY ' Stock Number | Description VREY |

1 100023 $%1Purchased  Each 1 ANSIJASMEBIS.8,1PIM. CLEVIS, 3/4x 181 Clevis Fin -
2 100021 B Norms! ; 1 Draw bar B
3 100024 84 Purchased 1 Axle Clip -
4 100027 1@, Inseparable 1 Hitch Weldment -
5 &8s purchased 1 § S

5 81 Purgresed 1

7100019 g Hormal no1

8 s purdesed Btk 4

3 B Bach 4

10 B8 Purch Each 4

Parts Only BOM

You can select a Parts Only view that flattens the BOM to a single
assembly hierarchy as shown in the following illustration:

Erasow]
1 Part Number ?BOM Structure E Unit QTY gQTY istock Number : f Description )
100023 %$_§ Purchased Sach 1 ANSI/ASME §13.8. LPIN, CLEVIS. 3/4x L.91 Clevis Pin -
100021 % Mormal gati 1 Draw bar B
100027 [ Inseparable Fach 1 Hitch Weldment -
%_$j Purchigsed  Eadt 2 Cuip Head Sousre Neck Bolt
B8t ourchused  Bach 4 Spring Washer
Bg_$_§ Purchased  Each 4
100019 e Mormal Fach 't -
¥ purchased Bach 1 '
Ui purhased  Bmah 2 e Thich
100024 81 Purchased  Each 1 axeclip -
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BOM Structure

Each part, subassembly, and virtual component in the assembly is assigned a BOM structure that
determines the status of the component in the assembly BOM.

The following table explains the display status of individual parts assigned different BOM structure
types.

Normal Shown as a single Shown as a single  Default BOM structure for most parts

line line Quantity can be affected by parent BOM
structure

Reference Excluded from Excluded from Typically assigned to parts that provide
view view reference for the current design

Phantom Excluded from Excluded from Skeleton model parts are often assigned
view view a Phantom structure

Purchased Shown as asingle Shown as a single  Assigned to components that are not
line line fabricated

Inseparable Not normally Not normally

assigned to parts assigned to parts

The following table outlines the display status of a subassembly and its child components when it is
assigned different BOM structure types.

Normal Shown as a single line Excluded from view Default BOM structure for
most subassemblies

Child components

displayed as
subcomponents in the
assembly BOM
Reference -~ Components and all Excluded from view Typically assigned to parts or
: children excluded from ' assemblies that provide
view ' ‘ reference for the current
design '
Phantom Excluded from view Excluded from view A Phantom assembly that

groups a bolt, nut, and
washers and can reduce
model complexity

Child components
promoted to Phantom
subassembly level

Quantity of Phantom
component affects quantity
of promoted children
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Purchased Shown as a single line

Child components
‘displayed as
stibcomponents {often not
shown inparts list):

Inseparable Shown as a single line

Child components
displayed as
subcomponents (often not
shown in parts list)

Shown as a single
line (treated as a
part)

Child components
excluded from view

Shown as a single
line

(treated as a part)

Purchased child
components
promoted and
shown

Other child
components
excluded from view

Assigned to assemblies that
are not fabricated

Assigned to assemblies that
are not easily disassembled

Weldments and riveted
assemblies are examples of
Inseparable assemblies

A component’s BOM structure also determines how the corresponding item is displayed in a Vault

Professional BOM.

Assigning a BOM Structure

Subassemblies retain their current BOM structure when you place them in a higher-level assembly.

Parts are assigned Normal BOM structure when placed in an assembly.

The following illustration shows how you select the BOM structure in the Create In-Place Component

dialog box.

+Mevs Component Name

I4ew File Location

Template
Drawbar_link lock.ipt Eﬁpdard ipt:

Default BOM Structure

e or plane

’ CHa0TCVaultProWanltworkingFalder \Designs{TrailerHitchl

riual Component

Editing a BOM Structure

You can change the BOM structure of a component from its default setting to Reference by right-

clicking the component in the browser and selecting BOM Structure > Reference. You can restore the

default BOM structure using the same steps.
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The following illustration shows how you can select any BOM structure for a component in the Bill of
Materials dialog box. These options are not available from the browser shortcut menu.

Tem [PartNamber V| BOM Stuckre [Unt v
By 4 w0 & Inseparable  Eact
¢ -f0 3 10024 '

T M) 1 woo:
A 2 e
A 7 wooms
S s
gre

Tz

Example of BOM Structure

You can assign Inseparable BOM structure to the welded frame assembly, as shown in the following
illustration. The assembly itself may contain a skeleton part model (Phantom BOM structure), multiple
frame members (Normal BOM structure), and purchased components, such as lifting shackles (Normal
or Purchased BOM structure).

Virtual Components

R

You add virtual (non-geometric) components to assemblies to represent engineering components that

cannot be easily modeled.

s ) Regular Hetical Spring Lock Washey (Inch) &)
Hex Thick Mut - Inch 3/4 - 10:1
<F FrameRail: 1

[ Frame_Fastener:4
49 Safety Bracket:1

- Loctite:1 M

Definition of Virtual Components

You create virtual components in place in Inventor assemblies. They have no geometry and are not
saved as separate files when you save the parent assemblies. Lubricants, glue, and other engineering
materials are often represented by virtual parts. You can add any number of virtual components to an

assembly.
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Virtual Components and Vault Professional Items

From a BOM perspective, virtual components are similar to user-created items in Vault Professional.
You can add a user-created item to the BOM of another item. Similarly, when you add a virtual
component to an assembly, it is automatically added to the BOM of the assembly.

When you assign item numbers to an assembly containing virtual components in Vault Professional,
each virtual component with Normal, Purchase, or inseparable BOM structure is assigned a separate
item number.

Your company’s practices determine whether you should represent something as a virtual component
in Inventor, or ignore it in Inventor and add a user-defined item in Vault Professional. You can add key
engineering components to Inventor assemblies in the engineering environment. You can add
common non-modeled components as items in Vault Professional. As with other items in a Vault
Professional BOM, you can override quantity and other values for the item you create from the virtual
component. {

4 Mounting Weldment 1
2 Drawbar 1
- 1 ClevisPint 1 i
- 7 Bal 1
1‘55] 3 Axle Clip 1
Inventor BOM with virtual component
| Mumber  ¥iDe..igQu..!Tie
100055 - Hitch Assembly

1 ’Safety Bracket.ipt
8 4  IS08678 MIZx25
10 4 5T MIZ
9 4 15306312
7 H Tyr s Moy

Vault Professional BOM with virtual component
Creating Virtual Components

You must create virtual components in place in an assembly. The following steps describe how to
create virtual components.

1. Onthe Assembly panel, click Create Component.

2. Inthe Create In-Place Component dialog box, select the Virtual Component
check box.

3. Under New Component Name, enter a name for the virtual component.
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4. Under Default BOM Structure, select a BOM structure from the list. Click OK.

ey New Component Mame Template

J s ot
| Loctite Standardapt

N b o

L/ New File Location

. \) COAOT ‘»fauit?rr:;‘?zau%t%%r%ej:@g?&tée‘r%ﬁeségms’g‘a‘raﬁ!ﬁr}iiéc&

- Default BOM Structure o i
’ i : [ virtisal Component

o Es ar plane

Lo :  Inseparable ;
: ’ }
- B5: Phantom

1 ¥ Reference

5. The virtual component is listed in the assembly browser.

=T } *ﬁ,g’ Aszembly View ™ ﬁ :
¥ HitchAssembly.iam
Representations
. Crigin
- 5 Mounting Weldment: 1

Drawbar: 1
] ANSISASME B13.8, 1 PIN. CLEVIS. 3/ x
& @ Axle Clip 1
el @ Ball:1
- &5 Regular Helical Spring Lock Washer {Inch
N v b & Hex Thick Nut - Inch 3/4 - 10:1
- £ FrameRail: 1

: - (B Frame_Fastener:1
] % Frame_Fastener:2
U % Frame_Fastener:3

Editing Virtual Components

Virtual components are not separate files but they contain the same properties present in other
Inventor documents. You can edit both their properties and their BOM structure. Although the default

units setting for new virtual components is Each, you can change this setting to better reflect the
component in the assembly BOM.
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Procedure: Editing a Virtual Component

The following steps describe how to change the units and quantity for a virtual component.

2.

3.

P Frame_Fastener:4 ]

@« Repeat Create Componenti.

I ‘Ccpy L CtivC

Delete

Add to New Folder .

Ccmpbnent

“Measure

BOM Structire

iProperties..,

bew T

Component Name

In the browser, right-click the virtual component. Select Component Settings.

7

In the Component Settings dialog box, click the Base Quantity drop down and scroll until you find
the appropriate value. Select OK.

Loctite
il of

Default EOM Structure

b

Unit Quantity

1Each
Base Quantity

Each

b 85 {0,0 mm}
~d147 (0.0 mm}
- g 148 {0.00 mm)
- {Jser Parameters

.. Referance Parameters

¢

In the Unit Quantity field enter the appropriate value.

NOTE: If the Base Quantity value is not in the list it can be created by editing the Parameters
| table and entering a new user-defined parameter. The units associated with the user
22wl parameter are assigned to the base quantity field for virtual part.
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4. Override the quantity for the virtual part in the assembly BOM.

Part Number - /BOM Structure: | Unit QTY. 1QTY ! Stock Mumber g " Dascription

T E) 00023 Y Puchased  Each 1 ANSIASME BI8.8.1 PIN, CLEVIS. 34 1,91 Clevis Pin
’ IRt 100021 2 Normal Each 1 Draw bar
; 100027 i Inseparable Cach Hitch Weldment
4 ‘3&[ Reference  Each Frame RailReference
S + ?é} Phantom Each Frame Fastener

100019 g Normal Esch Hitch Ball
‘{3} Purchased  Each tielical Spring Lock ‘Washer
Bgsj Purchssed  Each . e Thick St
100024 98 Purchased  Each ) #xle Clip
} Loctite 483 Purchased | 1.000m

Tnport, J i

Guidelines for Virtual Components

= Develop a company or departmental strategy for implementing virtual parts, user-created items,
or combination of both.

= Virtual components are not saved as separate files, but rather are contained within assemblies.

* Virtual components with Normal, Purchased, or Inseparable BOM structures are assigned separate
item numbers when their parent assemblies are assigned item numbers.

» Virtual components have the same properties as other Inventor documents.

Modifying Content Center Component Properties

You can customize Content Center library components to integrate them into Vault Professional.

Uoraﬁ e

22M Chamfered Bottom DIN 439-2 - DIN 555 -replaced
Hex Machine Sr...  replaced by DIN,., by DINEM 24033

DI 6915 DIN 934 -replaced DIl EN 24032 DIM £% 24033
by DIM B 290324..,

OIN BN 24034 DIN £ 24035 DN EN 24036 DIN EN 24036

Ttem Counti@4.
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Content Center Library Components

Many Inventor assemblies contain components from the Content Center libraries that ship with
Inventor. These libraries contain a large number of common engineering components from a variety of
standards, including ANSI, ISO, JIS, and others. You copy data from the read-only default libraries to a
custom read/write library where you can customize the property information in the component family.
When you assign an item to an Inventor assembly containing library components, those components
are also assigned items.

The following illustration shows a custom read-write library added to the content center libraries.

ty

cLibraries

g Icon | Name | Server Mame | Incuded Access

Inventor 8NST . localhost ; Read Cnly

Inventor DIN Jocalhost Read Only
Inventor Routed Systems . localhost N Read Only
Inventor Sheet Metal localhost \ Read Only
AOTC locathost Read/Writs

You can also publish your own components to a custom library by creating an iPart factory that
includes a table to define the variations in the part. You can include model properties as columns in
the table and assign default values for each variation of the part. After you publish the iPart factory to
a custom Content Center library, you can place the different versions in assemblies. Each variation
retains the property values defined in the original iPart table.

See “iParts” and “Content Center” in the Autodesk Inventor Help for more mformatlon on working
with and publishing your own library parts.

The following illustration shows an iPart Factory part and the iPart Author table that you use to create
the different iPart member definitions.

|| Parameters | pro

£7) 115_B_2301_MaleFema)
5 Revolution!

= &2 [14 mm]
x= B 37 ]

B1 [23 mm]

O [18.662 o]
M [1F mm]

Procedure: Modifying Properties of Content Center Components

The following steps describe how to copy data from a default read-only library to a custom read-write
library and edit the properties in the library table.

1. Log in to the Autodesk Data Management Server as a user with at least Content
Center Editor permission.
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10.

11.

12,
13.

Expand the folders and select Libraries. Right-click and select Create Library.

Enter the Display Name and select a Partition based on the Inventor version you
are using for the library.

4. Select OK to create the library.

Libraries
On NOV12376520

B3 Vaults
7 Libraries
3 Management

Libraries

Display. Name: Custom|
- Partition; L{«i

Database Name: AL2011_Custorn

In Inventor, open any assembly. Click Tools ribbon and select Editor in the Content Center section.
In the Content Center Editor dialog box, do the following:

e Right-click the category or family to copy. Select Copy To.
e  Click the name of a read-write library.
e Click Yes to refresh the content in the server.

In the read-write library, locate the part family you want to edit. On the List panel, right-click the
part family. Click Family Table to display the Family Table dialog box.

In the Family dialog box, display the iProperties columns only. Add a new column.

In the Column Properties dialog box, enter a column name and column caption. Select a data type
for the property.

Under Map to Inventor Property, select the Autodesk Inventor property to populate with the value
from the new column.

Select the Expression check box. Enter a constant string, or use a combination of strings and
parameter names to populate the cells based on other values in the table. Click OK.

If required, repeat steps 5 through 8 to add other columns.

Optionally, delete or suppress rows in the table that are not used in your designs. You can also add
rows or edit parameter values to create custom versions of the library part.

When you place parts from the table into subsequent assemblies, the property values in the library
part reflect the values in the columns mapped to Inventor properties.

Any component placed from the Content Center has a default Purchased BOM structure.
You can edit this structure in the Bill of Materials dialog box.
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Working with DWG Files

You can use Autodesk Vault Professional with drawing (DWG™) files created in AutoCAD, AutoCAD
Mechanical, AutoCAD Mechanical Desktop, AutoCAD Electrical, and Autodesk Inventor.

I:EE @ @x@? Number

B9 Hide Situations
{FilHide

B [Z FRONT PLATEL

Fi
]

State Title (ftem, COY

Wark In Progress | FRAME

Iwork In Progress | FRONT PLATE

DWG Files, Autodesk Vault, and Autodesk Vault Professional

Many companies work with a variety of Autodesk CAD software applications. Although the primary
focus of Autodesk Vault and Autodesk Vault Professional is to work with data from Autodesk
Inventor, you can manage versions and assign items to drawing files in Autodesk Vault.

Always check out and check in drawing files using the Vault ARX application inside your AutoCAD-
based software. AutoCAD Electrical users must check out and check in all files in a project at the

same time.

When you have checked drawing files into the vault, you can assign items to them using the same
technique you use to assign items to Inventor parts and assemblies.
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The following illustration shows an AutoCAD Mechanical file being checked in to the vault

Keep files checked out
[F Close files and delete working copies

Files Tree

4 2 $fAutoCAD Mechanical Files
% Arbor_Press_Frame.dwg

1File f 215 KB

Enter comments to indude with this version:

updated lower flange]

When you work with drawing files in Autodesk Vault Professional, consider the following:

* AutoCAD Mechanical and AutoCAD Mechanical Desktop BOM data is used to determine Category.
Assembly drawing file BOM data is translated into the item BOM.

= When you assign an item to a drawing file, any externally referenced files (Xrefs) are added as
attachments to the item in Autodesk Vault Professional. Always check in the drawing containing
the Xrefs to maintain the file relationships.

* Property extraction and mapping between Autodesk Vault Professional and drawing files is not as
robust as it is with Inventor documents. No provision exists for writing item property values back
to the properties in a drawing file.

* You can control lifecycle status and changes to drawing files with Autodesk Vault Professional
engineering change orders. If the vault is set to enforce file locking, you cannot check out a
drawing file from the vault unless its lifecycle state is set to Work in Progress.

You can generate 2D drawings in Autodesk Inventor in either Autodesk Inventor’s native format (IDW),
or in DWG format. You can assign items to both of these file types. If a drawing file does not exist in
the vault when you assign an item to its associated part or assembly, you must manually attach the
drawing item to its part or assembly item when the drawing is later added to the vault and assigned an
item.

Example of AutoCAD Files and Vault Professional

Your design team uses AutoCAD or AutoCAD Electrical in combination with Inventor. An AutoCAD
drawing contains a 2D reference layout for your Inventor assembly. AutoCAD Electrical drawing files
detail electrical requirements for your design and provide pin and wire information for a harness
assembly in Autodesk Inventor Professional.

You add the AutoCAD drawing file to the vault. You then attach it to your top-level Inventor assembly
file and assign an item to the Inventor assembly. You add the AutoCAD Electrical drawings to the vault.
You assign items to the AutoCAD Electrical drawings and use their Vault Professional bills of materials
to aid the design.
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Exercise 2: Work with Autodesk Inventor

Assemblies and BOMs

In this exercise, you examine an Inventor assembly BOM
and how various BOM structure settings affect Vault
Professional item creation. You work with components
having Normal, Reference, Phantom, Purchased, and
Inseparable BOM structures. You add a component to
the assembly after assigning an item number to the
assembly, and examine how the new component is
added to the Item Master.

R I B O S
i 101 Each . 9afety Bracket.i
- 100051 i Each  axle dip.ipt

: 100050 1 Each . ANSI/ASME B18.8.1 ..

Vault Setup

1. Start Autodesk Vault Professional. Log in using the
following information:

User Name — administrator
Password — leave this blank
» Database — AOTCVault

2. Click Go menu > Vault Explorer. Click Tools menu >
Options. If necessary, clear the Show Hidden Files
check box. Click OK.

3. Inthe Vault browser, right-click the Vault Explorer
(S) folder. Do the following:

Click Properties.
= The working folder should be set to
C:\AOTCVaultPro\VaultWorkingFolder.
= Click OK.

4. Inthe browser, click the Vault Explorer (S$) folder.
Do the following:

» |n the list, right-click Designs.ipj.
»  (Click Get / Checkout.
= Click OK.

10.

The Title property needs to be re-mapped in order

for the item Title property to be displayed properly.

Do this:
= Select the Tools menu > Administration > Vault
Settings.

= Select the Behaviors tab then the Properties
button from the Properties group.

= |nthe Property Name column find the System
property Title (Item, CO).

= On the Property Definition toolbar select Edit.

= Select the Mapping tab.
Find the entry for Provider: Inventor and select
the File Property Component Name.

= Select the up arrow in the Mapping toolbar to
move this entry to the top of the list.

= Select OK to dismiss the Edit dialog.

= Select Close to dismiss the Property Definition
dialog.

Start Autodesk Inventor.

In the New File or Open dialog box, click Projects. If
Autodesk Inventor was already running, click File
menu > Projects.

In the Project Editor dialog box, click Browse.
Do the following:

=  Browse to C:\AOTCVault Professional\
VaultWorkingFolder.
= (Click Designs.ipj.

«  (lick Open. i
= Click OK after you are warned about a missing
folder.

= Click Done.

Click the Vault tab and then select Log In in the
Access group. Log in using the following
information:

User Name — usera
Password — vault
» Database - AOTCVault

NOTE: If you have installed Inventor with separate
log-ins for Vaults and Content Center libraries,
select Vault Log In.
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Work with Autodesk Inventor Assemblies and
BOMs

1. Click the Vault tab and then Open from the Access
group. Do the following:

= Navigate to the Designs\TrailerHitch Folder.
Click HitchAssembly.iam.
= Click Open.

2. If prompted to check out the assembly, click No. If
prompted to get files from the vault, click Yes to All.

NOTE: If the Resolve Link dialog box is displayed,
click Cancel. Open the HitchAssembly.iam file from
the vault a second time.

3. Examine the assembly browser. The browser is a
hierarchical list of the assembly components.

The Mounting Weldment subassembly contains the
black components that make up the welded portion
of the hitch assembly.

Each instance of the Frame_Fastener subassembly
contains one bolt, one washer, and one nut.

x

F B v CrsccemblyView v @4
% HitchAssembly.iam
| - [E] Representations.
- 7 Origin
- %Mcunﬁng weldment:1
B () Drawbar: 1
[ AMSI/ASME B18.8. 1PIN, CLEVIS. 3/4 %
B () Axde Clip: 1
B fflBall 1
[E
£
£
&

1 8 & Reqular Helical Spring Lock Washer {fnch
- & Hex Thick Nut - Inch 3/4 - 1011
t g FrameRail: 1

g % Frame Fastener:1

- [ Representations
B~ (7] Origin

- G5 150 8678 M12x 25:1

& 153053 1201
- B 15 7790 M 12:1

5.

6.

7.

Structured tab.

Place the cursor over BOM Structure to display the
assigned structure of the Phantom assembly.

&% Hex Thick hut S
i 2dd to New Folder

5 @Represenh Salection »

- E:}Origin
B 21508678 | 27 U
B 42 1S 1063 12
B & 15 7750 M
o (B Insert:g Component L4
%Framefasben‘
¥~ (%2l Represent;
i t] origin Measure 14
o L2150 8673
- 153083 &
8- Z1s7m0 M

Representation...

In the browser, repeat the two previous steps to
examine the BOM structure of other components.

For example, the FrameRail:1 component is
assigned a Reference BOM structure.

On the Assembly tab click Bill of Materials Manage
group.
In the Bill of Materials dialog box, click the

TBOM Strictire | Unit OTY | GTY | Stock Number | Decaripton

W Purchased £ ANSI/ASME B18,8.1... ClevisPin
' 2 Normal Draye bar
B8] Purchased Adle Clip
| Hitch Wekiment

8.

9.

The Phantom Frame_Fastener subassemblies are
not listed in the BOM. The three child components
from the Frame_Fastener subassembly are
displayed as promoted items in the BOM as items 8
- 10. The QTY column displays the number of
components in one subassembly (1) multiplied by
the number of phantom subassemblies (4).

If a column is not visible, do the following:

= |nthe BOM, right-click a column header.

= (Click Runtime Column Customization.
Drag the desired column from the
Customization dialog box to desired location on
the display.

Add the Filename column to the display if it is not
visible.
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10. All items appear unavailable because they are not

checked out of the vault.

| BOM Striichrs
3 41584 BE$_§ Purchasad

ot % Hormal

E§_$j. Purchased
& Inseparable
3;_$_§ Furcha 5
S3_AUNCIot 82 purchased
Gall.in EEE Mormat

St

R I I S Y e R

]
= W@
o

L

LU devata

124pt

L

Ml

gt

The BOM Structure column displays the assigned
BOM structure for each component. The library
components are shown as Purchased. The Drawbar
and Ball components are Normal. The Mounting
Weldment assembly is shown as Inseparable.

11. In the Bill of Materials dialog box, click Done. lf you
get prompted to check out the files select No to All.

Assign an ltem to the Assembly

Switch to Autodesk Vault Professional.

Click Go menu > Vault Explorer. Expand the Vault
Explorer, Designs, and TrailerHitch folders.

NOTE: The components with the Reference and
Phantom BOM structures are included in the vault.
The BOM structure affects only items in Vault
Professional.

Right-click HitchAssembly.iam. Click Assign item.

In the Assign Item dialog box, click the Number
header to sort in ascending order.

In the Assign Item dialog box, the item list reflects
the structure of the Inventor BOM. The Reference
FrameRail part and the Phantom Frame_Fastener
assembly are not included in the list. The child
components in the Phantom Frame_Fastener
assembly are assigned item numbers.

In the Assign ltem dialog box, do the following:

= (Click Next.
= Click Finish.
= (Click Close.

In the Item Master, click the Hitch Assembly row.

7.

In the item pane, click the Bill of Materials tab.

The Inseparable Weldment assembly and all its chiid

items are included in the default tree view.

Number. Quantity <.~ i Units Tiﬂe(ltam,CQ) ;

100014 1 Each Mounting VVeldmenf:ié?n )
$7.244094488180 Inch ANSTAISC 202x174 - 1200mm

Each 157790 12
fach Batlipt

- 58 100008
00005

1 1 Each end_plate_RH.ipt
B 100012 1 Each end_plate_LH.ipt
5 100013 1 Each DravBarMountTopPlate.ipt
5 100017 1 Each DrawBarMountBottomPlate.ipt
{38 100002 3 Bach  ISOB678 #12x25
-G8 100007 3 Each 15306312
4
1

NOTE: Your item numbers and column organization
may not match the previous illustration.

8. Under Structure, select First-Level.

The child items of the Inseparable Weldment
assembly are not displayed.

Structure:

Title {frem, CO}

1 Hex Thick Mut - Inch 3/4 - 10
)3 Regular Helical Spring Lock Washer {... -
i Ballipt
§ 15306312
65/ 100008 4 57790 112
I 100009 I Drawbar,ipt -
(58] 100010 1 ANSFASME BLS81 PIN. CLEVIS, 374 .. | -
Mé} 100011 1 Axle Clipipt :
i

tdounting Weldmentiam

9. Under Structure, select Multi-Level.
10. Switch to Autodesk Inventor.
11. On the Vault tab in the Access group select Place..

12. In the Select File from Vauit dialog box, navigate to

the Vault Explorer($)\Desings\TrailerHitch folder.
Do the following:

Click Safety Bracket.ipt.

Click Open.

Click in the graphics window background.
Right-click in the graphics window and select
Done (esc).

A message is displayed, asking you to check out the
assembly from the vault. Select Yes. When you add
the bracket to the assembly, the assembly is
modified.
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13. Click Yes to All to check out the assembly and all
parts. Right-click and then click Done.

NOTE: You typically position the bracket in the
‘assembly with assembly constraints. You are not
required to apply the constraints in this exercise.

14. Save the assembly. In the Save dialog box, click OK.

 15. In the Assembly browser, click the title bar.

16; From the list, select Vault.

Representations

Favorites

17. In the browser, right-click HitchAssembly.iam.
18. Click Check In.

19. In the Check In dialog box, enter Added safety
bracket as a comment. Click OK.

20. Switch to Vault Professional.

21. In the ltem Master, right-click the Hitch Assembly
row. Click Update.

¥ Murdber: 7. - Revision ", State Description (tem,CQ) Catégory Mama.

| Work In Progress

Bifl of Materials |3
E Change ftem Number..,

Structure: Change Revision,,,

: 3 { Chapge State...
{Faz Multi-Levet =i 9

Number Quantity Units Title (it

22. Inthe ltem Master, do the following:

Click Next.
Click Finish.
= Click Close.

In the Update ltem window, notice that the safety
bracket part is automatically added to the Item

Master.

{11 Nurmber Quantity ‘Units  Title (ftem CO}

b @

i 5 Sefety Bracket 1 Eech  Sofety Brackehipt

! w1 Each  ANSVASME BB81 PIN. CLEVIS, 3/¢ x 141
¥ ““““ i~[G8] 100009 1 ) ‘each  Drawbaript

NOTE: Your item numbers do not match the item
numbers in the previous illustration.
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Chapter Summary |

In this chapter, you learned how to use to Autodesk Vault Professional to work with other applications,
including Autodesk Inventor and Autodesk Vault.

Having completed this chapter, you can:

Manage bills of materials (BOMs).
= Describe the integration of Inventor, Vault, and Vault Professional and the relationship between an
Inventor bill of materials (BOM) and the associated Vault Professional item BOM. M
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Administering Autodesk Vault
Professional

This chapter describes how to manage Autodesk® Vault Professional®. You learn about configuring
Items, configuring and mapping item properties, and configuring Change Orders.

Autodesk Vault Professional is an extension to Autodesk® Vault. Therefore, to effectively manage a
Vault Professional installation, you should also be familiar with the following Autodesk Vault
management topics.

Backing up and restoring vaults.

Moving file stores.

Detaching vaults.

Creating and deleting vaults.

Re-indexing properties.

Defragmenting databases.

Using the content indexing service.

Configure users, groups and folder level permissions.

Objectives

After completing this chapter, you will be able to:

= Create unit and categories, create new Item numbering schemes, and change lifecycle rules.
= Set up Change Orders including routing lists, user-defined properties, and Change Order
numbering.
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Lesson 1: Configuring ltems

Overview

This lesson describes how to configure Items. You learn how to create unit and categories, create new )
ltem numbering schemes, and change lifecycle rules. -

iﬁ Yault Settings.

gfﬁleg o Visualiza

Lifecycles and Revisi

Ef)"ﬁ Edit and Manage Lifecycles and Revisions:

+Categories

: D% Edit and hManage Categories

Properties

Edit and Manage Properties

Define Custormn Numbering Schemes

Report Management

Define Report Color Assignment

All of the workflows described in the chapter are access from the Vault Settings dialog shown above.
This dialog is displayed by selecting the Tools menu then selecting Administration > Vault Settings. You
will need to be logged in as an Administrator to complete these workflows.

Objectives

After completing this lesson, you will be able to:

Describe Units of Measure.

Describe Item categories.

Create Item numbering schemes.

Manage lifecycle rules and file locking.

Configure revision numbering sequences.

Configure visualization file watermarking.

Create units of measure, categories, and lifecycle rules.
Create Item numbering schemes.
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Units of Measure

Every Iltem is assigned a unit type. You can create new unit types if the supplied units do not meet your
company’s needs. The following illustration shows the complete set of units that ship with Vault
Professional.

- i}ﬁ Units of M’eéisure

Each
Faot 30485 L
Gallon 3785411
Gram 1
Inch i 254
Liguid Qunce 29.573531 ¢
Liter 10007
Meter m 100}
Milligram 0.001
Millititer 1
Millimeter 0l
Ounce 28.34953
Pound 453.5923
Quart 946.3531
Square Centimeter 1
Square Foot 9280205
Square Inch 6.451601
- Square Meter 10000
Yard Y 8144003

About Units of Measure

Unit types define the units of measure for [tems. You use unit types to specify the quantity of an Iltem
in a bill of materials. Many Items use a special unit type, each, when the number of required ltems is
countable. Other Items are assigned specific unit types, such as meters or grams, when a measurable
quantity is required, rather than an Item count. Several predefined unit types are supplied, but if those
types do not meet your needs, you can define new ones.

Each unit type is derived from a base unit and a conversion factor. For example, centimeters are the
base unit for length and all length units are defined with respect to centimeters. You can create new
base units if you cannot define the new unit from the existing base units.

The following illustration shows the length units that are defined using the centimeter base unit. The
conversion factor relates the unit to the base unit. For example, one inch is 2.54 centimeters and one
foot is 30.48 centimeters.

N ¥
Each
Foaot ft cm 30.48
_ Gallon gal il 3785411
Gram g g 1
Inch in cm - 254
Liguid Cunce lqd oz 2 2957353
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Procedure: Create a New Unit of Measure

One of the Items in your product’s bill of materials is measured in kilograms. You define a new unit
type to support this unit of measure. The new unit uses grams as the base unit.

In the Vault Settings dialog select the ltems tab.

2. Select Configure in the Units group to display the Units of Measure dialog.
3. On the Units of Measure dialog select New to display the Add Unit dialog.
4,

Enter the Name, Symbol, Base Unit and Conversion factor information.

Name: Kilogram

Symbaol: kg

Base Unit:

|| Conversion facton

Hame Symbol Base U,. 7 . Conversion Factor :
e g . . 1
' Mitligram mg g :
Ounce oz g 2834553
Pound . Ib g 453.5923
Kifogram kegy g
Milliliter ml [l 1
Liter i il 1000 Z

6. The Units of Measure dialog shows the new unit.
7. Select OK to dismiss the Unit of Measure dialog.
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Iltem Categories

Every ltem has a category, such as part, assembly, or product, which helps to identify the ltem. Some
categories, such as part, assembly, and purchased, are assigned automatically based either on the type
. of file or the CAD file’s bill of materials (BOM). You assign other categories manually when you create

J Items.

) There are several predefined categories, as shown in the following illustration. If these do not match
o the categories you use, you can create new types to meet your requirements.

% Conﬁ‘ggz‘re‘ Catégo%ieﬁ

- Itern Categories

Y Categary Name " Description

Document Document

Electrical Electrical

Electrical Project Electrical Project
ﬁ Generat General
Ll Part ‘ Part
& Process Process
& Product ) Product
&) Purchased Purchased
-~ Behaviors .~

Revisions"§~p;

Name Description

Procedure: Create a New Item Category

Your company manufactures industrial machinery. Frames are often built by one division of the
company and then brought to a central area for assembly. In your current ERP system, you identify the
frame as a weldment.

1. Inthe Vault Settings dialog, select the Behaviors tab and select the Categories button in the
Categories group to display the Configure Categories dialog.
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2. Select Item Categories from the drop down list. The Item Categories are displayed.

ﬁi Canfigure Catc—gcnﬁés

| Item Categories

) Category Name

- Description

Document Document

Electrical Electrica
Electrical Project Electrical Project
General General

Part Part

3. Select New from the toolbar to display the Category Edit dialog. Enter the new ltem Category
Name, pick a Category Glyph color, and optionally enter a Description. Make sure Available is
selected.

P4 Category Edit o

Mame: Weldment

Color Available

Description: EWe!d‘ment Frames

4. Select OK to dismiss the Category Edit dialog.
5. The new Item Category is added to the list.

Category Name. o Bescription *
Electrical Projéd Electrical Project
..... General General
{2} Part Part
& Process Process
J Product Product

6. Optionally assign a different Revision scheme and set of default properties to add to the Item
when it is created.

7. Select Close to dismiss the Configure Categories
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Iltem Numbering Schemes

Item numbers uniquely identify ltems. When you set up Vault Professional, create Item-numbering
schemes to match your company standards.

fﬁﬁiﬂu‘mbéﬁhg Schemes

AOTC-Numeric

Type

Active - Default . : Preview

tdapped

Sequentiat

; \ Item Number Components

Item numbering schemes can consist of one or more of the following components. For a simple
numbering scheme, use a single, automatically generated sequential number. For a complex scheme,
combine several components together.

Field Type:

% Aute-generated sequence

3 Delimiter.

- Fixed text

H 7 Freetext

e

o, 3 Pre-defined list

H Y e >

£ !

(- 5 Workgroup label

{,»W\E Pt i Field Settings

R

e HName: !Seql

PO

{ Y

A Length: 54

,2" § Range: llDOO - 119999
L N
- Step Sive: !10

A

121 Zero-pad atitn-generated sequence




Automatically generated Sequential number 100058

sequence
Delimiter Single character e -
Fixed te;(t Fixed text string ABC
Free text User-entered text string ANYTHING
Predefined list List of choices | FAST, STRU, ELEC, OTHR

100, 200, 300, 400, 500 \
Workgroup‘ label Workgroup ID ‘WGl -

Autodesk Vault Professional is shipped with two predefined Item numbering schemes named
Sequential and Mapped. Neither scheme can be modified. The default Sequential ltem numbering
scheme uses a single, automatically generated number that numbers ltems from 00000000 to
99999999. The Mapped Item-numbering scheme accepts a text string. It is automatically used when
you assign an Item to a file and the file contains a property that is mapped to the ltem’s Number
property. It is recommended that you define your own numbering scheme rather than using one of the
supplied schemes.

Procedure: Defining an Item Numbering Scheme
1. InVault Settings select the Behaviors tab and select Define from the Numbering Scheme’s group.

2. The Numbering Schemes dialog appears. Select Item from the drop down list to display the Item
Numbering Schemes.

T AOTC-Numeric

' Mapped

Sequential
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3. Select New to display the New Numbering Scheme dialog. Enter a Name for the new numbering

scheme and then select New.

:Acme Corporate Mumbering Scheme

Preview; i

Number Length {iVax): {

s Fields

 FiForcetoupparcase

4. The Add Field dialog appears. Create the first part of the numbering scheme. In this case a

predefined list with list values 100, 200, and 300 representing Parts, Assemblies and Purchased

ltems.

5 Add Field

Field Type:

3 Auto- generated sequence
4 Delimiter

% “Fived text

) Freeted

& Pre-defined list

&% Waorkgroup label

Predefined List Field Settings .00

Name: IT\_zpe

Entér code list:

Is Befault . | Code Description

’ (4 Pat

100
200 Assembly
300

Purchased




Enter OK to dismiss the Add Filed dialog. The first part of the sequence is shown in the New

Numbering Scheme dialog. Note the preview of how the number will look. Add two more parts to

the sequence repeating step 4.

{5 Add Field

Fietd Type:

& huto-generated sequence

@ Delimiter

£ Ficed text
¥ Freetext
. Pre-defined list

&3 Workgroup labsl

o Add-Field

3 Delimiter
£ Fixed text

& Freetext

#% Pre-defined list

£5 Workgroup label

Field Type;
1. 8 Autorgenersted sequence

== 19999

Delimiter Field Settings Auto-generated Field Settings.
Defimiter Yalus H Name: iSqu
Length: ;4
Range: f1ooe
Step Size !1.

ff Zerg-pad suto-generated sequence

Return to the New Numbering Scheme dialog to see the final sequence.

P New Nuﬁﬁeﬁﬁg Scheme ©

Name: &cme Corporate Numbering Scheme
Preview: s
RMumber Length {Maxj: 8
Figlds
Name Type Value
yo e-defimed list 103,200,300
elimiter -
Seql iAuto-genereted 1600 - 9399
% Force to uppercase
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7. Select OK to dismiss the New Numbering Scheme dialog and return to the Numbering Scheme
dialog.

Type Active.. . Default | Preview
AQTC-Complex
AOTC-Nurmeric item
e

{ Y Mapped Ttem

Sequential ftern

8. Select the checkbox Default if you wish this to be the default numbering scheme.

Note that numbering schemes that require user input are not good choices for default since
in automated processes like Assign ltem there is no chance to prompt for the input. In this
case the number generated will always use the default value. You will be required to go back
and edit the Item if you want to use a different value.

Guidelines

= Do not use one of the default numbering schemes

You should define your own numbering scheme rather than using the default, even if you want to

_use a simple sequential number. If you want to use a single sequential numbering scheme, start
the first ltem number with a 1 rather than 0 (for example, use 1000001 rather than 0000001)
because leading zeros may be suppressed when you share data with other applications.

—

= Create as many numbering schemes as required

You can create and use more than one ltem numbering scheme, if required. For example, you

. might use a simple sequential numbering scheme for users who assign ltems. After the ltems are
£ created, the ERP Manager can renumber Items, using a more complex scheme to make Item
numbers compatible with other company systems.

® Consider adding user-defined ltem properties to enhance searching

Although complex numbering schemes can be used to identify categories using fields in the ltem
number, you can also use Item properties to group and sort items. Properties are more flexible

fﬂ and are more easily searched than complex Iltem numbers. For example, if you use a complex ltem
N numbering scheme such as 100-ELEC-10345-545, consider using a simple scheme. Add user-
) defined properties to Items to include the information that is inherent in the numbering scheme.

You can search on the properties to find Items, and new or casual users will be able to better
identify and locate Items.
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item lifecycle States are:
Work In Progress

Configure Item Lifecycle Settings

In Review
Released
Obsolete

Unlike files, the Item lifecycles States are less flexible. However, there are three options for configuring

lifecycle settings:

1. Rules: When a lifecycle State is changed the system can automatically create new revisions. In
addition, in certain lifecycle States the associated files are locked and cannot be edited.

2. Configure: By default the system displays the four lifecycle States as shown in the list above. It is
possible to change the name of a lifecycle State to better match your organization’s nomenclature.

3. Security: By default, Item security (file locking) is applied to files associated with Items. It is
possible to disable this globally or on a user or group basis. This gives some flexible to do file
modifications to released files and restrict this to a particular user or set of users.

File Locking

File locking and lifecycle rules significantly affect how users work with Items and files. As an
administrator, you must be able to modify lifecycle rules to better suit your company’s workflows.

From State To State

Work In Progress Obsolete

Description

I&am‘ hés t;ansitiéned '
frem WIP to Obsolete

: Lifecycle Type:

Item Lifecycle

Work In Progress Released

Refeased

| State Transition from WIP to'In Review

Ttem has transitioned
fi

temn has trensitioned

Item Lifecycle

Rule v Action

# Bump Recrsion {Nene

Bump Primary Revision
Bump Secondery Revision

i Bump Tertiary Revision

File locking prevents Vault users from inadvertently modifying released or obsolete files without
following the correct change procedure. If you turn on file locking and an Item is in any State other
than Work in Progress (WIP), the associated vault files are locked and can be viewed but not checked
out. File locking maintains the integrity of ltems as well as the files to which they are assigned.

In the following illustration, the files are locked because the associated Items are in the released State.

sarch ICU Valve

D File Name Yersion | CheckedIn Comment Revizion
5 R/ 10U Valve Main Assembly.iam T |4/6/2007 425 M

ICUENDCP it 1 4/6/2007 £:25 Al

ICUHOUSG,igt 1 4762007 4:25 A

TCULBUTALnt 1 AAT0T 435 AN
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Item Security Configuration

, Administrators can override file locking on individual files in the vault. Use caution when unlocking files
manually, and remember to lock the file again. Remember, also, that each Item revision is associated
with a certain version of a vault file. If you unlock a file to make a minor edit without following the
proper change procedure, you may not be able to associate the new version of the file with the
) released ltem.

Procedure: Change File Security

! ‘ 1. Inthe Vault settings dialog select the ltems tab. Select the Security button in the Lifecycles dialog
to display the Configure Lifecycle Security dialog. Note that the default setting is to Apply Item
security to related files.

| Grovps or Users:

... Name

Permission
Read o
Medify

Delete

2. Select Add to add a user or group to the list of Groups or Users and modify the security. In this
example usera is added to the list. Select OK to dismiss the dialog.

Select Menihiers From:

. Avaiiable Members: Curvent Membeis:

‘Name: Last Name
i 3§ Guest Guest

L CCReadler CCReader

userc C

A
: sexplorer Explorer
pEexp P
B
&)

JobUser JobUser
userd [
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3. Inthe Groups and Users list select the new entry. Select which permissions to give them. In this
case usera can now modify a file associated with an Item regardless of the lifecycle State.

Apply Rem security to related files

Groups or Users:

L.  Name

[ Remove

Deny

Delete

4. Select OK to dismiss the dialog and close the Vault Settings dialog.
Lifecycle Rules

Lifecycle rules determine how an Item’s revision changes when the lifecycle State of the Item changes.
By default, the following rule is defined; when an Item’s State is changed from Released to Work in
Progress, the primary revision field is automatically bumped to the next revision. This rule is
compatible with file locking and should not be changed without fully understanding the implications.

You can add additional rules if they are required by your company’s procedures. For example, you
might add a rule that bumps the primary revision whenever an item’s State is changed to Obsolete.

The following illustration shows the default lifecycle rule for changing from Released to Work In
Progress. By default, Vault Professional only bumps the revisions for this lifecycle State change.

4 Administer Lifecycles LB

From State < To State Description Lifecycle Type o
Work In Progress Released \I'::rr: !::;Isptin;:::;&ei Tremn Lifecycle
Work In Progress In Review ﬁi‘: l::‘srpt;ir}f_‘h;; Z?:W item Lifecycle
Refeased Dbsolete ?r:ﬁ ?:;::Z;i:i:%iiulete Item Lifecycle

Obsolete
Obsolete

State Transition from Released to WIP

In Review

Rule Actien

V)”iBump Revision  |Bump Primacy Revision

In Review
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) Example of Lifecycle States and File Locking

As an administrator, you must fully understand the implications of changing the lifecycle rules,
() especially if you plan to use file locking and property mapping. To better understand the default
lifecycle rule and file locking, consider the following example, as summarized in the table that follows.

\ An item is currently in the Released State at revision A. When the Item is released, the CAD files are
/ locked and cannot be edited. A revision to the Item is required. To change the Item’s associated files,
M you change the Item’s State from Released to WIP. Based on the lifecycle rule, the primary revision is

automatically bumped to the next value, B. Because the Item is now in the WIP State, the associated
files are unlocked and can be edited. When the change is complete and the final files are checked in to
Y the vault, you change the ltem’s State back to Released. The revision does not change, because, by

‘ default, there is no lifecycle rule for the change from WIP to Released. Because the ltem is how

j Released, the associated files are locked and cannot be modified. :

None, current status. A Released Locked because ltem
is not inWIP State.
Cannot be modified.

Need to revise ltem. Change State to WIP. B (automatically WIP ~ Unlocked. Users can
. ~ increments based on check out files and
the lifecycle rule) Lo work-on the change.
Change is approved and completed. Change B (no change) Released Locked. Cannot be
State to Released. The change of State is either modified.

manual, or, if Change Orders are used, the State
changes automatically.

Procedure: Changing Lifecycle State Rules

™
_—
o This example shows how you can configure the State transitions to bump a revision when an Item is
o obsoleted. _
Ty
‘\ o . - - .
- 1. Inthe Vault settings dialog select the Items tab then select the Rules button in the Lifecycles group
) to display the Administer Lifecycles dialog.
() 2. Inthe list select From State Released - To State Obsolete.
L %4 Administer Lifecycles
i\*j . fromStaLe TqState' e ,QECﬁPﬁ?Y‘ s Lifecyde’Typem o
{ﬂ»\l Work In Progress Obsolete ?rzr:‘n r":qsptznéig:;:i Trern Lifecyle
p—
{ ....... \} Work In Progress Released }:’:‘n IEIS; :Zn;::::;i Ttern Lifecycle
= sty i,
L
{ ‘w‘j} Relfeased Wcr; I;;;; r;s; B gi'::‘ ;:::xi?::;;‘; ftem Lifecycle
{—m} Obsolete In Review 22";&‘;;5&'2:’;:‘:@% Item Lifecycle
ft‘x Obsolete Workln Progress Iéi"n‘\’g:;;;ﬁ’:’&i tem Lifecycle
Ex,u._.,./} In Review Obsolete 1:2"{;}":;2: :3:’:05:”'2& Trem Lifecycle
{ i‘; In Review Released Trem Pas tansiioned o |ltem Lifecycle j
o
o E
an
o
Ty
U
™
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3. Select Edit to display the Lifecycle Rules dialog. From the drop down select Bump Primary Revision.

1} State Transition from Released to Obsolete

Rule Action

Bump Tertiaty Revisicn
None

4. Select OK to dismiss the Lifecycle Rules dialog and Close to dismiss the Administer Lifecycles dialog.
Close the Vault Settings dialog.

Configure Lifecycle Settings

By default, Vault Professional ships with the four Item Lifecycle States:

»  Work In Progress
*= |n Review

= Released

= Obsolete

By default these names are displayed in Vault Professional when operating on Items. It is possible to
change these names so they better reflect the nomenclature of your organization.

For example, in your organization Items that are being reviewed are marked For Review and Items that
are obsolete are designated as Archived. These differ from the default States In Review and Obsolete
for Items. The display names for ltem Lifecycle States can be changed to reflect this.

Procedure: Configure Lifecycle Settings
To change the display names of Item Lifecycle States do the following:

1. Inthe Vault Settings dialog select Configure from the Lifecycles group in the ltems tab to display
the Configure Item Lifecycle dialog.

Select Display Name and enter new namea;

Lifecycle State Display Name

Nork In Progress

eview n Review

Released Released

Obeolete Ohsolete
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2. Select the Lifecycle State In Review and change the Display Name to For Review. Do the same for

the Lifecycle State Obsolete ad changed the display name to Archive.

Select Display Narﬁg énd enter new name;

Lifecycle State

Display Name

Work In Progress

Work In Progress

In Review

For Review

Releazed

Released

3. Select OK to dismiss the Configure Item Lifecycle dialog and Close on the Vault Settings dialog.

Item Revision Schemes

Autodesk Vault Professional includes several predefined revision numbering sequences. You can use

one of the predefined sequences or create your own.

lter: Ttem Categories

it 3 Delete | 5> Import..

Scheme Name

Defauit ASME ¥14.35M Format

Default Numeric Format

Standard Alphabetic Fermat

Only characters are permitted within the primary format

Standard Numeric Format

Sequential numbering starting from I

<None>

Null Revision Scheme for opt-out scenario

~Scheme Details

Scheme Values:

Revision primary sequence values:

I ™MO o

Example Revision Fommats
Delimiter Character;
Pritnary:

Secondary;

Tertiary:
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Procedure: Configuring Revision Numbering Sequences

The following steps show how to create a revision number sequence for items.

1. Before creating a new revision sequence you must first create a text file that contains all of the
revision numbers. When you specify a new revision you must either allow the system to choose
the next character in the sequence or manually specify a character that is the imported sequence.
An example is shown in the illustration.

Uni:itfed . Matépaé'i

prototype
prototype
|prototype
iprototype
| prototype
| prototype
| prototype

U T O b G B

prototype

2. Inthe Vault Settings dialog select the Behaviors tab and then select the Revisions button for the
Lifecycle and Revisions tab. Select the Import button to create a new Revision Scheme Definitions.

3. Inthe Import dialog specify the Name by browsmg to the file. Then enter a Descnptlon and enter
which of the Item Categories to associate the revision scheme with.

Y Imgont Revision Scheme Definitio

i
i

i Narog protetype_scheme

i §
i

Bescription: Prototype Scheme

[ Delimites {

Categories:

Rewision primary.

pretotype L
prototype 2
prototype 3
pratotype 4
prototype 5
pretotype6
protetype 7
prototype 8§
protetype 3

Example Revisicr
- Defimiter Cha

Primary:

Secondary

Tertiary:

4, Select OK to dismiss the Import Revision Scheme Definition dialog and return to the Revision
Schemes Definitions dialog.

Select Close to dismiss the Revision Scheme dialog.
6. Close the Vault Settings dialog.
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Configuring Visualization Watermarking

Downstream users of ltem drawings need to be aware of the lifecycle status of the underlying ltem. As
an administrator, you can configure watermarks for visualization files to display a custom message
depending on the lifecycle State.

The following illustration shows the watermark on a drawing for which the associated Item is in the

Work in Progress State.

1

T T

There are three choices for selecting the watermark to be displayed on the drawing:

1.

Item lifecycle State: This is the most common watermark. Text will be displayed on the drawing at
a specified location, font, size and color depending on the lifecycle State of the ltem that the file is
associated with.

Property: The value of an Item property will be displayed on the drawing at a specified location,
font, size and color.

Custom: A string specified in the Customize Watermark dialog is displayed on the drawing at a
specified location, font, size and color.
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Procedure: Configuring Visualization Watermarks

Visualization watermarks are displayed on drawing files associated with Items in the View pane. The
actual watermark is determined by the State of the Item that the drawing is associated with.

The following steps show you how to enable and configure visualization watermarking for ltems.

1. Inthe Vault Settings dialog select the ltems tab. In the Visualization Watermarking section ensure
that the Enable Visualization Watermarking checkbox is selected.

Ojey] - Set clientvisibility of items features
80 :

Units

Configure Units

fon

Lifecycles

E(}jj Configure Lifecycle Settings

Visualization Watermarking

gg] Enablevisuéiization Watermarking
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- Item.

~Wetermatk

% em lifecycle State watermark

Select a lifecycle state to i th text, location, style, and size s

» Lifecycle State Watermark Text

- For Rediew

Location

Font

Color

Size

IN REVIEW Diagonal Tahoma Medium

Released - Effective RELEASED — EFEECTIVE Border Tahoma Medium
Released - Pending RELEASED — PENDING Diagonal Tahoma Medium
Released - Superseded | RELEASED — SUPERSEDED Diagonal Tahoma Medium
Released - Expired RELEASED  EXPIRED Diagonal Tahcma Medium

" Archive GBSOLETE Diagonal Tahoma Medium

3 Propeny-based watermark

£ Custom watermark:

: %ﬁ Watenﬁafk Text Entry -'Wéréifn'brcgm

Input text for display in the watermark

- prinsert @ property from below

@ % -- ltem Properties --

Watefrr{ark Text Dispaly:

WORK N PROGRESS

3. The default selection is to display Watermark text associated with the current lifecycle State of the

4. Specify the Watermark text by selecting the button next to the text to display the Watermark Text
Entry dialog.
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5. The default is to display the Item lifecycle State in upper text. To change the value to another
string first select the current water mark text and the select the ‘- button to remove it from the
list. Then select the Input text for display in the watermark radio button and enter a new line of
text in this case WIP. Select the ‘+’ button to Add it to the list. Dismiss the Watermark Text Entry
by selecting the OK button.

¥ Watermark Text Entry - Work In Prograss . . B
Input text for display in the watermark ;
|

Lwwap

= e Bropertiss -~

Watermark Text Dispaly:
WORK IN PROGRESS

% orinserta pfdperty from below
F

H

1

§

“Watermark Text Size
" For Review 1IN REVIEW Diagonal Tahome Medium
Released - Effective : RELEASED ~ EFFECTIVE Border Tahome Medium
Released - Pending RELEASED — PENDING Disgonat Tahoma Medium
Released - Superseded RELEASED — SURERSEDED Dizgonat Tahomz Medium
Released - Expired RELEASED ~ EXPIRED Disganat Tahoma ediun
Aychive OBSOLETE Diagonat Tahoma Medium

7. The following can also be changed:

e Location: Diagonal (default), Horizontal and Border (across the bottom).

e Font: Common Windows fonts.

e Color: Pick from a palette of Custom, Web and Systems colors. You can right-click
in one of the blank fields to display a color picker.

e Size: Small, Medium & Large.

e BEe

EE 8

...... s |
an L B |

t g | L

L] B
o

o
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The result of a customized watermark changing the values is shown in the accompanying illustration.

8. Selecting the Property-based watermark radio button allows you to specify any of the properties
associated with the Item. For example, you can specify the Property Compliance system property

to display this as a watermark.

: @ Property-based watermark

{45y Property Compliance

5 Clistom watermaty
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This can also be customized by selecting the Configure button.

% ' Preperty—bése‘:i Watgrmérk Sétiing

; - Properties

Location; Diagonal

Font: ETahoma

Colon

iMedium

9. The third option is to enter a custom watermark. Like the previous example, this will be displayed

regardless of the lifecycle State. In this example, a custom watermark has been added and
configured.

10. Select OK to dismiss the Customize Watermark dialog. Close the Vault Settings dialog and refresh

the display to see the new watermark.
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. Exercise 1: Configure ltems

In this exercise, you create a new unit and new categories, add a new lifecycle rule, and select a new
revision numbering scheme.

| In Review . |Review

| {Released Released
U ohsclabs Ohselats

The completed exercise

1. Start Autodesk Vault Professional and login with

the following information. 3. Do the following:

User Name: Administrator
= No password
= Database: AOTCAdminVault

2. Select the Tools menu then Administration >
Vault Settings to display the Vault settings dialog.

For Name enter Micron

For Symbol enter um

For Base Unit select centimeters (cm)

For the conversion factor enter .0001

Make sure the This is a Base Unit is unchecked

&

Select OK to create the new unit.

 Name Symbol Base Unit : Cou’wersi::nfai ;
: Centimeter fem om

Horkigace St Milimeter o o 01
Meter m om 160 |
- Inch in om 2.54: z
{Foot ft cm 3048 |
N Yard yd cm 9144003} - |
=t 3:::2::;;}5 Micron umn P 8O0 i
63 [7] Designs b A

5. Confirm the new unit is added. Select OK to dismiss the
3. Select the Items tab. giglltoSgOf Measure dialog and return to the Vault Settings

Unit of Measure

1. Select Configure in the Units section to display
the Units of Measure dialog.

2. Select New to display the Add Unit dialog. This is
where you will define the new unit — microns.
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Item Category

1.

3. Now select Edit to see the Bump Revision rule for this

In the Vault Settings dialog select the Behaviors

lifecycle State change.

tab.

2. Select the Categories button in the Categories
section to display the Configure Categories
dialog.

Item Categories 4.
File Categories
5.
cournent
] . 6.
3. Inthe Configure Categories toolbar select new to
display the Category Edit dialog.
4. Inthe Category Edit dialog enter the following
information:
For Name enter Weldment. _
For the Color select a color of your choice.
Select the Available checkbox if not already
enabled.
»  For description enter Frame Weldments.
% Category Edit o 7.
| o
§ [ame: ‘Weldment 8.
i
i
]i Colon Avaiiéble: [;}j
§ Dascription: Frame Weldments

i Lifecycle Rules

State Transition from Released to WIP

Rule Action |
: Bump Primary Revision ,\:“g

; {Bump Revisicn

ook [ coneet ] [ bep

By default, this is the only Item lifecycle change which
changes a revision. Close this dialog by selecting Cancel.

Select the row that has a From State of Released and a
To State of Obsolete. Select Edit to display the Lifecycle
Rules dialog.

In the Action column, select the drop down and specify
Bump Secondary revision.

- Lifecycle Rules

|| State Transition from Released to Obsolete

: B
4l Rufe Action
Wiy {Bump Revision | None

Select OK to dismiss the Lifecycle Rules dialog and return
to the Administer Lifecycles dialog.

Select Close to dismiss the Administer Lifecycles dialog.

Now when a user changes the lifecycle State of an ltem
from Released to Obsolete the revision will be bumped.
for example from B to B.1.

Configure Item Lifecycle

5. Select OK to dismiss the Category Edit dialog and

S ry £di 1. Inthe same section (Lifecycles) on the ltems tab select
return to the Configure Categories dialog. Configure to display the Configure Item Lifecycles dialog.
6. Select OK to dismiss the Configure Categories 2. Inthe row In Review select the Display Name field and
dialog and return to the Vault Settings dialog. replace In Review with the string For Review.
LifECYCIE RU|ES Eﬁcénﬁgurekemufecy' -
Setect Display Name and enter new name
1. Select the Items tab again and now select Rules e e oo
from the Lifecycles section to display the ’
Administer Lifecycles dialog. e
Note that Item Lifecycles are administered
separately from File Lifecycles which is found on
the Behaviors tab.
3. Select OK to dismiss the Configure Item Lifecycle dialog.

2. Inthe Administer Lifecycles dialog select the row
that has a From State of Released and To State of
Work In Progress.
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Visualization Watermarking

_ 1. On the same (ltems) tab select Configure from
the Visualization watermarking section to display
the Customize Watermarks dialog.

s 2. Select the row for the Lifecycle State of In

e/ Review. We need to change this to be consistent
with the change we just made in Configure ltem
Lifecycle.

3. Select the button next to the Watermark Text IN
REVIEW to display the Watermark Text Entry — In
Review dialog.

Watermark Text
WORK TN PROGRESS

Lifecytle State

Work In Progress”

Released - Effective
SR Released - Pending

RELEASED - PENDING
RELEASED -~ SUPERSEDED

fan]

Released - Superseded

4. Inthe Watermark Text Display list Select the
current text and then select the ‘- button to
remove it.

Watermark Text Dispaly:

5. Select the Input text for display in the watermark
radio button and enter the text For Review.

{} 6. Select the ‘+” button to add this text to the list.

Input text for display in the watermadk.

orinsgrta pmpehy From bélow

| e M Propertier vy

Watermark Text Dispaty: i

Select OK to dismiss the Watermark text Entry — In
Review dialog and return to the Customize
Watermark dialog.

7. Note the change in the Watermark Text for the In Review
State.

Watermark Text Location
| WORK TN PROGRESS !
For Rev?ew
RELEASED — EFFECTIVE
RELEASED — PENDING
RELEASED — SUPERSEDED

Lifecycle State

Work In Progre:

' Released - Effective

Released - Pending

Releasad - Superseded

8. Select OK to dismiss the Customize Watermark dialog
and return to the Vault settings dialog.

9. Select Close to dismiss the Vault Settings dialog.
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Exercise 2: Create Iltem Numbering Schemes

In this exercise, you create two Item numbering schemes. One scheme consists of a simple sequential
number. The other is a more complex numbering scheme, with a list, delimiter, and sequential number.

 AllNumbering Schemes:

| Name
| Complex Numbering Schame
| Mapped
| Sequential
| Simple Mumbering Scheme

{ Mame

} Complex Mumbering Scheme
| Mapped
! Simple Mumbering Scheme o’

The completed exercise

Create Simple Iltem Numbering Scheme

1. Select the Behaviors tab in the Vault Settings
dialog.

2. Inthe Numbering section select Define to display
the Numbering Schemes dialog.

3. Inthe Numbering Scheme dialog select the drop
down and select Items to display the ltem
Numbering Schemes.

ﬁﬁ Numbenng hem
- ’ S

E
i
|
~{
2

E Sequential EItem

4. Select New to create a new Iltem Numbering
Scheme.

5. The New Numbering Scheme dialog is displayed.

In the Name field enter Simple Numbering Scheme.

o New Numbering Schemé

Name: Simple Numbering $cheme

Select the new bhutton dialog to display the Add Field
dialog.

In the Add Field dialog do the following:

= For Field Type select the Auto-generated sequence
radio button.
For Name enter Number.
For Length enter 6
For Range enter 100001 for the starting number and
do not change the ending number.

= leave Step Size at the default (1).

Select OK to return to the Numbering Schemes dialog.
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Create Complex Numbering Scheme

1.

Select New to create a new Item Numbering
Scheme.

The New Numbering Scheme dialog is displayed.
In the Name field enter Complex Numbering
Scheme.

Select the new button dialog to display the Add
Field dialog.

In the Add Field dialog do the following:

®  For Field Type select the Auto-generated
sequence radio button.
For Name enter Number.
For Length enter 5
For Range enter 10001 for the starting
number and do not change the ending
number.

= Leave Step Size at the default (1).

Select OK to dismiss the Add Field dialog and
return to the New Numbering Schemes dialog.

Select the new button dialog to display the Add
Field dialog.

In the Add Field dialog do the following:

For Field Type select Delimiter.
* “For Delimiter Value enter *-* (hyphen).

Select OK to dismiss the Add Field dialog and
return to the New Numbering Schemes dialog.

Select the new button dialog to display the Add
Field dialog.

. In the Add Field dialog do the following:

For Field Type enter Pre-defined list.
In the Predefined List Field Settings section
enter Type for the Name.

= In the first row of the Enter code list: section
enter 100.

= Select the Description field right next to it and
enter Part.

= Asecond row is added to the list. In the Code
field for this new row enter 200.

= Select the Description field right next to it and
enter Assembly. 15

= A third row is added to the list. In the Code
field for this new row enter 300.

=  Select the Description field right next to it and
enter Purchased. ,

= Select the first row and select the Set As
Default button

11.

12,

13.

14.

Your entries should look like the following illustration.

WiaddFen

Field Type:

8 Delimiter
& Figed pext
&5 Freetext
% Pre-defined list
) Workgroup fabel

Predefined List Field Settings

Name: 3Type

Enter code fist:

L. Code ; Description
iy W00 [Part
; 200 | Assembly
300 :Purchased

Select OK to return to the New numbering Scheme
dialog.

Select the Type row and then select the Move Up button
twice to move it to the top of the list.

Now select the Delimiter row and select the Move Up
button once to move it between the Type and the
Number. Your Fields list should appear like the following
illustration.

Fields

Value
100,200,300

Name

Type

Type
Pre-defined list
Detimiter

10001 - 69893

to-generated

Select the OK button to dismiss the New Numbering
Scheme dialog and return to the Numbering Schemes
dialog.

. In the Numbering Schemes dialog box select the default

checkbox in the Simple numbering Scheme row. This
numbering scheme will now be applied to new Items.
Select Close to dismiss the Numbering Schemes

Sequential

Simple Numbeting Scheme
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Lesson 2: Configuring Change Orders

Overview

This lesson describes how to set up and configure Change Orders to better match your company’s

requirements.
P R
o Vault Settings
r5 Itgmg;;i Change Orders
Change Crder Enablement
Q:M—,—:] Set client visibility of Change Orders features
F—W X ;] L
Options .
7 Restrict iem Lifecycle Changes to' Change Orders
e : :
B : .
éﬁ Ttems on Change Orders Cannot Be inthe Work In-Progress State
When Moving Cut of the Change Order Work State
Iarkup Folder
({_,_ Configure Markup Folder
-, -Use Common Markup Falder, & Folder must be Configured
=" Using the 'Configure... Command. : :
£ Store Markups in the Same Folder as the File Being Marl-':edr-u‘p.'
@ User Selects Markup Folder.
Link Properties
Manage properties that support a unique value
for each item on each-Change Order
Change Crder Murmbering i
0071 Define Change Grder Numbering Schemes
£0-0!
Objectives

After completing this lesson, you will be able to:

Set Change Order options.

Configure a Change Order markup folder.

Add user-defined properties to Change Orders.
Define Change Order routing lists.

Define Change Order numbering schemes.
Configure email notification.
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Change Order Options

As an administrator, you can set several options for Change Orders that determine Change Order
workflows. The Change Orders option settings are shown in the following illustration.

£ T
% Wault Setfings

Change Order Enablement

@g Set client wvisibility of Change Orders features

Options

[T Bestrict tem Lifecycle Changes to Change Orders

F Items.on Change Orders Cannot Bein the Work In Progress State
“ When Mowving Out of the Change Order Work State :

i

Restrict Item Lifecycle Changes to Change Orders.

If on, forces all lifecycle changes to be performed using Change Orders.
* Disables manual lifecycle State changes for any user other than those with the Administrator role.

Items on Change Orders Cannot Be in the WIP State When Moving Out of the Change Order Work"
State.

* Ifon, prevents the Change Order State from moving from the Work State to either the Check or
Review States if any of the ltems on the Change Order are in the Work In Progress lifecycle State.

* Forces the Change Order participants to set the associated ltems’ States to In Review when the
Change Order is ready to move out of the Work State.

Configuring a Markup Folder

During the Change Order process, markups are often used to discuss changes. By default, the markup
files are placed in the same folder as the associated file. As an administrator, you can enable the user
to select a markup folder or you can configure a markup folder in the vault where all of the markup
files are stored.

Matkup Folder

Configure Markup Folder |

o Lise Corhmon Markup Folder, A Fnldiér must BE Configured
" Using the 'Configure..’ Command.

9

Store Markups in the Same Folder as the File Being Marked-up.

¥

. User Selects Markup Folder,

Link Properties

: %g Manage properties that zupport 2 untque value

164




The following illustration shows a markup folder named Markups that was added under the root of the
vault.

Change Order List
g rem M

= [ Designs
9 Clamp
7] Table
7 Markups
Ea My Search Folders

Procedure: Configuring a Markup Folder

The following steps describe how to configure a markup folder.
1. Inthe Vault Settings dialog select the Change Orders tab.

2. Inthe Markup Folders sections select the Use Common Markup Folder radio button. The Configure
button in the same group is now enabled.

3. Select the Configure button to display the Select a Vault Folder dialog.

If the folder already exists then select it, otherwise use the New Folder command to create a new
folder.

[ SelectVault tocation. -

| Select a Vault folden

‘ : I”JEE% Vault Explorer {$]
wf] 0

5. Dismiss the Select Value Folder dialog by selecting OK and return to the Vault Settings dialog.

Link Properties

Introduction to Link Properties

Link properties are unique to Change Orders and allow you to support a unique value for each ltem on
the Change Order. Link properties are Item properties but only in the context of the Change Order that
they are associated with. If the Item is not on a Change Order it does not have this property.
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Lock Fer

[z

Title . Revision State {Historical) Units
[ICURBUTNp |8 | Reteased {Each
ICULBUTN.jpt 1A i Released

Change Cost

Procedure: Adding a Link Property

1. Inthe Vault Settings dialog select the Change Order tab. In the Link Properties section select the
Properties button to display the User Defined Linked Properties (Change Order) dialog. There are
no default properties shipped with the product.

i3 User Defined Linked Prgperﬁ‘es;{changg Qrd

f User Defined Linked Properties
]

Property Name Data. Type State Usage H

There are e itens to show in this view.

2. Select New to display the New Change Order Link Property dialog. Enter the Name, select the type
from the drop down and then specify and Settings for the Property. In this case we specified that

the property requires a value great than $0. Click OK to dismiss the dialog and return to the User
Defined Linked Properties (Change Order) dialog.

13 New Change Oider Link Propenty
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3. The new link properties appear in the list. Select Close to return to the Vault Settings dialog.

a U"ser"Deﬁng’d~Lir§kedlé%aﬁer;:iés'%Cﬂaﬁéé‘dde

Et User‘DéﬁneS LinkedProperfies ;
|
bip
i

Change Order Numbering

The default Change Order numbering scheme uses a three-letter prefix, ECO, and an auto-generated,
six-digit number. If the supplied Change Order numbering scheme does hot match your company
standards or does not meet your needs, you can create new Change Order numbering schemes.

If your company standards require more thfén one Change Order numbering scheme, you can create
multiple numbering schemes. The person originating the Change Order can select the appropriate
scheme when they create the Change Order. The following illustration shows the creation of a new

numbering scheme for usef’with Change Orders on a specific product in a company.
Example of Using Change Order Numbering Schemes

Your company differentiates Change Orders that originate out of the design and manufacturing
departments. In Vault Professional, you can differentiate Change Orders using one of the following
methods:

1. Create two Change Order numbering schemes to match the numbering scheme that you already
use. The person originating the Change Order can select a numbering scheme when creating the
Change Order. Users can sort, group, or search by the Change Orders’ numbers.

2. Create one new numbering scheme (or use the supplied numbering scheme) and then define a
- user-defined property that contains a list of the product lines. Users can sort, group, or search by
the Change Orders’ user-defined property.
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Procedure: Define a Change Order Numbering Scheme

The following steps describe how to define a new Change Order numbering scheme.

1. Inthe Vault Settings dialog select the Change Order tab and in the Change Order Numbering
section select Define to display the Change Order Numbering dialog.

‘ %Change ,O(ae,r Nuﬁmb;e

Medify Change Order numbéring lists

Name

2. Select New to display the Edit/Create Change Order Numbering Scheme dialog. Enter the Code
(Prefix), a textual Description, the starting humber and a number of digits between 3 and 6 in the
drop down. Select the Append workgroup label checkbox if you wish and are using replication.

% Edit/Create Change

Code: MCO

Bescription:. : | Manufacturing Change Order

Startirig Number: 10003

Number of Digits:

[ Append workgroup label

Select OK to dismiss the dialog and return to the Change Order Numbering dialog.
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3. If desired, select the new Numbering Scheme and click Set as Default to make this the default
Change Order numbering scheme used when a new Change Order is created. Select Close to
dismiss the dialog.

b Chaég‘e‘OzderNumb«éggaig’

Modify Change‘Orde'r nurﬁbeﬁng fisty ’

L..: Mame
¥ ECO j .
»i MCO : ; [

4. When a new change Order is created, the user selects the button next to the Change Order
Number field to change the scheme used.

#h £CO-000002

Geperal

Change Order Number

ECQ-000002

Change Order Title:
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Routing Definition - Workflow Selection

There are two possible workflows possible with Vault Professional:

ot 1. Standard: in the workflow definition a Change Order moves from the Work State to the Review

™ State. The Responsible Engineer or Change Administrator moves the Change Order out of the

Work State and the Approvers can either reject the Change Order to the Rejected State or Approve
it to the Approved State. This is the default workflow.

Submit and Force Approval

Fast Trackapproval

p prove

Reject

5 Cancel

2. Check State: In this workflow definition a new State Check and Routing Participant Checker is

, added to the standard workflow. This is a common workflow where someone checks the work of
the Responsible Engineer to insure adherence to company standards, etc. before it is submitted to
final review. In this workflow the Responsible Engineer or Change Administrator submits the

: Change Order to the Check State. There the Checker can either Approve it to the Review State or
b Reject it back to the Work State.

Submit and Force Approval

Fast TrackApproval
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The workflow can be changed by selecting the Tools menu then selecting Administration and Global ; \
Settings dialog.

;ﬁiﬁit}bal Settings

: Routing Definition

Define Chang'e Order Routing Li#ts .

Select workflow definition to-use
oninew Change Orders:

Routing Definition - Change Order Routing Lists

As an administrator, you define one or more routing lists to define Change Order participants and their
roles in the Change Order process. When users create a Change Order, they select which routing list to
use. Small companies may need only one routing list and large companies may need many. Because
routing lists are shared across all vaults, only one set of routing lists is required regardless of the

number of vaults you use.
The following illustration shows the creation of a Change Order routing list.

£ | Users
| Administrator { EngineerOne
i enga | EngineerTwo
| engb A&t
{ psexplorer
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Change Order Roles

Change order participants are assigned one or more of the following roles.

Change Requestor

Change Administrator

ResponSible Engineer

Checker

Reviewer

Approver

Notification User

This is the only role that does not need to be explicitly added to a routing.
Anyone with Change Order Editor permission can create a Change Order.

= Can submit the new Change Order to the Open State.
= Can edit or delete the Change Order in the Create State.

Participates in all States.

Is notified when the Change Order enters the Open State.

Can submit a Change Order from the Create to the Open State.
Can delete the Change Order in the Create State.

In the Create State, can edit, submit to the Work State, submit and
force approval to the Approved State or can cancel the Change
Order.

Can change the State of associated Iltem(s) in the Open State.
Can add or remove ltems.

Can add, remove, and edit user-defined properties.

Can add or reply to comments.

Only participant who can set effectivity once the Change Order is
approved (Change Order moves to Closed State).

Pamcupates only in the Work State.

= Notified whenthe Change Order enters the Work State

= Can add and remove approvers and reviewers.

= - -Can submit to the Review State.

= - Can change the State of the associated Item{s) in the Work State:

Participates only in the Check State (when enabled).

Notified when the Change Order enters the Check State.
= Can add comments in the Check State.
=  Can approve to the Review State or reject back to the Work State.

Participates in the Work, optional Check and Review States.

= Notified when the Change Order enters the Review State.

»  Can add or reply to comments in the Work, optional Check, and
Review State.

». . Can add attachments and markups.

= . ‘Can-add additional reviewers to routing list.

Participates in the Review State.

Notified when the Change Order enters the Review State.

= Cannot add or reply to comments (must be Reviewer).

=  Only participant who can approve or reject the Change Order in the
Review State.

Notified when a Change Order enters the Closed State. Does not participateiin
Change Order activities.




Guidelines

You can use the following guidelines when you create Change Order routing lists:

=  Any user with Change Order Editor Permission can create a Change Order, even if the user is not
on a Change Order routing list. When a user creates a Change Order, he or she is added to the
routing list and assigned the role of Requestor.

= Routing list participants can be changed as the Change Order progresses. A participant on the
routing list who wants another user to review the Change Order can add that user as a Reviewer or
Notification User, even if the new user is not a participant in the routing list. The administrator can
also add or remove approvers and reviewers while the Change Order is active. ,

= The administrator, Change Administrator, and Responsible Engineer can add and remove Y
Approvers and Change Administrators in the States where they can edit the Change Order. s

= There must be at least one Change Administrator, one Responsible Engineer, and one Approver on
a routing list. If there is more than one Approver, you can select whether or not unanimous
approval is required to approve the Change Order.
If you turn on the Check State for Change Orders, a routing list must also include a Checker.
Assign multiple roles where necessary. If one user makes changes to associated files and approves
Change Orders, assign that user the Responsible Engineer and Approver roles. If the user does all
tasks, assign them all roles.

Example

A small company wants to track change. They install Autodesk Vault Professional and need to set up a
single Change Order routing list. Two engineers are responsible for all aspects of the Change Order
process and the production manager wants to be notified of change.

A Change Order routing list is created with three participants. Each of the two engineers is assigned as
Change Administrator, Responsible Engineer, and Approver. The production manager is assigned as a
Notification User.

i EaitRouting

Reuting Name: Main Reuting

Change Order participanis: : Routing participants;

Users : Users Reuting Rele
» : Administrator EngineerOne | Approver, Change ..
‘ EngineerTwo | Approver, Change ...
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Procedure: Creating a Change Order Routing List

The following steps outline the creation of a routing list.

1. Open the Global Settings dialog (Tools menu > Administration > Global Settings) and select the
Change Orders tab. Select the Change Order tab and in the Routing definition section select the
Define button to display the Routing dialog.

Drag a routing from the list on the left to the list on the right to make it active. You can deactivatea.
routing by dragging it back to the left,

Al routings: : Active routings:

Routing ‘L. Routi
Default

2. A number of Routings have been defined but only one, Default, is currently active and set as the
default. Select New to display the Edit Routing dialog.

i Edit Routing

Routing Name:

Change Order parficipants: . ! Routing participants:

Users Routing Role

EngineerTwo

Prodifanager
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3. Enter a Routing Name. Then select one of the users from the Change Order participants list and
select Add to display the Edit roles dialog.

| EditRoles

e "Avaiiable Rolest . : : : Selected Roles:

Role Name L Role Mame

Revtewer

Approver SN
Checker e

‘Responsible Engineer ; . i

Natification User

4. Select arole from the list of Available Roles and select Add to add it to the list of Selected Roles.
5. Repeat the previous step to add any additional roles.

fﬁj Edit Roles ‘

HAvailable Roles: : Selected Roles:

Role Name Role Name

| ChangeRequestor
Change Administrator : Change Adm|

e : Responsible Enginger

Responsible Engineer
Netification User
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6. Select OK to return to the Edit Routing dialog. Note the Routing Roles assigned to the first selected
user.

Routing Name: ‘Main Routing

Change Order participants: - Routing participants:

Users

Administrator

» EngineerTwo ;

ProdManager : . Lo Approver, Change Administrator, Respensible Engineerk

7. Repeat steps 3 —5 to add the rest Qf the Change Order participants and define their Routing Roles.

%5 Edit Routing

Routing Mame: Idain Routing

Change Qrder participants: Reuting participants:

Users Users Routing Role

¥ Administrator { EngineerOne | Approver, Change ..
: . EngineerTwo | Approver, Change

Note that you must add users in the Change Administrator, Responsible Engineer and
Approver role. If you are using the optional Check state a Checker must also be added.

8. If you have more than one approver, use the Settings button to display and select the approval

type required.
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9, Select OK to dismiss the Edit Routing dialog and return to the Routing dialog.

10. In the Routing dialog select the new Routing and drag it from the All routings list to the Active
routings list.

Drag 2 routing from the list on the left to the list on the right to make it active. You can do:
“routing by dragging it back to the Jeft,

CiAltroutings: ' Active routings:

RN \
Routing L. Routing
Default ar o
Grouph o

11. In the Routing dialog select the new Routing. If this is to be the new default Routing select Set as
Default from the lower left part of the dialog.

gﬁ Rozk%&g :

' Drag 2 rouiting from the list on the left to the fist on the right to make it active. You can deactivate a
routing by dragging it back to the left. -

45 Mlbroigings: : Active routings:

Routing

Defavit )
Grouph Tl % Main Routing
G B

12. Select OK to dismiss the Routing dialog and return to the Global Settings dialog.
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1O Configure Email Notification

As an administrator, you must configure email settings if you want notifications emailed to participants
(9 on the routing list when a Change Order enters a State that requires attention. For example, the
Responsible Engineer is notified when the Change Order enters the Work State, Approvers are notified
when the Change Order enters the Review State, and Notification Users are notified when the Change
Order enters the Closed State.

Y The following illustration displays the Email dialog box in which you enable email notification and enter
o the email server information.

SMTP Server Name: - Enter SMTP Server Here
Emait From: VautiManager®somecompany: |
VL SMTP Server Port Mumber I587]
L " Ehable Compatibility with SSL
¢ B
- 71 SMTP Authentication

User Mame:

Password:

Confirm Password:

Procedure: Configuring Email Notification

The following steps describe how to configure email notification.
1. Make sure that all users that will be participating in Change Orders have email addresses.

P User Profile

& ‘ EngineerOne

First Namie: Engineer

Last Name: One

User Name: :EngineerCne

Email: engl@somecompanyicom

2. lLogin to the Autodesk Data Management Server console as the Administrator.
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3. Inthe Tools menu select Administration.

‘Autodesk Data Manageme

Dretach Master Vault
Index Block Atiributes..,
Rebuild Search Indexes

Yiew Server Tasks..

: ,_m Administration,,

4. Select the Advanced tab to display the Global Settings dialog. In the Email section select the Email

button to display the Email dialog.

i Global Settings &

e Advanced Ssttings—L

Advanced configuration settings

.. Email configuration

SMTP Server Mame;

Performance Threshol
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5. Select the Enable Email Notification and then enter the appropriate SMTP Server Name, and
address that will show up in the From address in the email and the SMTP Server Port Number. You
may need to specify the other options in the bottom half of the dialog (consult with your IT group).

SMTP Sérver Name; Enter SMTP Server Here

Email From: ; VautiManager@somecompany

SMTP Server Port Number: s
Enable Compatibility with 551

7] SMTP Authentication’

User Mame:

Password:

Confirm Password:

. VaqﬁManager@somecompany.com

| user@somecompany.com

- Server console Test mail message from NOV1237¢

7. Select OK to dismiss the Email dialog and return to the Global Settings dialog.

8. Select OK to dismiss the Global Settings dialog and log out of the Autodesk Data Management
Server console.
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Exercise 1: Set Up Change Orders

In this exercise, you set up a markup folder, add a user-defined Change Order property, create a new Change Order

numbering scheme, and add a new Change Order routing list.

The completed exercise

Configure Change Orders

1. Start Autodesk Vault Professional logging in with
this information:

User Name: Administrator
= No password
= Database: AOTGAdminVault

2. Open the Vault Settings dialog by selecting Tool
from the menu then Administration > Vault
Settings.

3. Select the Change Orders tab and review the
default options.

Markup Folders

1. Inthe Markup Folder section select the Use
Common Markup radio button. The Configure
button in the same section is now enabled.

Markup Folder
%—\@ Cenfigure Markup Felder

w5 Hsg Common Mar!iup Folder. A Folder must ke Configured
= Using the 'Configure..’ Command.

2. Select the Configure button to display the Select
Vault Location dialog.

3. Select New Folder to create a new folder named Markup

in the Vault Explorer ($) root folder.

4. Enter Markup in the New Folder Dialog and then OK to

dismiss the dialog.

ﬁ%ﬁ Select Vault Location

Select a Vault folder

mffg Vault Explorer (3]

5. Select OK to dismiss the Select Vault Location dialog and

return to the Vault Settings dialog.
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Add Link Properties

1. Inthe Vault Settings dialog select the Properties
button in the Link Properties section to display
the Link Properties dialog.

i User Defined Linked Properties (Change Ord

User Defined Linked Properties

Data.. . State Usage

There are no items o show in this view.

!
|
i Prope..
41
1
i
i

Note that unlike other properties, there is no
default Link Properties.

2. Select New to display the New Change Order Link
Property dialog.

Settings ’i

Property values:

Mame.

Initial Value
; List Values
: Enforce List Of Values

: Requires Value

Case Sensitivity
: Minimum Length

: Maximum Length

3. Enter the following information for a new Link

Property Disposition.

Enter Disposition for Name.

Keep the Type default Text.

In the list Values dialog select the right
column to display the List Values

4. In the List Values dialog do the following:

» |n the Click here to add new row section enter Revise

followed by the enter key.
= Enter Substitute followed by the Enter key.
= Enter Obsolete followed by the Enter Key

Preperty values:

I
Name Yalue |
State ¥ Enabled ‘
- Initial Value ’
- l=dl 1R
Enforce List Of Values
-~ -~ Property Yalues
Requires Yalue
Case Sensitivity o List Values
Minimum Length
Maximum Length = evise
Substitute

5. Select the entry for Revise and then select Set Initial
Value to make this the default value.

o ListValues

Click hers to add 5 new oopw

Substitute
Obsolete

6. Select Close to close this dialog and return to the New
Change Order Link Property dialog.

7. Finish filling out this dialog by entering:
= Select True from the drop down to Enforce List of

Values.
8. Review the entries. They should look like the following
list: '

Settings |

Property values:
: Name Value
State S Enabled
Initial Value Revise
| List Values ‘Revise’, 'Substitute’, 'Obsolete’

rue v

q | False
Case Sensitivity MNone
Minimum Length

Iaximurm Length
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9. Select OKto return to the User Defined Linked
Properties (Change Orders) dialog and then Close

to return to the Vault Settings dialog. 5. Select the new numbering scheme and then select Set as

Default button from the lower right section of the dialog
to set it as the default. )

% User Deﬁnechked or P !

User Defined Linkéd Properties

Change Order Numbering

1. In the Vault Settings dialog select Define in the
Change Order Numbering section to display the
Change Order Numbering dialog.

6. Select Close to dismiss this dialog and return to the Vault
Settings dialog.

2. Select New to create a new Change Order
Numbering Scheme.

3. In the dialog that appears enter the following: 1. Select Close to dismiss the Vault Settings tab.
=  For Code enter AOTC ECO.

Create Routing List

In the Tools menu under Administration select Global

- :l%rn?be:;rr:gt'on enter AOTC Change Order Settings to display the Global Settings dialog.
= For Starting Number enter 1 3. On the Global Settings dialog select the Change Orders
Keep the default number of digits (3). , tab.
- :\élﬁlgtzﬁgcrgcg.at the Append workgroup label 4. Select the Define button to display the Routing dialog.
, e Select New to display the Edit Routing dialog.
feal Edit/Create Change Order Numbering Scherne <
| EfiCioe Chorgs Qe Mg ohee Do the following:
Code: AOTCECO
T, O v For Name enter GroupOne
| TR e e e =  Shift-select usera, userb, userc and userd from the
| Starting Number ! : | Change Order Participants list and select Add to add
| Mumberof Digits = them to the Routing Participants.
| ' » In the Edit roles dialog that appears select
Notification User from the Available roles list and
then the Add button to add that to the Selected
Roles list.
4. Select OKto return to the Change Order = Select OK to dismiss the dialog and return to the Edit
Numbering dialog. Routing dialog.

Routing Meme; GroupOne

Change Qrder participants: T -~ Routing participants:

Users ; Users Routing Role

Notification User

userd Notification User
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7. In the routing Participants list select usera and
then select the Edit Roles button to display the
Edit Roles dialog.

8. CTRL-select Change Administrator and Approver
from the list.

Auvailable Roles:

Role Name

Change Requestor

Responsible Engineer

Notification User

9. Select the Add button to add these roles to the
Select Roles list.

(hieditholes

| Available Roles; Selected Roles:

Role Name Role Name

Change Requestor
g inistrator

e g
Metification User

10. Select OK to dismiss this dialog and return to the
Edit Routing dialog.

11. Do the following:

=  Select userb in the Routing participants list.

»  Select the Edit Roles button.

= |n the Edit Roles dialog that appears select
Responsible Engineer from the Available
Roles list.

= Select Add to add this role in the Selected
Roles list.

=  Select OK to dismiss the dialog and return to
the Edit Routing dialog.

12. Do the following:

Select userc in the Routing participants list.
Select the Edit Roles button.
In the Edit Roles dialog that appears select
Approver from the Available Roles list.

= Select Add to add this role in the Selected
Roles list.

Select OK to dismiss the dialog and return to the Edit
Routing dialog.

13.

14.

15.

16.

17.

18.

19.

20.
21. Exit Vault Professional.

Examine the Edit Routing dialog to see the Routing
participants and their roles you setup.

Routing participants:. -

Users © . Routing Role

usera Approver, Change Administrator, Notiﬁcatic}n Ugser

Motification User, Responsible Engineer

Select the Settings button from the lower left part of the

dialog. '

Select Unanimous approval for Review state required.

Select OK to dismiss this dialog and return to the Edit

routing dialog.

In the All routings list select the new routing GroupOne

and drag it to the Active routings dialog.

In the lower left corner of the dialog select the Set as

Default button.

| “Drag & routing from the fist on the left ko the list on the right to make it active: You can deactivate 2
routing by dragging it back to the left,

All routings: Active routings:

-

Reuting

.- Routing
Default

Select OK to dismiss this dialog and return to the Global

Settings dialog.
Select Close to close this dialog.
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Chapter Summary

As a Vault Professional administrator, you need to configure Vault Professional to meet your
company’s needs.

Having completed this chapter, you can:

Create unit and categories, create hew ltem numbering schemes, and change lifecycle rules.
= Create, edit, and map item and change order properties

= Set up Change Orders including routing lists, user-defined properties, and Change Order
numbering.
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Chapter

Reporting

Autodesk Vault Professional provides the ability to generate formatted reports representing data contained in a
vault. You can generate reports for files, items, and change orders, and organize the report based on specific
properties. For example, a report can display files grouped by a category, summarize currently open change
orders, or show the distribution of lifecycle states across a model. Reports can display the data in a variety of
ways, including charts, tables, and data sheets. You can also format data using dozens of pre-defined operators.

In this chapter, you learn how to create and modify report templates so that you can customize Vault reports
that contain information relevant to your business, in a format that suits your needs.

Objectives

After completing this chapter, you will be able to:

. Create reports from an advanced search and configure how the data is displayed.
. Identify the different out-of-the box report templates and the information they are formatted to
display.
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Lesson 1: Creating Reports

Overview

In this lesson you learn how to create a report from an advanced search and configure how the report
data is displayed.

Use search reports to illustrate details about files, items, and change orders stored in the vault by
using charts, tables, and data sheets.

ltem By ltems State Report
Date: ! 672172010 4:26:31 AM

Search
Conditions:

n Review (1)
B8 Work In Progress (7)
EBEE Released (1)
(=3 Obsolete (1)

Objectives

After completing this lesson, you will be able to:

. Create reports from an advanced search.

. Understand how to use each of the out-of-the box templates included with Autodesk Vault
Professional.
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About Reports

Working with reports is a way of illustrating file details for those who do not have direct access to the
vault. Reports can be organized to suit the needs of your business and to illustrate certain file, item, or
change order details.

Search options specified in the Advanced Find dialog determine which vault objects appear in a report.
The properties displayed in the report, as well as the report layout, are specified in a report template
file that is selected during the report generation. Through the report template, you have control of the
report content, layout, and format.

You generate reports by creating an advanced search with specified parameters and then clicking the
report button. After selecting a template for the report, the information is displayed in a window for
viewing.

Example of Creating a Report

A report must be generated to show the current state of the change orders in a particular project. You
create an advanced search with the condition that the search return all of the change orders for a
specific project folder. Once the search is complete, you generate a report and choose the template
that shows the state of each change order. Once the report is generated, you save a copy to the vault
and email a copy to the project manager for review.

Report Templates

Report descriptions for Vault reports are contained in RDLC files stored on the Vault client machine.
These report description files are referred to as report templates. Vault report templates are fully
RDLC compliant, but Vault requires certain naming conventions in the <DataSet> section of the
template for integrating Vault data into the report.

A report template authoring utility is installed with the vault client to help you create simple client
report definition files (.rdlc) for storing search data. This utility provides only a raw template structure
for categorization purposes. A more sophisticated template authoring tool is required for custom
visual layouts.
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Pre-existing Report Templates 3

When the Vault Client is installed, several pre-existing report templates are provided. The following
table describes each template.

ECO Average Close Rate

ECO By State

ECO Detail

ECO Status Created on Month

ECO Table
*File by Category

File Detail
_F“e,Ta,b!e\ -

, t=i|e Transm:ttal

ltem Detail

ltem Table

Displays the average number of days it takes to close an
ECO.

_ Displays the ECOs in groups based on ECO state.

Displays the ECO Number, Change Order Properties, Sate,
Due Date, and submission information without table
formatting.

'Dlsplays the number of ECOs per State

Displays the ECO Number, Change Order Properties, Sate,
Due Date, and submission information in table format

L Dlsplays the ﬁle name, revrsuon state, comments, and

check-in mformatron in'a pie-chart orgamzed by category

Displays the file name, revision, state, check-in information,
and comments without table formatting.

Displays the file name, revision, state eheck in mformatlon

e “and comments m a table format

Displays the file name, revision, state, vault folder location,
and date the version was created for each file.

- ,;DisblaYstfre, "it,e.',n'l}informatipn in groups ybas‘ed'-on_s;tate, ~.

Displays the item name, revision, state, type, units,
modification information, compliance status, and
description without table formatting.

Dlsplays the ltem name, revision‘ state, type, units;

\descnptron in table format
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Microsoft Report Viewer

Vault uses the Microsoft Report Viewer to generate and display reports. Microsoft Report Viewer
contains a full-featured, highly customizable reporting engine to display reports for SQL Server

Reporting Services. However, the report viewer can also be run in “local mode” - allowing applications
like Vault to provide data for report rendering without requiring the overhead of SQL Server Reporting

Services. Vault runs the report viewer in local mode. Report descriptions for Vault reports are
contained in RDLC files stored on the Vault client machine.

Change Orders By State Report

Generated By: Administrator

Date: 672142010 4:22:19 AM
Search Root: §

Search Conditions:

E30pen
Bi§ Create
Bt Closed

Creating Search Reports

To create a search report, you must be familiar with how to generate searches with conditions.
Familiarize yourself with the template you intend to use before creating the search. Once you
understand which file, item, or change order properties will be displayed, you can specify search
conditions to return the desired vault objects for the report.

Report templates may be stored in a local folder or in a vault. During installation, the pre-existing
report templates are placed in a local folder at C:\Program Files\Autodesk\Vault <edition>
2011\Explorer\Report Templates.
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Procedure: Creating a New Report

The following steps describe how to create a new search report.
1. Click Find. The find dialog box is displayed.

2. Click the Basic tab or the Advanced tab depending on the type of criteria for which you want to
search.

3. Specify the search criteria for this report.
4. Click Report. The Select Report Template dialog box is displayed.

5. Enter the path of a template that you would like to use or click the Browse button to navigate to
the desired template. The last selected report template is displayed by defauit.

6. Click OK to generate a report. If none of the search criteria is set to ask me later, the report is
created and displayed automatically.

7. If any of the criteria has a value set to ask me later, the Specify Search Values dialog box is
displayed. Specify the search values for the listed properties, and then click OK. The Select Report
Template is displayed.

8. Click OK to generate and view the report. The report automatically displays in Microsoft Report
Viewer.

9. In Microsoft Report Viewer, click Page Setup to configure printing preferences and to print the
report.

10. To export the report, click the Save As command and select whether to export the report as an
Excel file or a PDF file.

hhhhhhh
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Create a Search Report

1.

Start Autodesk Vault Workgroup or Autodesk
Vault Collaboration. Log in using the following
information:

User Name: usera
Password: vault
Database: AOTCVault

In the navigation pane, click Ali Folders.
Select the Item Master list.
Click Find on the toolbar.

Exercise 1: Create a Search Report

In this exercise, you create a search report using a pre-existing template and save the report to the vault.

System Iltem Properties Report

Generated By: Administrator

Date: 6/21/2010 4:34:30 AM
Search

Conditions:

100002 A Work In Progress MaleEnd.ipt Each

VNB_EDB_US-FemaIeEnd A Work In Progress FemaleEnd.iam ' Each

VB_E06_03-LinkAdjust

IV6_E0B_03-MaleEnd A Work In Progress MaleEnd.iam Each

The completed exercise

5. On the Find dialog box, click the Advanced tab.

{8asc | Advanced | options

| Search fors,
Property; Condition! Yalue:

" Add 'Re;'xlaca k \ Remove

| Find Rems that metch these aiterta:
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6. Onthe Advanced tab, do the following:

e Select State from the Property drop-down
menu.

e Select does not contain from the Condition
drop-down menu.

o Enter Obsolete in the Value field.
e Click Add.

Find items that match these criteria:
State does not contain Gbsolete

|
!
|

7. Click Find Now. All of the items not in an
Obsolete state are listed. .

1v¥6_E06_04-LinkRod LinkRod.iam
100002 MaleEnd.ipt
100001 FemaleEnd.ipt
Bushing Small-Alum.ipt
1¥6_E06_D3-LinkAdjust Linkadjust.iam
1v6_E06_03-MaleEnd MaleEnd.iam

1y6_£06_03-HeimBall12 HeimBali12.ipt
1v¥6_£06_03-FemaleEnd FemaleEnd.iam

Click Report.

On the Select Report Template dialog, do the
following:

o  Click the ellipses (...) button.

e Select Item Table.rdlc on the Select Report
Template dialog.

e (Click Open

10. Click OK on the Select Report template dialog.
The report is generated and immediately
launched in Microsoft Report Viewer.

Autodesk:
System Hem Properties Report

eS8y Ansiedn
36k, GIIKRD B33 AN

Bessth
Sondifigug

11. Click the Save button on the View Report toolbar.

12. Select PDF as the format in which you will save
the report.

13. On the Save As dialog, navigate to the desktop.

14. Name the report and click Save to store it on
your desktop.
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Chapter Summary

All Autodesk Vault Professional users can create reports to illustrate file, item, and change order details.
These reports are useful in understanding design statuses by visually organizing vault data based on
specified properties.

You can use existing report templates to display your data in the form of charts, graphs, and tables.
Having completed this chapter, you can:
. Create reports from an advanced search and configure how the data is displayed.

* Identify the different out-of-the box report templates and the information they are formatted to
display.

SO B S

R

1
-

(R

194




,§
o
2
<

Additional Resources

A variety of resources are available to help you get the most from your Autodesk® software. Whether
you prefer instructor-led, self-paced, or online training, Autodesk has you covered.

Learning Tools from Autodesk

Autodesk Certification

Autodesk Authorized Training Centers (ATC®)
Autodesk Subscription

Autodesk Communities

Learning Tools from Autodesk

Use your Autodesk software to its full potential. Whether you are a novice or an advanced user,
Autodesk offers a robust portfolio of learning tools to help you perform ahead of the curve.

»  Get hands-on experience with job-related exercises based on industry scenarios from Autodesk
Official Training Guides, e-books, self-paced learning, and training videos.

All materials are developed by Autodesk subject matter experts.

»  Get exactly the training you need with learning tools designed to fit a wide range of skill levels and
subject matter—from basic essentials to specialized, in-depth training on the capabilities of the
latest Autodesk products.

= Access the most comprehensive set of Autodesk learning tools available anywhere: from your
authorized partner, online, or at your local bookstore. '

= To find out more, visit http://www.autodesk.com/learningtools.
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Autodesk Certification

Demonstrate your experience with Autodesk software. Autodesk certifications are a reliable validation
of your skills and knowledge. Demonstrate your software skills to prospective employers, accelerate
your professional development, and enhance your reputation in your field.

Certification Benefits

Rapid diagnostic feedback to assess your strengths and identify areas for improvement.

An electronic certificate with a unique serial number.

The right to use an official Autodesk Certification logo.

The option to display your certification status in the Autodesk Certified Professionals database.

For more information:

- Visit www.autodesk.com/certification to learn more and to take the next steps to get certified.

Autodesk Authorized Training Centers

Enhance your productivity and learn how to realize your ideas faster with Autodesk software. Get
trained at an Autodesk Authorized Training Center (ATC) with hands-on, instructor-led classes to help
you get the most from your Autodesk products. Autodesk has a global network of Authorized Training
Centers that are carefully selected and monitored to ensure you receive high-quality, results- oriented
learning. ATCs provide the best way for beginners and experts alike to get up to speed. The training
helps you get the greatest return on your investment, faster, by building your knowledge in the areas
you need the most. Many organizations provide training on our software, but only the educational
institutions and private training providers recognized as ATC sites have met Autodesk's rigorous
standards of excellence.

Find an Authorized Training Center

With over 2,000 ATCs in more than 90 countries around the world, there is probably one close to you.
Visit the ATC locator at www.autodesk.com/atc to find an Autodesk Authorized Training Center near
you. Look for ATC courses offered at www.autodesk.com/atcevents.

Many ATCs also offer end-user Certification testing. Locate a testing center near you at
www.autodesk.starttest.com.
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Autodesk Subscription

Autodesk® Subscription is a maintenance and support program that helps you minimize costs, increase
productivity, and make the most of your Autodesk software investment. For an attractive annual fee,
you receive any upgrades released during your Subscription term, as well as early access to product
enhancements. Subscription also gives you flexible license terms, so you can run both current and
previous versions (under certain conditions) and use the software on both home and office computers.
In addition, Subscription gives you access to a variety of tools and information that save time and
increase productivity, including web support direct from Autodesk, self-paced learning, and online
license management.

= Autodesk Subscription offers a way to make software costs predictable. Whether a customer opts
for a one-year subscription or a multiyear contract, the costs are known for the entire term of the
contract.

= A complete library of interactive learning tools and high-quality, self-paced lessons help users
increase their productivity and master new skills. These short lessons are available on demand and
complement more in-depth training provided through Autodesk Authorized Training Centers.

=  Autodesk Subscription makes managing software licenses easier. Customers have added flexibility
to allow their employees to use their Subscription software—in the office or at home. Better yet,
designers are entitled to run previous versions of the software concurrently with the latest release
under certain conditions.

* Get what you need to stay productive. With web support, Autodesk support technicians provide
answers to your installation, configuration, and troubleshooting questions. Web and email
communications deliver support straight to your desktop.

*  For more information, visit www.autodesk.com/subscription.

Autodesk User Communities

Autodesk customers can take advantage of free Autodesk software, self-paced tutorials, worldwide
discussion groups and forums, job postings, and more. Become a member of an Autodesk Community
today!

Free products are subject to the terms and conditions of the end-user
license agreement that accompanies download of the software.

Feedback

Autodesk understands the importance of offering you the best learning experience possible. If you
have comments, suggestions, or general inquiries about Autodesk Learning, please contact us at
learningtools@autodesk.com.

As a result of the feedback we receive from you, we hope to validate and append to our current
research on how to create a better learning experience for our customers.
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Useful Links

Learning Tools
autodesk.com/learningtools

Certification
www.autodesk.com/certification

Find an Authorized Training Center
www.autodesk.com/atc

Find an Authorized Training Center Course
autodesk.com/atcevents

Autodesk Store
Store.autodesk.com

Communities
autodesk.com/community

Student Community
students.autodesk.com
Blogs
autodesk.com/blogs

Discussion Groups
forums.autodesk.com
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